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Introduction
This guide provides information necessary to implement, configure, and administer 
Siebel Assignment Manager. Chapters are organized in a way that allows users to 
move throughout the guide for various tasks. Introductory material, assignment 
manager concepts, and potential strategies for product use are explained in 
Chapter 1, “Assignment Concepts,” and Chapter 2, “Assignment Strategy.” 
Chapter 4, “Assignment Rules,” and Chapter 5, “Running Assignment Manager,” 
are important to those interested in applying the introductory knowledge to actual 
implementations of Assignment Manager. Chapter 3, “Assignment Manager 
Configuration,” and Chapter 6, “Advanced Configuration,” provide detailed 
instructions for those users who require specific configurations to Assignment 
Manager functionality. Concluding this guide are two appendixes. Appendix A, 
“Assignment Object Parameters,” describes properties of assignment objects, and 
Appendix B, “Assignment Manager Error Messages,” describes the error codes that 
can appear when processing Assignment Manager. 

Several other server processes, not fully documented in this guide, play an integral 
role in Assignment Manager functionality. The Siebel System Administration 
documentation, especially Siebel Business Process Designer Administration Guide, 
and Siebel Server Administration Guide should be used as additional references 
when using Assignment Manager with these processes. For application 
development, see Siebel Tools Reference.
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 9



Introduction

Who Should Use This Guide
Who Should Use This Guide
As part of the System Administration documentation set, this guide provides 
information necessary to implement, configure, and administer Siebel Assignment 
Manager. 

This book is useful primarily to people whose title or job description matches one 
of the following:

The user should possess skills in SQL, RDBMS, and network connectivity using 
TCP/IP. Previous experience with application and database software is helpful.

Product Modules and Options
This Siebel Bookshelf contains descriptions of modules that are optional and for 
which you may not have purchased a license. Siebel’s Sample Database also 
includes data related to these optional modules. As a result, your software 
implementation may differ from descriptions in this Bookshelf. To find out more 
about the modules your organization has purchased, see your corporate purchasing 
agent or your Siebel sales representative.

Database 
Administrators

Persons who administer the database system, including data 
loading; system monitoring, backup, and recovery; space 
allocation and sizing; and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Sales and Service 
Administrators

Persons responsible for setting up and maintaining a sales or 
service department. Duties include designing the business 
requirements necessary for service and sales deployments.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
10 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B
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Revision History
Revision History
Siebel Assignment Manager Administration Guide

Version 7.5, Rev. B
Table 1. Changes Made in Version 7.5, Rev. B

Topic Revision

“Individuals” on page 21 Corrected information in Table 3.

“Assignment Rule Groups” on page 25 Added information about how to use rule 
groups. 

“Assignment Rule Sequencing” on page 26 Corrected topic content.

“Server Key Maps” on page 29 Corrected topic content and added more 
information about the server key mapping 
feature.

“Assignment Criteria” on page 32 Added last sentence to comments for the 
Include inclusion method in Table 7.

“Nonrequired Assignment Criteria” on 
page 38

Added for Windows NT to the procedure 
heading and replaced step 8.

“Workload Criteria” on page 43 Added the All Organizations flag to the first 
note.

“Assignment Logic and Scoring” on page 51 Changed title to include Scoring.

“Assignment Methodology” on page 53 Added note to Step 3.

“Assignment Operation Modes” on page 60 ■ Removed parenthetical text from the 
Contact Denormalization and Product 
Denormalization bulleted items.

■ Added second paragraph (following 
bullets).

“Creating Assignment Objects” on page 98 Added tip to Step 2.

“Configuring Assignment Objects for 
Availability-Based Assignment” on 
page 107

Added content to the Calendar Create 
Activity value in Step 4 of the To configure 
Availability-based Assignment for an 
assignment object procedure. 
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Revision History
“Creating Assignment Rules” on page 161 In Table 17:

■ Added a footnote for the Activation and 
Expiration fields. 

■ Added to the descriptions for All 
Organizations and All People fields.

■ Added note to the Minimum Score field 
description. 

“Creating Assignment Rule Groups” on 
page 165

In Table 18:

■ Added a footnote for the Activation and 
Expiration fields. 

■ Added Key Based field description. 

“Adding Employees to Assignment Rules” 
on page 189

Added a footnote for the Activation Date/
Time and Expiration Date/Time fields in 
Table 24. 

“Adding Positions to Assignment Rules” on 
page 195

Added a footnote for the Activation Date/
Time and Expiration Date/Time fields in 
Table 25. 

“Adding Organizations to Assignment 
Rules” on page 199

Added a footnote for the Activation Date/
Time and Expiration Date/Time fields in 
Table 26.

“Releasing Assignment Rules” on page 202 Added result to Step 2 and note following 
that step. 

“Migrating Assignment Rules” on page 203 Added topic. 

“Running Assignment Manager in 
Interactive Mode” on page 216

■ Deleted second and third paragraphs.

■ Deleted Table 29 and note following the 
table.

■ Reorganized section and added a 
subtopic. 

“Running Assignment Manager in Batch 
Mode” on page 236

Corrected Step 3d.

Table 1. Changes Made in Version 7.5, Rev. B

Topic Revision
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Introduction

Revision History
“Assigning Child Accounts Based on 
Parent’s Primary Address” on page 254

■ Corrected title of topic.

■ Reinstated missing information for 
Step 7.

“Reassigning Accounts to a Different 
Primary Position” on page 257

Incorporated last three paragraphs in topic 
into the To reassign accounts to a different 
position procedure.

“System Preferences Compatibility” on 
page 270

Added Default Organization to the Assignee 
of Unowned preference in Table 36.

“Assignment Object Parameter Usage” on 
page 276

Added a paragraph to the usage comments 
in Table 39 for the following run-time 
parameters:

■ Default Employee

■ Default Organization

■ Default Position

“Set Primary Position” on page 287 Corrected note in the usage comments for 
this run-time parameter.

“Run-Time Parameter Default Values” on 
page 288

In the procedure:

■ Added step 2.

■ Corrected step 4.

Table 1. Changes Made in Version 7.5, Rev. B

Topic Revision
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Revision History
January 2003 Bookshelf
Table 2. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Skills” Added information about predefined skills 
at beginning of section.

“Contact Denormalization” Added next to last paragraph in topic.

“Product Denormalization” Removed the following sentence from last 
paragraph in topic: “You can also configure 
Assignment Manager to run Batch 
Assignment in this mode.”

“Assigning Skills to Employees, Positions, 
and Organizations”

Added this topic. Before version 7.5, Rev. A, 
was documented in Applications 
Administration Guide.

“To configure interactive assignment for an 
assignment object”

Removed last bullet from Step 4.

“Creating Skills and Using Skill Tables” Added this topic.

“Creating Workflow Policy Components” Added note after second paragraph.

“To define workload criteria for 
organizations”

Rewrote the description for the Required 
workload criteria field to reflect there are 
two options.

“Adding Employees, Positions, and 
Organizations to Assignment Rules”

Changed all variations of the word assign to 
add throughout this section.

“Adding Positions to Assignment Rules” Removed note about not deleting positions 
near the end of the section.

“Adding Organizations to Assignment 
Rules”

■ Corrected List name in Step 4.

■ Added third from last paragraph in 
topic.

“Checking the Assignment Manager and 
Server Request Broker Components”

Added note after Step 3.
14 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Introduction

Revision History
Chapter 5, “Running Assignment Manager” Reworded note in second set of bullets to 
include information about how to 
automatically refresh skills without 
restarting the Assignment Manager 
component.

“Checking the Assignment Manager and 
Server Request Broker Components”

Added note at end of topic.

“Running Interactive Assignment Using the 
Command-Line SRVRMGR Utility”

Added MaxSkillsAge parameter to table.

“Running Workflow Monitor Agents” Added note after first paragraph.

“To run Batch Assignment” Reworded caution after Step 8 because of 
change in functionality.

“Running Multiple Instances of Assignment 
Manager in Batch Mode”

■ Added third paragraph to topic 
(immediately following bulleted items).

■ Added when not to run batch 
assignment near end of topic.

“Assigning Objects Based on the Primary 
Address”

Added note after first paragraph specific to 
Siebel Life Sciences.

“Reassigning Accounts to a Different 
Primary Position”

Added second sentence to first paragraph.

“Stopping Assignment of Organizations for 
Accounts”

Added this topic.

“Setting the Lock Assignment Default Value 
for Activity Assignment Objects”

Added this topic.

Appendix A, “Assignment Object 
Parameters”

Added note to the description for the Lock 
Assignment Column parameter.

“Activity Object Parameters” Added content after note (before the table).

Appendix B, “Assignment Manager Error 
Messages”

Added this appendix.

Table 2. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision
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Assignment Concepts 1
Siebel Assignment Manager allows sales and service organizations to assign the 
most qualified people to specific tasks. Assignment Manager accomplishes this 
function by matching candidates to predefined and user-configurable assignment 
objects. To assign the most qualified candidate to each object, Assignment Manager 
applies assignment rules that you define. For you to define assignment rules, you 
select:

■ Objects to which each assignment rule applies

■ Rule Groups to which each assignment rule applies (optional)

■ Criteria for each assignment rule

■ Values for each assignment criteria

■ Skills to match assignment rules, objects, organizations, employees, and 
positions

■ Expertise to weigh skill scores

■ Scores for each assignment rule, criteria, and value

■ Candidates that are scored using the assignment rule

■ Workload rules to balance work across your organization

For example, in a sales organization, you can create an assignment rule that scores 
positions (candidates) based on territory definitions (criteria) for an opportunity 
(object). In a service organization, you can create an assignment rule that scores 
employees (candidates) based on product expertise (criteria) for a service request 
or product defect (object). Using the sum of scores for each assignment rule, 
Assignment Manager assigns the best candidates for each object.
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You can also customize the way Assignment Manager makes assignments by:

■ Defining how attributes are matched by using:

■ Inclusion and exclusion methods

■ Different comparison methods

■ Wildcard values

■ Defining how objects are matched by using Multitiered assignment

■ Defining how assignment rules are matched by using:

■ assignment rule groups

■ assignment rule sequencing

■ Creating and configuring your own components, including:

■ Objects

■ Assignment criteria

■ Criteria values

■ Assignment attributes

■ Running Assignment Manager in different operation modes to process 
assignments:

■ Interactively in real time

■ Dynamically when database changes are made by connected or mobile users

■ Periodically assigning objects in batches

This chapter explains how Assignment Manager works and how it can be 
configured to meet your organization’s needs.
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Assignment Manager Components
This section defines the components used by Assignment Manager. The 
components are:

■ “Assignment Objects”

■ “Candidates” on page 20

■ “Assignment Rules” on page 23

■ “Assignment Criteria” on page 32

■ “Workload Criteria” on page 43

■ “Activity-Based Assignment” on page 45

■ “Multitiered Assignment” on page 52

■ “Availability-Based Assignment” on page 45

■ “Skills” on page 46

Assignment Objects
In Siebel Assignment Manager, objects represent assignment entities to which 
candidates are matched based on assignment rules. A number of predefined 
assignment objects are available for use by Assignment Manager for the most 
commonly used business entities in Siebel eBusiness Applications. The predefined 
assignment objects are:

■ Account

■ Activity

■ Campaign

■ Campaign Contact

■ Contact

■ Opportunity

■ Order (Sales Credit Assignment)
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■ Product Defect

■ Project

■ Project Team

■ Service Request

If your deployment requires other objects, or if you need to modify predefined 
objects, you can create new objects and configure existing objects using Siebel 
Tools. For more information, see “Assignment Object Configuration” on page 96.

Candidates
In Siebel Assignment Manager, candidates represent the people who are evaluated 
as potential assignees for objects. Depending on the assignment rule you use, and 
the object to which a candidate is assigned, candidates can be positions, employees, 
or organizations, and can be assigned as individuals or as members of a team. For 
information about the predefined assignment objects and recommended candidate 
assignments, see Table 3 on page 22.

Positions
Positions represent candidates distinguished by their job functions, and are 
typically used as candidates in sales organizations. For example, a sales 
organization would want to assign positions to objects, because these positions are 
responsible for a region or territory.

By assigning objects to positions, you can have one sales representative inherit the 
opportunities, accounts, and contacts from another representative by reassigning 
the employee responsible for a specific position.

Employees
Employees represent candidates distinguished by their skills and product expertise, 
and are typically used as candidates in service organizations. For example, a service 
organization would want to assign employees with the proper skills and expertise 
to objects, because these employees possess specific skills that are related to the 
service request or activity. Assignment Manager can also take into account a 
specific employee’s work schedule, calendar, and regional schedule when 
determining assignments by creating rules based on an employee’s availability.
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Organizations
An organization represents a group of positions that has limited visibility to 
particular application data. For example, your company can create separate and 
distinct organizations to distribute specific information to organizational groups 
both inside and outside of your enterprise. Both internal and external users are 
granted access only to the information that they should see (such as accounts, 
opportunities, and contacts) and data they need to see (such as price lists, products, 
and literature).

By assigning objects to organizations, you can maintain better security and promote 
proper business practices by controlling data access and visibility between different 
organizations. For example, you can limit your distributors’ data access by giving 
them visibility to product information, but restrict their visibility to price lists for 
the products. To do this, you can create a separate organization for your distributors 
that does not have access to the price list data. In this case, the price lists are not 
available to your distributors even if they are assigned to the products.

Some objects allow the assignment of a single organization, whereas other objects 
allow the assignment of multiple organizations to the same object. For more 
information, see Table 3 on page 22.

For more information on organizations, see Applications Administration Guide.

Teams
A team represents a group of employees or positions. Assigning a team allows you 
to assign a group of individuals that possess various skills or job functions to a 
particular object.

In sales organizations, teams are typically assigned to objects. For example, you can 
assign a sales representative and a sales consultant to an opportunity. Or you can 
can assign a team of sales professionals—two district representatives, a regional 
manager, and a sales engineer—to work a single, large sales opportunity.

Individuals
An individual represents a single employee or a position. Assigning individuals 
allows you to assign exclusive ownership to an individual who possesses a specific 
skill or expertise for a particular object.
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 21



Assignment Concepts

Assignment Manager Components
In service organizations, individuals are typically assigned to objects. For example, 
you can assign a customer service representative with expertise in disk drives to all 
service requests that are marked for this area.

Table 3 shows which candidates can be assigned to each of the predefined 
assignment objects. This table also shows which assignment objects are restricted 
to a single assignee, and assignment objects that are capable of incorporating a team 
of assignees. S indicates the ability to allow only a single owner or assignment; M 
indicates the ability to allow multiple owners or team assignments.

If you need to modify the default properties—for example, if you want to assign 
Accounts to Employees—you can do so by configuring the assignment object 
properties using Siebel Tools. For more details, see “Assignment Object 
Configuration” on page 96.

Table 3. Summary of Predefined Assignment Objects

Candidate

Assignment Object Position Employee Organization

Account M M

Activity S

Campaign M M

Campaign Contact S S

Contact M M

Opportunity M M

Product Defect S

Project M M

Project Team M

Service Request S M
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Primaries
A primary on an assignment rule represents the candidate (employee, position, or 
organization) that is assigned as the primary owner of the assignment object if the 
candidate passes the criteria for that object. The primary is the main or first owner 
of an assignment object. For assignments that allow only single assignees, the single 
assignee becomes the primary assignee as well.

Assignment Rules
Siebel Assignment Manager uses assignment rules to match assignment objects to 
candidates. Multiple assignment rules can be active for each assignment object. An 
assignment rule can also apply to multiple objects because the assignment object 
field supports multiple selections.

Assignment rules use scores to rate candidates and select potential assignees. 
Candidates that qualify for an assignment rule have the assignment rule score 
added to their total score. For example, Figure 1 shows a High Priority assignment 
rule that applies 20 points to the candidate’s total score if the candidate meets the 
priority levels defined in the rule’s criteria.

Figure 1. Sample Assignment Rule
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Table 4 shows the four methods used by Assignment Manager to determine which 
potential assignees are assigned to the object from each assignment rule.

The assignment rule method determines how candidates are evaluated as potential 
assignees to the object. In the example shown in Figure 1 on page 23, only the 
highest-scoring candidate is used because the assignment rule uses the One, Best 
Fit method.

For information about creating, defining, and configuring assignment rules, see 
Chapter 4, “Assignment Rules.” 

Table 4. Types of Assignment Rules

Assignees from Rule Description

All, Above Minimum Use assignees with an assignment score greater than or equal to 
the assignment rule’s minimum score.

All, Must Assign Same as All, Above Minimum, except that the highest-scoring 
candidate is a potential assignee even if all candidates fail to meet 
the minimum score.

One, Best Fit Use the assignee with the highest assignment score from this 
assignment rule.

One, Random Choose a random assignee whose score is greater than or equal to 
the minimum score required for this assignment rule.
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Assignment Rule Groups
Assignment Manager allows you to group assignment rules, splitting them up by 
business function or other categories. An assignment rule group can include 
multiple assignment rules, however, an assignment rule can belong to only one rule 
group.

Rules not associated with a user-defined group belong to a group known as Default 
Group. This group name (Default Group) is not visible in the Assignment Rule 
Group view, but is an inherent part of Assignment Manager. Rules upgraded from 
previous versions of Assignment Manager to version 7.5 are automatically 
associated with the Default Group. For information about how to create user-
defined groups, see “Creating Assignment Rules” on page 161.

You can use rule groups to split the load between multiple assignment servers by 
defining a server key map. The server key map defines which rule groups load and 
process for each server. You can also use the server key map to configure a server 
to load multiple rule groups. For more information about server key maps, see 
“Server Key Maps” on page 29 and “Defining Server Key Maps” on page 168. 
However, you cannot run assignment rules associated with rule groups and 
assignment rules associated with the Default Group on the same server because the 
two tasks are mutually exclusive functionalities. For example, you cannot use the 
same assignment server to run resource assignment (used for professional service 
automation and does not use rule groups) and credit assignment (used for sales and 
does use rule groups). You should run assignment for each on different servers.

When running batch assignment, Assignment Manager can load a particular rule 
group into memory for each task, resulting in better performance (as compared to 
batch assignment loading all active rules into memory). For more information about 
batch assignment, see “Running Assignment Manager in Batch Mode” on page 236.
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Assignment Rule Sequencing
Assignment Manager can evaluate assignment rules in a specified sequence. When 
you assign sequence numbers to assignment rules, Assignment Manager evaluates 
those rules in that sequence in ascending order. Assignment rule sequencing 
provides a means for you to prioritize the rules that apply to any given assignment 
object by order of importance, thereby limiting the number of rules that Assignment 
Manager checks for assignment.

If none of the rules have a sequence number, or if all of the rules have the same 
sequence number, then Assignment Manager processes all the rules. However, if 
some of the rules in the group have sequence numbers and other rules do not, the 
rules with no specified sequence number are considered to have a sequence number 
of 0 and are evaluated first. Therefore, you should give every rule a sequence 
number if you use sequencing.

NOTE: You can use sequencing even if you are not using rule groups.

Assignment Manager can also evaluate, at periodic intervals in the sequence, 
whether or not an item has been assigned; and if it has, Assignment Manager stops 
evaluating the rest of the rules in that sequence. The sequences are specified in 
segments so that Assignment Manager can pause between segments to find out 
whether assignment has been made, as shown in Table 5 on page 27. When a rule 
results in successful assignment, Assignment Manager processes the rest of the 
rules having the same sequence number and then stops processing. Subsequently, 
the rules with higher sequence numbers do not get processed.

Assignment Manager identifies the beginning and end of a segment within a 
sequence by the change in sequence number. For example, Assignment Manager 
first evaluates rules with a sequence number of 1, then evaluates rules with a 
sequence number of 2, and so on. It does not matter, however, how rules within a 
segment are evaluated.
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At runtime, Assignment Manager evaluates the rules in the first segment 
(Segment 1) first, then stops to find out whether an assignment has been made. If 
it has assigned, Assignment Manager does not continue. If it has not assigned, then 
Assignment Manager continues to the next sequence (Segment 2).

If Assignment Manager is running with multiple groups loaded into memory, each 
with its own sequence, then Assignment Manager evaluates the rules as if they are 
part of one big group with one sequence.

For example, if there are two groups loaded by the same Assignment Manager 
instance with the sequences shown in the following table:

Table 5. Example of a Rule Sequence

Segment Assignment Rule Sequence #

1 Assign Sales Rep West 1

Assign Sales Rep North 1

Assign Sales Rep East 1

2 Assign Sales Rep West 2

Assign Sales Rep North 2

3 Assign Sales Rep West 3

Assign Sales Rep North 3

Assign Sales Rep East 3

Group A Group B

1 1

1 1

1 2

2 2

2 3

3 3

3 3
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Then, this is the order Assignment Manager evaluates those rules:

A1
A1
A1
B1
B1
A2
A2
B2
B2
A3
A3
B3
B3
B3

Sequence numbers can be assigned to assignment rules when creating new 
assignment rules or can be added to assignment rules at a later time. For more 
information about assignment rules, see “Defining Assignment Rules” on page 159.
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Server Key Maps
A server key map defines the rule groups that load and process for each server. You 
can configure a server to load multiple rule groups. When you define server key 
maps, you are actually dividing the rules among the different servers. Server key 
maps are defined in the Server Key Map view in the Assignment Administration 
screen. For information about defining server key maps, see “Defining Server Key 
Maps” on page 168.

You submit an assignment request by specifying the AsgnKey parameter, where the 
AsgnKey parameter is the row id of the assignment rule group that is associated 
with the rules you want to evaluate. When using AsgnSrvr, the AsgnKey parameter 
must be the row id of one of the rule groups defined for the server in the Server Key 
Mappings view. The assignment server (AsgnSrvr) first looks for entries in the 
server key map for a specific server, and then loads rules for only those rule groups 
associated with that server key map. Assignment Manager uses key-based routing 
to route the request to a particular instance of Assignment Manager where the rules 
are loaded for that rule group. 

You can specify multiple servers to load the same rule group. Assignment Manager 
routes requests to one of the servers where that rule group is based on load 
balancing metrics.

However, the server key mapping feature is only supported in certain environments, 
as follows:

■ Interactive and dynamic assignment

For interactive and dynamic assignment, Assignment Manager does not support 
invocation of rules through rule groups. You cannot assign server key mappings 
in these environments, therefore, all active rules are processed.

■ Script or Workflow Process Calling a Business Service

You can invoke Assignment Manager through a business service from within a 
workflow process, or from a script, using one of the following predefined 
business services:
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■ Synchronous Assignment Manager Requests business service. This business 
service has one method available: Assign. This method sends a request to the 
assignment manager server component using the AsgnObjName and 
ObjRowId parameters. All active rules in the database are processed.

Use this business service:

❏ To submit requests to assign a single object row. 

❏ With the Default Group (no server key maps defined).

NOTE: You cannot use this business service to invoke rules based on rule 
groups.

■ Server Requests business service. You can use this generic business service to 
submit requests to the server request broker. With this business service, you 
can use the Assignment Manager server mapping feature. If using this 
business service to invoke rules based on rule groups, pass the AsgnKey 
parameter as the input parameter, and pass the ReqKey parameter as a 
request parameter (in the child property set for the component). Set the 
AsgnKey and ReqKey parameters to the rule group ID of the relevant rule 
group. 

NOTE: You can use this business service with the server key mapping feature.

For more information about business services, see Siebel Business Process 
Designer Administration Guide.
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■ Batch Assignment

You can start a batch assignment task with a particular group of rules loaded. 
This task is performed by specifying the row id of the rule group in the 
Assignment Key (AsgnKey) parameter for the task. If the Asgnkey parameter is 
specified when submitting a batch assignment request, Assignment Manager 
loads only rules of that rule group. If the AsgnKey parameter is not specified 
when submitting a batch assignment request, Assignment Manager loads all 
rules in the Default Group. For more information about the Default Group and 
loading a particular group of rules, see “Assignment Rule Groups” on page 25.

NOTE: Batch assignment does not read entries from the server key map; only 
AsgnSrvr reads entries from the server key map.

Assignment Manager stores rule information in a cache file, and there are 
different cache files for each assignment mode. Batch assignment uses the 
batchrulecache.dat file to store information. After the cache file is created, 
Assignment Manager loads the rules from this cache file instead of from the 
database, resulting in faster loading. However, the next time an assignment is 
submitted and given the rules have been released, the rules again load from the 
database and the cache file is recreated. 

For example, if you submit a request for rule group A, Assignment Manager 
loads the rules from the database, creates a batchrulecache.dat file, and 
processes the rules for group A. If another similar request for rule group A is 
initiated, Assignment Manager uses this same cache file. However, if you submit 
a request for rule group B, Assignment Manager loads the rules from the 
database, overwrites the batchrulecache.dat file, and processes the rules for 
group B. Then, if you submit another request for rule group A, Assignment 
Manager reloads from the database because the batchrulecache.dat file has rules 
only for rule group B. For more information about the AsgnKey parameter, see 
“AsgnKey” on page 242.

NOTE: Siebel Incentive Compensation and Siebel Marketing are specifically designed 
to use the server key mapping and rule group features. For more information, see 
Siebel Incentive Compensation Administration Guide and Siebel Marketing Guide.
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Assignment Criteria
Assignment rules use criteria to determine which candidates qualify as potential 
assignees. Criteria also determine which assignment rule should be evaluated in 
assigning an object. An assignment rule can include none, one, or many criteria. 
Criteria are sets of conditions describing the attributes of objects or candidates, or 
both, that are evaluated to determine optimal assignment. 

Each criteria uses five types of comparison methods to determine if candidates meet 
the criteria. Table 6 shows the available types of assignment criteria.

Table 6. Assignment Criteria Comparison Methods

Comparison Method Description

Compare to Object Compares criteria values to object attributes. Objects 
that possess the required criteria values qualify for this 
criteria.

Compare Object to Person Compares object attributes to candidate attributes. 
Candidates that possess the attributes required by the 
object qualify for this criteria.

Compare to Person Compares criteria values to candidate attributes. 
Candidates that possess the attributes required by the 
criteria qualify for this criteria.

Compare to Organization Compares criteria values to organization attributes. 
Organizations that possess the attributes required by 
the criteria qualify for this criteria.

Compare Object to Organization Compares object attributes to organization attributes. 
Organizations that possess the attributes required by 
the object qualify for this criteria.
32 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Assignment Concepts

Assignment Manager Components
Depending on the comparison method, candidates that meet the criteria have the 
criteria score added to their total score.

NOTE: Assignment rules can be created with no criteria. A rule of this nature 
functions to make sure all data items of a particular object type are assigned, that 
is, all objects of the defined type pass. Use these rules carefully as a rule defined 
with no criteria can make assignments that are not required. Assignment rules with 
no criteria and no assignment object specified are ignored by Assignment Manager.

You should be especially careful creating rules with no criteria using Batch 
Assignment. This mode can produce a very large number of assignments, because 
all objects in the database that have rules with no criteria pass and are assigned in 
this mode. This can result in a backlog of requests that may cause the whole 
environment to stop working if the database or file system runs out of space. 
Therefore, assignment rules with no criteria should be used sparingly with Batch 
Assignment.

Criteria also use an inclusion method to:

■ Define how candidates are selected if the criteria is marked as Required.

■ Determine if the criteria score are added to the candidate’s total score if the 
criteria are satisfied.
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Table 7 shows the types of inclusion methods for assignment criteria.

Table 7. Assignment Criteria Inclusion Methods

Inclusion Method Comments

Include At least one value needs to match:

■ For Compare to Object, the object attribute must match at least 
one listed criteria value.

■ For Compare to Person, the candidate attribute must match at 
least one listed criteria value.

■ For Compare Object to Person, at least one value of the object 
attribute must match one value of the candidate attribute.

■ For Compare to Organization, the organization attribute must 
match at least one listed criteria value.

Note: For Compare Object to Organization, at least one value of 
the object attribute must match one value of the organization 
attribute.

Assignment Manager stops processing this method when one 
value is matched.

Include All All values must match:

■ For Compare to Object, the object attribute must match all 
listed criteria values.

■ For Compare to Person, the candidate attribute must match all 
listed criteria values.

■ For Compare Object to Person, all values of the object attribute 
must match all values of the candidate attribute.

■ For Compare to Organization, the organization attribute must 
match all listed criteria values.

For Compare Object to Organization, all values of the object 
attribute must match all values of the organization attribute.
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Include All Matching This method only works with objects that have skills defined. If 
an object has a skill with a number of skill items, then all the items 
do not need to match for the skill to pass, as long as at least one 
item matches. The more items of the skill that match, the higher 
the score of the passing skill:

■ For Compare to Object, the object skill item must match at 
least one listed criteria value.

■ For Compare Object to Person, at least one of the object skill 
items must match one of the candidate skill items.

For Compare Object to Organization, at least one of the object skill 
items must match one of the organization skill items.

Exclude All values must not match:

■ For Compare to Object, the object attribute must not match 
any of the listed criteria values.

■ For Compare to Person, the candidate attribute must not 
match any of the listed criteria values.

■ For Compare Object to Person, no values of the object attribute 
can match any values of the candidate attribute.

■ For Compare to Organization, the organization attribute must 
not match any of the listed criteria values.

For Compare Object to Organization, no values of the object 
attribute can match any values of the organization attribute.

Table 7. Assignment Criteria Inclusion Methods

Inclusion Method Comments
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Figure 2 shows a Service Request Priority assignment criteria that uses the Compare 
to Object comparison method. In this case, candidates for this assignment rule have 
50 points added to their total score if the object has a Service Request Priority value 
of High. 

Siebel Assignment Manager provides predefined criteria that are related to sales and 
service organizations. If your organization requires other criteria, you can create 
new criteria using Siebel Tools. For more details, see “Assignment Criteria 
Configuration” on page 117.

Assignment criteria can be enabled for multilingual list of values (MLOV) 
capabilities. MLOV allows assignment criteria to be stored in a form that can be 
retrieved and displayed in a variety of supported client languages. For more details 
on this feature, see Siebel Tools Reference. For configuration details, see 
“Configuring MLOV for Assignment Attributes” on page 124.

Figure 2. Sample Assignment Criteria
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Required Assignment Criteria
Use required assignment criteria to match related objects and candidates to 
assignment rules. You can make criteria required by selecting Always from the 
picklist in the Required field. Depending on the criteria’s comparison method, the 
object or the candidate (or both) must meet the required criteria to qualify for the 
assignment rule. Table 8 shows the different requirements for each comparison 
method.

For example, an assignment rule can have a required Service Request Severity 
assignment criteria with a Compare to Object comparison method and a criteria 
value of 1-Critical. In this case, if the object to be assigned has a service request 
severity of 1-Critical, the object qualifies for the assignment rule. An object without 
a service request severity value or one that has a lower service request severity 
value does not qualify for the assignment rule.

Table 8. Required Criteria Requirements

Criteria Comparison Method Requirement

Compare to Object The object must meet the required criteria to qualify for 
the assignment rule.

Compare Object to Person Both the object and the candidate must meet the 
required criteria to qualify for the assignment rule.

Compare to Person The candidate must meet the required criteria to 
qualify for the assignment rule.

Compare to Organization The organization must meet the required criteria to 
qualify for the assignment rule.

Compare Object to Organization Both the object and the organization must meet the 
required criteria to qualify for the assignment rule.
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Required When Available Assignment Criteria
Use required when available assignment criteria to match related objects and 
candidates to assignment rules only when the assignment criteria is available for 
the object or candidate. You can make criteria required when available by selecting 
When Available from the picklist in the Required field.

An assignment criteria is not available for an object or candidate if the assignment 
criteria does not include criteria values or corresponding skills that match the object 
or candidate. Required when available assignment criteria allow you to create 
assignment criteria that are required only when the object or candidate is defined 
with matching criteria values or skills.

For example, an assignment rule can have a required when available Service 
Request Severity assignment criteria with a Compare to Object comparison method 
and a criteria value of 1-Critical. In this case, if the object assigned has a service 
request severity of 1-Critical, the object qualifies for the assignment rule. An object 
that has a lower service request severity value does not qualify for the assignment 
rule. However, an object without a service request severity value qualifies for the 
assignment rule (because the criteria value is null, or not available).

NOTE: If an assignment criteria uses a Compare Object to Person comparison 
method, and criteria value is not found on a person, the criteria fails because 
availability applies only to the object.

Nonrequired Assignment Criteria
Use nonrequired assignment criteria to further determine a suitable match between 
candidates and assignment rules. You can make criteria nonrequired by selecting 
Never from the picklist in the Required field. Use nonrequired criteria that include 
scores to apply scores to candidates. These scores are added to the total scores of 
the candidates for this assignment rule. By using nonrequired criteria with scores, 
you can add a higher score to candidates that satisfy this criteria, while keeping 
candidates that do not satisfy the criteria.

If an assignment rule does not include any required criteria and an object has not 
been selected for the rule, you must define the assignment rule with nonrequired 
criteria that apply to objects that you want to assign. If an assignment object has 
not been defined for an assignment rule, Assignment Manager determines whether 
the assignment criteria can be applied to the object before the criteria is qualified.
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For example, you should use service-related criteria (such as Service Request 
Priority) for an assignment rule that are applied to service-related objects (such as 
Service Request). If you create an assignment rule with Server Request Priority as 
nonrequired criteria, Assignment Manager does not qualify any accounts for the 
criteria because Service Request Priority does not apply to accounts.

If an assignment rule uses only nonrequired assignment criteria, then the 
assignment rule passes even if the minimum score for the rule is not satisfied, 
because the assignment criteria are not required. To avoid this behavior, you can 
alter Assignment Manager so that assignment rules pass only when the minimum 
score for the rule is satisfied, even if the assignment criteria are not required.

To require that an assignment rule satisfies the minimum score for the rule for the 
rule to pass, set the environment variable SIEBEL_AM_MINRULESCORE to TRUE. 
By default, this parameter is set to FALSE. You also need to define this variable as 
a system variable, not a user–defined variable.

To set the SIEBEL_AM_MINRULESCORE system variable for Windows NT

1 In Windows NT, choose Start > Settings > Control Panel.

2 Double-click System.

3 In the System Properties dialog box, select the Environment tab.

4 Click any variable in the Systems Variables list applet.

5 In the Variable field, type SIEBEL_AM_MINRULESCORE.

6 In the Value field, type TRUE.

7 Click Set, and then click Apply.

8 Stop the Siebel Server services and reboot the Windows NT machine.

NOTE: This variable must be set on Siebel Servers that execute Assignment Manager.
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Figure 3 shows an example of setting the SIEBEL_AM_MINRULESCORE system 
variable.

NOTE: If the Assignee from Rule type is All, Must Assign, then the assignment rule 
passes even if the minimum score is not satisfied in this case.

Figure 3. Setting the SIEBEL_AM_MINRULESCORE System Variable
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Criteria Values
For assignment criteria that use the Compare to Object, Compare to Person, or 
Compare to Organization comparison method, each criteria also includes one or 
more values. Criteria values are details associated with criteria that are compared 
to an object or candidate. Depending on the Inclusion value, candidates that meet 
the criteria value have the criteria value score added to their total score. Criteria 
values can be defined as constants or can use wildcard characters to include a wider 
selection of potential matches between assignment rule and object. For more 
information, see “Creating Criteria Values” on page 174.

NOTE: Criteria value scores are only calculated for criteria that use the Include 
inclusion method.

Figure 4 shows a Language Code criteria that uses four languages as criteria values 
(German, Spanish, Italian, and French). Assuming this assignment rule’s minimum 
score is 10 points, and each language is worth 5 points, candidates for this 
assignment rule that possess expertise in at least two of these languages qualify for 
the assignment rule. 

Figure 4. Sample Assignment Criteria Values
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Assignment Attributes
Each criteria value can include one or more assignment attributes. Assignment 
attributes define how the criteria value matches with the following:

■ Each assignment object

■ Employees, positions, or organizations

Figure 5 shows a Product Line Wildcard assignment criteria that uses the Compare 
to Person comparison method. The assignment criteria also uses the Include All 
inclusion method and includes two criteria values. Each criteria value includes two 
assignment attributes. In this case, only candidates that possess an Expert expertise 
in monitors and graphic cards qualify for the assignment criteria.

Figure 5. Sample Assignment Attributes
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Workload Criteria
The workload criterion is a special criteria type used to balance the load between 
candidates. You can create workload criteria by adding workload rules in the 
Assignment Workload view for employees and positions, or the Assignment 
Organization Workload view for organizations. Workload criteria are generally used 
with service assignments. You can also define your own workload rules using the 
Workload Rules view.

NOTE: When creating your own workload rules, keep in mind that performance may 
be affected if Assignment Manager is accessing a nonindex column, retrieving the 
total number of records, the All People or the All Organizations flag is checked on 
the rule, or any combination of the above. 

The workload criteria apply a workload score to candidates based on their current 
workload. The workload score is calculated as follows:

Workload score = Score * (1 – (current workload/maximum workload))

NOTE: The candidate’s current workload excludes the workload of the current object 
being assigned.

Candidates with a lighter workload receive a higher score than candidates with a 
heavier workload. The workload score is then added to the candidate’s score to 
generate a total score. Candidates that have workloads in excess of the maximum 
workload are eliminated from the assignment rule. This criteria prevents employees 
from being overloaded. Multiple workload criteria can be used for each assignment 
rule.

NOTE: If multiple workload criteria are used, the score is added only if each 
workload criterion passes; that is, workload criteria function similarly to the logical 
‘AND’ statement.
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Figure 6 shows a workload criteria that:

■ Adds 100 points to candidates with a workload of 0 items

■ Adds 50 points to candidates with a workload of 1 item

■ Adds 0 points to candidates with a workload of 2 items

■ Eliminates candidates with a workload of more than 2 items if the criteria is 
marked as Required

For information on defining workload see “Defining Assignment Workload” on 
page 182.

Workload criteria can be enabled for multilingual list of values (MLOV) capabilities 
with additional configuration. MLOV allows workload criteria to be stored in a form 
that can be retrieved and displayed in a variety of supported client languages. For 
more details on this feature, see Siebel Tools Reference.

Figure 6. Sample Workload Criteria
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Activity-Based Assignment
Assignment Manager can assign emails as email activities created during inbound 
and outbound email processing. Communications Server (Communications 
Inbound Manager server component) works in conjunction with Siebel eMail 
Response and Siebel Workflow to create activities for inbound emails. 
Communications Server (Communications Outbound Manager server component) 
creates activities for outbound emails. For more information, see Siebel eMail 
Response Administration Guide (Workflow section) and Siebel Communications 
Server Administration Guide.

NOTE: Setting up assignment rules to assign email activities requires customization 
in Siebel Tools for Applets, Workflow Policy Object Column, and Assignment 
Attribute. For related implementation information, see Siebel Business Process 
Designer Administration Guide, Siebel Communications Server Administration 
Guide, and Siebel Tools Reference. 

Availability-Based Assignment
Assignment Manager has the ability to assign employees based on their calendar 
availability and can find out whether candidates are working at the required time—
and whether their calendar is free or not—before assigning an item to a candidate 
or team. This feature is used on employee-based assignment objects only, and 
requires the installation of the Field Service option as it depends on a Field Service 
component, the Appointment Booking System, to check employee availability. It is, 
however, not limited to use in the Field Service application and can be used in any 
application that has employee-based objects. In general, this feature is meant for 
use with employee-based objects that have an associated time duration, such as 
Activities and Service Requests.

To use this feature, certain properties of the assignment object require configuration 
in Siebel Tools. The Activity object is, by default, partially preconfigured for use 
with availability assignment; the Service Request object, however, is not. Both 
objects require configuration in Siebel Tools to activate availability-based 
assignment. See “Configuring Assignment Objects for Availability-Based 
Assignment” on page 107 for further information on these procedures. Assignment 
Manager can also be configured to create an Activity in the calendar of the 
candidate assigned to the object.
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After an object is configured for availability-based assignment, an assignment rule 
activates this feature by means of a check box on the Assignment Rule detail applet. 
For more information on availability-based assignment, see “Assigning Employees 
to Assignment Rules Based on Availability” on page 193.

Skills
Skills are assignment criteria values attributed to specific assignment rules, objects, 
employees, positions, and organizations. Assignment Manager uses skills to match 
assignment rules, objects, employees, positions, and organizations. By default, 
sales objects do not use skills. For information about assigning skills to employees, 
positions, and organizations, see “Assigning Skills to Employees, Positions, and 
Organizations” on page 68. For information about associating skills to objects, see 
“Creating Criteria Values as Skills with Expertise Codes” on page 177.

The Siebel application provides predefined skills, however, you can create new 
skills using Siebel Tools. For information about the predefined skills and creating 
new skills, see “Creating Skills and Using Skill Tables” on page 141.

You enable and configure skills at the criteria level using Siebel Tools. For more 
information, see “Assignment Criteria Configuration” on page 117.

After skills are enabled, Assignment Manager matches skills based on the 
assignment criteria comparison method:

■ If a skill uses the Compare to Object criteria, Assignment Manager matches the 
skill (or object attribute value) specified in the assignment rule to objects that 
include this skill. Objects that include the specified skill qualify for the 
assignment rule.

■ If a skill uses the Compare Object to Person criteria, Assignment Manager 
matches objects that include this skill (or object attribute value) specified in the 
assignment rule to employees or positions that possess this skill. Employees or 
positions that possess the specified skill qualify for the object.

■ If a skill uses the Compare Object to Organization criteria, Assignment Manager 
matches objects that include this skill (or object attribute value) specified in the 
assignment rule to organizations that possess this skill. Organizations that 
possess the specified skill qualify for the object.
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■ If a skill uses the Compare to Person criteria, Assignment Manager matches the 
skill (or object attribute value) specified in the assignment rule to employees or 
positions that possess this skill. Employees or positions that possess the 
specified skill qualify for the assignment rule.

■ If a skill uses the Compare to Organization criteria, Assignment Manager 
matches the skill (or object attribute value) specified in the assignment rule to 
organizations that possess this skill. Organizations that possess the specified 
skill qualify for the assignment rule.

In each of these cases, Assignment Manager applies scores and other filters to find 
the best candidate after a match has been made. For more information about 
assignment criteria comparison methods, see “Assignment Criteria” on page 32. For 
information about assigning skills to employees, positions, and organizations, see 
“Assigning Skills to Employees, Positions, and Organizations” on page 68.

Expertise Codes
Assignment Manager uses expertise codes to rank skills to find the most suitable 
candidate. For example, you do not want to assign a novice to a service request that 
requires an expert. Using expertise codes allows you to prevent assigning objects to 
underqualified candidates.

Expertise codes are predefined for the following skill types (or assignment criteria):

■ Language Code

■ Product

■ Product Line

■ Product Line Wildcard

■ Product Wildcard

The three predefined expertise codes are Novice, Intermediate, and Expert. 
Expertise codes are stored in—and can be modified, added to, or deleted from—the 
List of Values Administration view. For procedures, see “Creating Expertise Codes” 
on page 178. Expertise codes apply only to skills and are global; after they are 
defined, assignment criteria share the same set of expertise codes.
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After you select an expertise code for a skill, Assignment Manager matches 
assignment rules based on the assignment criteria comparison method. If the 
expertise code belongs to a skill that uses the:

■ Compare to Object criteria. The assignment rule passes if the skill’s expertise code 
is equal to, or higher than, the object’s expertise code.

■ Compare Object to Person criteria. The assignment rule passes if the candidate’s 
expertise code is equal to, or higher than, the object’s expertise code.

■ Compare to Person criteria. The assignment rule passes if the candidate’s 
expertise code is equal to, or higher than, the skill’s expertise code.

For more information on assignment criteria comparison methods, see “Assignment 
Criteria” on page 32.

Weighting Factors
Optionally, you can apply weighting factors to expertise codes. While you can use 
expertise codes to eliminate underqualified candidates, using weighted expertise 
codes allows you to weigh skill scores to find the most suitable candidate by further 
eliminating overqualified candidates. For example, you may not want to assign an 
expert to a service request that can be handled by a novice.

Using weighted expertise codes allows you to prevent assigning objects to 
overqualified candidates by applying a weight to the skill score. Each expertise code 
has a defined value, which is its weighting factor. The expertise code with the 
highest defined weighting factor represents the maximum weighting factor (Max 
Weighting Factor). 

The weighting applied to a skill or criteria score is the percentage defined by an 
expertise code’s weighting factor over the maximum weighting factor, see Table 9 
on page 49 for an example. 

Weighting factors are only applied if the expertise code is defined for both the skill 
items and the object attributes. If the expertise is not defined for both, the weighting 
factors are ignored. Weighting factors are also calculated differently for candidates 
and organizations based on the comparison method chosen for the assignment rule.
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■ For the Compare to Person, Compare to Object, and Compare to Organization 
comparison methods, the weighted score is determined as follows:

Score=Criteria Score + Skill Score*(Weighting Factor/Max Weighting Factor)

■ For the Compare Object to Person and Compare Object to Organization 
comparison methods, as neither of these comparison methods can define skill 
scores, the weighted score is determined as follows:

Score=Criteria Score*(Weighting Factor/Max Weighting Factor)

Assignment Manager applies the weighted skill scores and other scores to find the 
most suitable candidate when a match is made.

Weighting factors for expertise codes are stored in—and can be modified, added to, 
or deleted from—the List of Values Administration view. For procedures, see 
“Defining Weighting Factors” on page 179. Weighting factors for expertise codes 
apply only to skills and are global; after they are defined, assignment criteria share 
the same set of weighting factors for expertise codes.

Weighting factors weigh expertise codes by applying a specified percentage to the 
skill score. Table 9 shows sample weighting factors that can be used for the three 
types of predefined expertise codes.

Table 9. Sample Weighting Factors for Expertise Codes

Expertise Code Weighting Factor Percentage of Skill Score

Novice 2 If skill is matched, adds 40% of score for the skill (or 
criteria value)

Intermediate 5 If skill is matched, adds 100% of score for the skill (or 
criteria value)

Expert 3 If skill is matched, adds 60% of score for the skill (or 
criteria value)
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In this example, candidates with an intermediate expertise for the matched skill are 
favored over other candidates, because they receive 100% of the skill score. This 
may be desired if your organization has many more service representatives with an 
intermediate expertise than service representatives with an expert expertise. In this 
case, you make sure that service requests that require only an intermediate 
expertise are assigned to service representatives with an intermediate expertise.
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Assignment Logic and Scoring
This section explains the scoring scheme and assignment methodology used by 
Siebel Assignment Manager to assign candidates to objects.

Assignment Scoring
Siebel Assignment Manager determines which candidates are assigned to objects by 
applying scores to potential candidates. Assignment Manager then ranks the 
candidates based on their scores and selects assignees based on the Assignees from 
Rule type.

Assignment Manager applies scores to candidates from each assignment rule for:

■ Assignment rule

■ Assignment criteria

■ Assignment criteria values (only for criteria that use the Include inclusion 
method)

■ Workload criteria

■ Employee score

■ Position score

■ Organization score

Assignment Manager adds the values of each score to apply a total score for each 
candidate. Before implementing Assignment Manager, you should carefully 
consider the value for each score, and assign higher scores to more important 
attributes.

Assignment Manager can also be configured to save the scores of candidates who 
are assigned to an assignment object. The scores of each candidate are stored in the 
appropriate team table. Team member scores are written independently for each 
type of candidate (employees, positions, and organizations). Saved candidate scores 
can be accessed by other Siebel application modules and used to produce items 
such as analysis reports for employee utilization. The scores can also be exposed to 
users for review and sorting. See “Configuring Assignment Objects for Team 
Scoring” on page 114 for information on configuring this feature.
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Multitiered Assignment
By default, Assignment Manager independently matches people and organizations 
to assignment objects. Activating Assignment Manager to use multitiered 
assignment, however, allows assignments based on the relationship between a 
person and their organization or an organization and its people. Without multitiered 
assignment—or appropriate assignment rules—it is possible for Assignment 
Manager to assign an unrelated organization or person to an assignment object. 
Multitiered assignment has the following modes of assignment operation: 

■ Independent—Assigns people and organizations that qualify, regardless of 
whether they are related or not.

■ Person-Oriented—Assigns people that qualify, then assigns only qualified 
organizations that the assigned people belong to. 

■ Organization-Oriented—Assigns organizations that qualify, then assigns 
qualified people from those organizations. 

■ Organization and Person-Oriented—Identifies qualified people and 
organizations, then assigns only those that have both a qualified person and 
related qualified organization.

NOTE: Use caution when the Organization and Person-Oriented mode is used 
with assignment rules that use the Assignees from Rule selection One, Best Fit. 
Inconsistencies can occur. The One, Best Fit Assignees from Rule assigns only 
the highest scoring position or organization. If the highest scoring position does 
not have a qualifying organization, or if the highest scoring organization does 
not have a qualifying position, the object remains unassigned, even if a lower 
scoring position and its related organization both qualify for the assignment 
rule.

This logical assignment feature is well-suited to Sales organizations. Assignment 
objects must be configured to activate multitiered assignment. For more 
information, see “Configuring Assignment Objects for Multitiered Assignment” on 
page 112. For more information and examples of multitiered assignment, see, 
“Using Multitiered Assignment with Sales Assignment Rules” on page 78.
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Assignment Methodology
Siebel Assignment Manager uses the following methodology to assign candidates to 
assignment objects.

1 Find assignment rules for the object. Find active assignment rules to be evaluated 
for the object being assigned. If an assignment rule does not include any 
assigned objects, then the assignment rule is evaluated for all objects. Objects 
should be assigned to assignment rules in the Object field of the Assignment 
Rules view.

NOTE: When an assignment object has multiple rules, rules are evaluated 
randomly. 

2 Evaluate assignment criteria for the object. Evaluate each criteria that uses the 
Compare to Object comparison method to find assignment rules that satisfy the 
object’s attributes.

NOTE: If criteria marked as Required do not satisfy the object’s attributes, then 
Assignment Manager stops evaluating the assignment rule. 

3 Determine a list of candidates from each assignment rule. For each assignment rule 
that satisfies Step 2, determine a list of candidates relevant to the assignment 
rule:

■ If the object uses position-based assignment, then the candidate list includes 
the positions registered in the Assignment Positions view.

■ If the object uses employee-based assignment, then the candidate list 
includes the employees registered in the Assignment Employees view.

■ If the object uses organization-based assignment, then the candidate list 
includes the organizations registered in the Assignment Organizations view.

■ If the All People field is checked in the Assignment Rules view, then the 
candidate list includes registered employees or positions in the Siebel 
database.
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■ If the All Organization field is checked in the Assignment Rules view, then 
the candidate list includes registered organizations in the Siebel database.

Candidates pass for assignment unless a required rule fails or there is no relevant 
attribute.

NOTE: If no rules pass, then Assignment Manager assigns the object row to either 
the default employee or default position, depending on rules that are associated 
with the assignment object. For example, a service request is assigned to Default 
Employee, whereas an opportunity is assigned to Default Position. If the 
assignment object is configured for assignment to an organization and no rules 
pass, Assignment Manager assigns Default Organization. For more information, 
see Appendix A, “Assignment Object Parameters.”
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4 Evaluate each candidate against assignment rule criteria. Evaluate each candidate 
against the criteria using the selected comparison method as described in the 
following table:

NOTE: Candidates fail if they do not match the criteria or if they fail to meet the 
minimum score required for the criteria. Candidates that fail criteria marked as 
Required are not evaluated further against this rule.

5 Score each qualified candidate for each assignment rule. Scoring of each candidate 
for an assignment rule is based on the sum of:

■ Assignment rule score

■ Score of each assignment criterion that is satisfied

Comparison Method Description

Compare Object to 
Person

Remove candidates that do not satisfy required object attributes 
when using this comparison method. These criteria make sure 
that qualified candidates possess the required skills for this 
object.

Compare to Person Remove candidates that do not satisfy required criteria values 
when using this comparison method. These criteria make sure 
that only qualified candidates with the required skills are 
evaluated for this assignment rule.

Compare Object to 
Organization

Remove organizations that do not satisfy required object 
attributes when using this comparison method. These criteria 
make sure that qualified organizations possess the required 
skills for this object.

Compare to 
Organization

Remove organizations that do not satisfy required criteria 
values when using this comparison method. These criteria 
make sure that only qualified organizations with the required 
skills are evaluated for this assignment rule.

Workload Remove candidates that have a workload greater than the 
maximum workload specified in the Assignment Workload 
view (only if the criteria is marked as Required).
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■ Each assignment criterion value that is satisfied

Some assignment criteria values (skills) are weighted by expertise.

❏ To rank expertise codes, use the Order field in the List of Values view. For 
procedures, see “Creating Expertise Codes” on page 178. 

❏ To define expertise weight, use the Weighting Factor field in the List of 
Values view. For procedures, see “Defining Weighting Factors” on 
page 179. 

For more information on skills, see “Skills” on page 46. For more information 
on expertise, see “Expertise Codes” on page 47. For more information on 
weighting factors, see “Weighting Factors” on page 48.

NOTE: Criteria value scores are calculated only for criteria that use the Include 
inclusion method.

■ Score for the candidate

This value is specified in the Assignment Employees view, Assignment 
Positions view, or Assignment Organizations view.

■ Workload score

Prorated score based on the current workload of candidates compared to the 
maximum workload allowed. The workload score is calculated as:

❏ Workload Score = Score * (1 – (current workload/maximum workload))

For more information, see “Workload Criteria” on page 43.

If the Assignment Rule form has the Check Calendar box selected, Assignment 
Manager uses the availability-based assignment feature to submit employee 
availability information to the Field Service Appointment Book component, 
which reviews qualified candidates’ calendars and work schedules to see who is 
available to undertake the assignment at the required time. See “Availability-
Based Assignment” on page 45 for further information on this feature.
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6 Apply the Assignees from Rule method to scored candidates to generate a list of 
potential assignees. Use the Assignees from Rule type to eliminate candidates and 
determine a final list of assignees. The following table describes the types of 
assignment rules.

7 Determine the primary assignment rule. If an exclusive assignment rule does not 
exist, then the primary assignment rule is the assignment rule with the highest-
scoring assignee. If all assignment rules do not have a score, then the assignment 
rule with the lowest row ID is selected.

8 Evaluate exclusive assignment rules. If at least one assignment rule marked as 
Exclusive has candidates that satisfy Step 6, then find the exclusive assignment 
rule with the highest-scoring assignee. Keep all assignees in this assignment rule 
and eliminate other assignees.

If more than one exclusive assignment rule yields the same highest score, then 
assign the object to:

■ The default employee for employee-based assignments

■ The default position for position-based assignments

Assignees from Rule Description

All, Above Minimum Use assignees with an assignment score greater than or equal 
to the assignment rule’s minimum score.

All, Must Assign Same as All, Above Minimum, except that the highest-scoring 
candidate is a potential assignee even if all candidates fail to 
meet the minimum score.

One, Best Fit Use the assignee with the highest assignment score from this 
assignment rule.

One, Random Choose a random assignee whose score is greater than or equal 
to the minimum score required for this assignment rule.
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■ The default organization for organization-based assignments

NOTE: When two or more exclusive assignment rules have the same score and the 
Keep Man Asgn Primary Position assignment property is set to TRUE, then the 
manually assigned primary position is retained and the default position is added 
to the team as a nonprimary.

9 Determine the primary assignee. Determine the primary assignee from the primary 
assignment rule:

■ For objects that use employee-based assignments, set the primary assignee 
to the primary employee selected in the Primary Employee field of the 
Assignment Rule form applet for the primary assignment rule. If the selected 
primary employee is not an assignee that satisfies Step 6 on page 57, then 
select the highest-scoring employee for the primary assignment rule that 
satisfies Step 6 on page 57.

■ For objects that use position-based assignment, set the primary assignee to 
the primary position selected in the Primary Position field of the Assignment 
Rule form applet for the primary assignment rule. If the selected primary 
position is not an assignee that satisfies Step 6 on page 57, then select the 
highest-scoring position for the primary assignment rule that satisfies Step 6 
on page 57.

■ For objects that use organization-based assignments, set the primary 
organization to the primary organization selected in the Primary 
Organization field of the Assignment Rule form applet for the primary 
assignment rule. If the selected primary organization is not an assignee that 
satisfies Step 6 on page 57, then select the highest-scoring organization for 
the primary assignment rule that satisfies Step 6 on page 57.

NOTE: The primary employee, position, or organization must pass the minimum 
score required for this assignment rule to be assigned as the primary assignee. 
The only exception is when the Assignee from Rule type is All, Must Assign, in 
which case the highest-scoring candidate or organization is a potential assignee 
if all candidates fail to meet the minimum score. For more information about 
Assignee from Rule types, see Table 4 on page 24.
58 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Assignment Concepts

Assignment Logic and Scoring
10 Filter out certain assignees based on multitiered mode. By default, the assignment 
mode is set to independently assign qualifying people and organizations. Three 
other assignment modes are available, which allows filtering of unwanted, but 
qualifying, people and organizations based on the relationship that exists 
between them. See “Multitiered Assignment” on page 52 for further 
information.

11 Generate assignments. Write assignees to the object table:

■ Write the primary assignment rule and primary assignee to the object’s 
primary table.

■ For team-based objects, write assignees to the object’s team table.

NOTE: For interactive assignments, generated assignees can be assigned 
manually in the Assign Employees view.
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Assignment Operation Modes
This section explains the assignment modes available for running Assignment 
Manager:

■ Interactive

■ Dynamic

■ Batch

■ Mobile

■ Contact Denormalization

■ Product Denormalization

Assignment modes are established using the Server Administration views or the 
command-line interface. For more information, see Chapter 5, “Running 
Assignment Manager.”

Interactive Assignment
Running Assignment Manager in interactive mode allows users to make real-time 
assignments.

NOTE: Mobile users running Assignment Manager in interactive mode do not make 
real-time assignments, because interactive assignments made by mobile users are 
not applied to the server until they resynchronize.

By clicking the Menu button on any selected object and choosing Assign, Interactive 
Assignment allows you to view the list of assignees generated by Assignment 
Manager. You can then override the assignment and select another assignee from 
the list in real time.
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Dynamic Assignment
Dynamic Assignment allows users to create assignments as other users and server 
programs change assignment object attributes. For example, if a user changes the 
revenue amount or address of an Opportunity, Dynamic Assignment detects the 
change and automatically invokes Assignment Manager to reassign the Opportunity 
to a different territory or sales team as necessary.

The dynamic assignment process is as follows: a user makes a change that requires 
assignment; a database trigger fires (triggers are setup by the Generate Triggers 
server component); the Workflow Monitor Agent recognizes this trigger and assigns 
the object (internally invoking Assignment Manager). By default, the Server 
Request Broker and the Assignment Manager server components are not explicitly 
used in Dynamic Assignment. 

Workflow Monitor
To run Dynamic Assignment, a Workflow Monitor Agent must be active. A 
Workflow Monitor Agent detects when a user changes data related to objects. For 
more information about Workflow Monitor Agent, see Siebel Business Process 
Designer Administration Guide.

Generate Triggers
The Generate Triggers server component generates the database triggers used by 
Workflow Manager to detect changes. Generate Triggers reads the Workflow Policy 
Object and Assignment Object definitions in the Siebel repository and generates the 
appropriate database triggers to monitor changes.
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Batch Assignment
You can use Batch Assignment to assign multiple records of an object in a single 
batch. For example, after changing assignment rule definitions, you can use Batch 
Assignment to reassign objects using the new assignment rules. Batch Assignment 
is optimized to process a large number of items efficiently. You should monitor the 
performance of Batch Assignment and increase or decrease the number of running 
tasks to obtain the optimal performance.

You can set up Batch Assignment to run Assignment Manager in Contact 
Denormalization mode. For more information on Contact Denormalization, see 
“Contact Denormalization” on page 63.

Mobile Assignment
Mobile Assignment allows mobile users to make interactive and dynamic 
assignments. Changes to the mobile client’s database are queued and are applied to 
the server the next time the client synchronizes.

Assignment Manager automatically performs interactive assignments made by the 
mobile user after synchronization. Changes to assignment rules and objects are 
updated, and affected objects are reassigned dynamically.

NOTE: Mobile users running Assignment Manager in interactive mode do not make 
real-time assignments, because interactive assignments made by mobile users are 
not applied to the server until they resynchronize.
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Contact Denormalization
In Contact Denormalization mode, Assignment Manager denormalizes positions 
from the Accounts and Opportunities team tables by copying these positions to the 
associated contacts in the Contact team table, even if the assignees are not assigned 
to the contacts:

■ Positions from the Accounts team table are copied to the Account Contact access 
list.

■ Positions from the Opportunity team table are copied to the Opportunity Contact 
access list.

If you want the Contact access list to reflect the positions in both the Account and 
Opportunity team tables, you must associate the contact with an account and then 
associate the contact with an opportunity. If a team member is removed from the 
Account or Opportunity’s team table, then the position on the associated Contact’s 
access list can also be removed by Contact Denormalization (dependent on the 
properties of the Contact Denormalization assignment object. For more 
information, see “Contact Denormalization Object Parameters” on page 315.) 
Similarly, if the Account Team has manually assigned team members and you want 
the same team members on both the access list and Account team, you must run 
Contact Denormalization after the account assignment. This process can be run in 
dynamic and batch assignment modes. 

NOTE: Positions marked Indirect by Contact Denormalization in Contact Access list 
are not dropped by contact assignment, that is, contact assignment does not drop 
the positions that were added by Contact Denormalization. 

Contact Denormalization checks the Lock Assignment column on assignment 
objects before denormalizing. If this flag is checked, Contact Denormalization does 
not denormalize the contact record. For more information about the Lock 
Assignment feature, see the usage comments for the Lock Assignment Column 
run-time parameter in Table 38 on page 276.

NOTE: Both Account and Contact and Contact and Opportunity have a many-to-
many relationship. The Account and Contact many-to-many relationship is a new 
feature as of the version 7.0 release.
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Assignment Manager also assigns a primary position to the contact when running 
in Contact Denormalization mode using the following methodology:

1 If the Set Primary Position flag is checked and a primary position is not currently 
selected, then Assignment Manager sets the creator’s primary position as the 
new primary position.

2 If a primary position is not selected for the creator, then Assignment Manager 
sets the default position as the new primary position.

3 If a default position is not defined, then Assignment Manager does not set a 
primary position.

However, Contact Denormalization does not remove positions marked as the 
Primary, even if the positions no longer exist on an associated account or 
opportunity (with the Denorm Flag set).

The Contact Denormalization object is reserved to run Assignment Manager in 
Contact Denormalization mode. Assignment Manager does not evaluate the Contact 
object against any assignment rules in Contact Denormalization mode, and 
therefore does not assign candidates to objects. For this reason, do not create 
assignment rules for the Contact Denormalization object. By default, Assignment 
Manager runs Dynamic Assignment in Contact Denormalization mode. You can also 
configure Assignment Manager to run Batch Assignment in this mode.

For more information about Contact Denormalization, see Chapter 5, “Running 
Assignment Manager,” and “Activating Contact Denormalization” on page 232.
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Product Denormalization
In Product Denormalization mode, Assignment Manager denormalizes 
organizations from the Price List table into the Product table by copying these 
organizations to the products associated with the price lists.

NOTE: Product to Price List is a many-to-many relationship.

Assignment Manager also assigns a primary organization to the product when 
running in denormalization mode using the following methodology:

1 If the Set Primary Organization flag is checked and a primary organization is not 
currently selected, then Assignment Manager sets the creator’s primary 
organization as the new primary organization.

2 If a primary organization is not selected for the creator, then Assignment 
Manager sets the default organization as the new primary organization.

3 If a default organization is not defined, then Assignment Manager does not set 
a primary organization.

The Product Denormalization object is reserved to run Assignment Manager in 
Product Denormalization mode. Assignment Manager does not evaluate the Product 
object against any assignment rules in Product Denormalization mode, and 
therefore does not assign organizations to objects. For this reason, do not create 
assignment rules for the Product Denormalization object. Additionally, you should 
run Product Denormalization only in batch mode. For more information about 
running Batch Assignment, see “Running Assignment Manager in Batch Mode” on 
page 236.
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To use Assignment Manager for your organization, you must develop and document 
a clear set of strategies that can be consistently applied by Assignment Manager or 
system administrators.

For each assignment object, you should consider how to develop assignment rules 
that:

■ Optimally match the attributes of assignment objects to criteria values of the 
assignment rules. This is commonly used for traditional territory assignment 
where territories are managed exclusively through assignment administration. 
Employees, positions, or organizations associated with these rules are potential 
assignees. Sales organizations typically use this method.

■ Optimally match the attributes of assignment objects to employee skills. 
Expertise is managed using employee, position, or organization skills. Service 
organizations typically use this method.

■ Reflect a blend of the attributes outlined in the two methods described above. 
For example, sales organizations can benefit from assignment rules using 
employee skills as well as territory rules.

This chapter discusses common strategies that you can use to develop effective 
assignment rules in sales and service organizations. 
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Assigning Skills to Employees, Positions, and 
Organizations

You use skills to find the best matching candidates to assign to certain projects, 
service requests, and so on. Skills can be associated with individual employees, 
positions, or organizations. During the assignment process, Assignment Manager 
tries to find candidates that have the relevant skills for assignment to a particular 
item. For example, a service request requiring an agent who has expertise for a 
particular product is routed to someone who has that product expertise as a part of 
their skillset. For more information about how skills are applied, see “Skills” on 
page 46, and “Creating Criteria Values as Skills with Expertise Codes” on page 177. 
For more information about creating skills, see “Creating Skills and Using Skill 
Tables” on page 141.

You can enable and configure skills at the criteria level by using Siebel Tools. For 
more information, see “Assignment Criteria Configuration” on page 117. 

To associate skills with a position

1 From the application-level menu, choose View > Site Map > Group 
Administration > Positions.

2 In the Positions list, select the position for which you want to associate skills. 

3 Click the Assignment Skills view tab.

4 In the Assignment Skills list, add a new record.

5 From the Item field drop-down list, select a skill.

6 In the Position Skill Items list, add a new record and complete the necessary 
fields.

The columns that display in the Position Skill Items list depend on the skill 
chosen from the drop-down list in the Assignment Skills list.

To associate skills with an organization

1 From the application-level menu, choose View > Site Map > Group 
Administration > Organizations.
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2 In the Organizations list, select the organization for which you want to associate 
skills.

3 Click the Assignment Skills view tab.

4 In the Assignment Skills list, add a new record.

5 In the Item field, select a skill from the drop-down list.

6 In the Organization Skill Items list, add a new record and complete the necessary 
fields.

The columns that display in the Organization Skill Items list depend on the skill 
chosen from the drop-down list in the Assignment Skills list.

To associate skills with an employee

1 From the application-level menu, choose View > Site Map > User 
Administration > Employees.

2 In the Employees list, select the employee for whom you want to define skills.

3 Click the Assignment Skills view tab.

4 In the Assignment Skills list, add a new record.

5 In the Skill field, select a skill from the drop-down list.

6 In the Employee Skill Items list, add a new record and complete the necessary 
fields.

The columns that display in the Employee Skill Items list depend on the skill 
chosen from the drop-down list in the Assignment Skills list.

NOTE: Employees can also track and update their own skill profiles in the User 
Preferences Profile view (View > User Preferences > Profile > Employee Skills).
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Assignment in Sales Organizations
Sales organizations typically need to distribute opportunities and accounts to the 
proper people within the organization. Assignment of sales opportunities must take 
place quickly so that sales representatives can respond to potential revenue-
generating opportunities. Information must also be readily available to salespeople 
to close the maximum number of sales possible.

Assignments in sales organizations are commonly made to positions responsible for 
a territory. Mobile salespeople who are not connected to a network can share 
information and work as a collaborative sales force on sales opportunities. Sales 
organizations can therefore use the talents of their salespeople within their entire 
organization.

Siebel Assignment Manager allows you to create territories for positions using a 
wide variety of criteria. By assigning objects to positions, you can have one sales 
representative inherit the opportunities, accounts, and contacts from another sales 
representative by reassigning the employee responsible for a specific position.

After you have created the territories using assignment criteria, a major territory 
realignment can negatively affect your system resources. If the realignment is large, 
Assignment Manager may create a volume of transactions for mobile clients, which 
increases synchronization time drastically. To avoid this, you can run Database 
Extract again and have the mobile clients initialize their databases. Because the 
time required to run Database Extract for multiple clients may be significant, try to 
coordinate territory realignments with Database Extracts to occur during a time of 
low system utilization.

Because sales organizations typically distribute their accounts and opportunities 
based on territories, create assignment rules based on these territories. Assignment 
Manager includes two additional views, Territory List view and Territory Detail 
view, originally designed for sales organizations. However, these views function 
exactly as the Assignment Rule view and Assignment Criteria view respectively. The 
Territory List view has been simplified to allow users to define their sales territories. 
For this reason, some of the assignment options covered in this chapter do not 
appear in the Territory List view.
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To illustrate how Assignment Manager can be used in a sales organization, this 
section uses two related examples to show how you can strategically distribute 
salespeople by using assignment rules based on territories and a third scenario that 
examines multitiered assignment in various modes. 

NOTE: The Territory List and Detail views will eventually be phased out from the 
Assignment Administration screens. If your configuration currently uses these 
views, note that they can migrate to the existing Assignment Rule views with no loss 
of functionality or data. For further information, contact Siebel Technical Support.
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Creating Sales Assignment Rules Based on Territories
This section uses an example to demonstrate how a sales organization can 
strategically assign salespeople based on territories. This example assumes that 
your sales organization wants to create four territories based on geographic 
location. In this case, you may want to create four assignment rules: US NW, US NE, 
US SE, and US SW, as shown in Figure 7. Assignment Manager then assigns your 
salespeople depending on the geographic location of the sales opportunity.

NOTE: For detailed instructions on performing each step, see Chapter 4, “Assignment 
Rules.”

To develop assignment rules based on territories

1 Create assignment rules as sales territories.

In this example, in the Assignment Rule view you create four assignment rules, 
one for each territory as shown in Figure 7.

2 Determine the assignment criteria.

In this example, in the Assignment Criteria view, you define Account State as 
the criteria for each assignment rule, because the assignment rules are based on 
territories.

Figure 7. Example of Creating Sales Territories

One of the assignment rules representing
a sales territory (US NW) highlighted in

the Assignment Rules view.
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3 Define the criteria values.

In this example, in the Assignment Criteria view, you use the states that make 
up each territory as criteria values.

The following figure shows an example of defining a sales territory using 
assignment criteria and values as described in Step 2 and Step 3.

4 Add the Positions.

In the Assignment Positions view, add the sales positions responsible for each 
territory. As an example, you add Division Manager - West and Field Sales 
Representative to the US NW assignment rule.

NOTE: To specify a primary position, you must set the primary at the rule level 
(in the Primary Position field in the Assignment Rule view) and also assign a 
specific position within that rule (Assignment Rules > Positions). For more 
information on the primary position, see “Creating Assignment Rules” on 
page 161. For more information about assigning positions, see “Adding Positions 
to Assignment Rules” on page 195.
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5 Release the assignment rules.

In the Assignment Rules view, click the Release button. You can then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about running Batch Assignment, see “Running Assignment 
Manager in Batch Mode” on page 236.

After these assignment rules are released, Assignment Manager assigns salespeople 
based on the geographic location of the sales opportunity. For example, a sales 
opportunity in California is assigned to a Western Field Sales Representative. 

NOTE: After an Account or Opportunity has been assigned to a Sales Team, the list 
of Territory definitions used by Assignment Manager for this item is added to the 
item record in the Territories field. This list is not modifiable in the standard user 
Account or Opportunity detail views. If manual changes are made to the Sales Team 
over time and the Territory list needs to be updated to match the changes, then use 
the Accounts view under the Data Administration screen to make the updates.
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Creating Sales Assignment Rules That Combine Criteria
The example in this section assumes that your sales organization now wants to 
further distribute its salespeople in the same geographic location based on revenue 
potential. In this case, you can create territories that use the same geographic 
location but different revenue potentials. In this example, you may want to create 
two assignment rules: US SW High Revenue and US SW Low Revenue as shown in 
Figure 8. Assignment Manager then assigns your salespeople, depending on both 
the geographic location and the revenue potential of the sales opportunity.

NOTE: For detailed instructions on performing each step, see Chapter 4, “Assignment 
Rules.”

To develop assignment rules that combine criteria

1 Create assignment rules.

In this example, create two assignment rules, one for each territory, as shown in 
Figure 8.

2 Determine the assignment criteria.

In this example, select Account State and Revenue as the criteria.

Figure 8. Example of Creating Assignment Rules with Combined Criteria

Two assignment rules, one
for each territory, created for

Opportunity objects.
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3 Define the criteria values.

In this example, use the states that make up each territory as the Account States 
criteria values. For the Revenue criteria values, select different assignment 
attributes for each assignment rule:

■ For the US SW High Revenue Assignment Rule, type 100,001 in the Revenue 
Low assignment attribute.

■ For the US SW Low Revenue Assignment Rule, type 100,000 in the Revenue 
High assignment attribute.

NOTE: The columns that appear in the Values list applet change dynamically 
depending on the criteria selected in the Criteria list applet.

The following figure shows an example of defining the US SW High Revenue 
assignment rule as described.

4 Add the positions for this assignment rule.

In this example, you add a different sales position for each assignment rule:

■ For the US SW High Revenue assignment rule, add Division Manager - West.
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■ For the US SW Low Revenue assignment rule, add Western Field Sales 
Representative.

The figure shown in Step 3 shows an example of defining the US SW High 
Revenue assignment rule as described.

5 Release the assignment rules. 

In the Assignment Rules view, click the Release button. You may then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about running Batch Assignment, see “Running Assignment 
Manager in Batch Mode” on page 236.

After these assignment rules are released, Assignment Manager assigns 
salespeople based on the geographic location and revenue potential of the sales 
opportunity. For example, a sales opportunity in Nevada with a revenue 
potential of over $100,000 is assigned to the western division manager. However, 
a sales opportunity in New Mexico with a revenue potential of $100,000 or lower 
is assigned to a western field sales representative.
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Using Multitiered Assignment with Sales Assignment Rules
Multitiered assignment is a logical assignment feature that considers the 
relationships between people and organizations before assigning an object. 
Multitiered assignment functions in various modes; see “Multitiered Assignment” 
on page 52 for more information on multitiered assignment and its assignment 
modes. Multitiered assignment must also be configured for assignment objects. For 
more information on this process, see “Configuring Assignment Objects for 
Multitiered Assignment” on page 112. The following scenarios show how 
multitiered assignment functions in various modes. Each scenario is based on the 
same sales opportunity and the same assignment rules.

Independent Assignment. If multitiered assignment is disabled, Assignment Manager 
assigns the object independently, resulting in the following scenario:

■ All people and organizations not matching assignment rule criteria are filtered 
out.

■ For each person that matches, assign that person to the object.

■ For each organization that matches, assign it to the object.

■ The European and Asian Sales Representatives independently are assigned to 
the same opportunity as well as the Europe and North America organizations, 
as shown in the following table:

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American 
Sales 
Representative

N North America Y North 
America

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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Person-Oriented Assignment. If multitiered assignment is set to person-oriented mode 
the following situation occurs:

■ All organizations and people not matching assignment rule criteria are filtered 
out.

■ For each person that matches, assign that person to the object.

■ Evaluate organization candidates for the assigned people’s organizations. If the 
organization matches, assign that organization to the object.

■ The European and Asian Sales Representatives are assigned, but only the Europe 
organization is assigned, as shown in the following table:

Organization-Oriented Assignment. If multitiered assignment is set to organization-
oriented mode the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are 
filtered out.

■ For each organization that matches, assign it to the object. 

■ Evaluate each person candidate for the assigned organization’s people. If a 
person matches, assign that person to the object.

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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■ The Europe and North America organization are assigned, but only the 
“European Sales Representative” is assigned, as shown in the following table:

Organization and Person-Oriented Assignment. If multitiered assignment is set to 
organization and person-oriented mode, the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are 
filtered out.

■ For people and organizations that satisfy the assignment rule criteria, assign 
only those that have both a corresponding organization and person that meet the 
criteria (similar to a logical AND statement).

■ Only the European Sales Representative and the Europe organization are 
assigned, as shown in the following table:

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N
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Assignment in Service Organizations
In a service organization, service requests can often be resolved by the first 
customer service representative (CSR) who services the customer. However, when 
the request cannot be resolved, or when the service request is logged through the 
Internet, ownership must be transferred to a service representative who possesses 
the expertise to handle the request.

In this environment, it becomes critical to assign employees with the proper 
expertise and skills to service requests. Therefore, you should assign employees to 
objects because some employees possess specific skills that are different from those 
of other CSRs or field service engineers. When service representatives are on 
vacation, are promoted, or assume different responsibilities, work assigned to these 
employees must be reassigned based on the skills and workloads of other 
employees in the service organization.

NOTE: A quick-start method is available if you plan to assign service requests using 
the same assignment rule. To use this method, skip to Step 4 on page 82 in the 
following procedure.

To develop effective assignment rules for your customer service organization

1 Determine the different assignment objects that need to be assigned.

Service organizations need to assign ownership of a wide variety of tasks. These 
tasks may include service requests, activities, and accounts. In addition, a 
product development organization may need to assign ownership of product 
defects to engineers. For instance, you may decide to assign only service 
requests and product defects, because the associated activities are manually 
assigned by owners of those objects.

2 Determine if multiple assignment objects are assigned using the same 
assignment rules.

Multiple assignment objects can be assigned using the same assignment rules. 
For example, if you are assigning accounts and service requests in the same 
manner, you can use the same assignment rules by associating those rules with 
multiple assignment objects.
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3 For each assignment object, determine which of the objects is assigned using the 
same assignment rules.

The Compare to Object comparison method allows you to assign different 
groups of objects using different rules. Typically, complex service environments 
assign different groups of service requests using different rules, such as 
segmenting the service requests based on service request priority.

4 Determine the strategy for each group of objects to be assigned using the same 
assignment rules.

Use the skill criteria to minimize the number of assignment rules. One 
assignment rule can match different candidates to various objects based on the 
object characteristics and candidate skills. To determine optimal assignment, 
determine the criteria that you wish to evaluate for each candidate to make sure 
that the candidate possesses the proper skills to handle the task. This is the 
primary type of criteria you use most frequently for implementing assignments 
in a customer service environment. These criteria are defined using the Compare 
Object to Person comparison method in the Assignment Criteria view.

5 Define workload rules.

Determine the various methods of calculating workloads for employees in your 
organization. Each workload rule is associated with a specific assignment 
object. For instance, you can define two workload rules to calculate:

■ Open Service Requests for an employee

■ Critical Service Requests submitted through Siebel eService

6 Define assignment rules, assignment criteria, assignment criteria values, and 
assignment workloads.

Using the strategy, rules, and criteria discussed above, define the assignment 
rules and the corresponding details using the Assignment Administration views. 
In defining rules, criteria, values, and workloads, you can specify scores for each 
component. These scores are aggregated in determining the total score for each 
candidate of an assignment rule.
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7 Define candidates.

Using the All People check box or the Assignment Rule Employees view, define 
the eligible employees for assignment. You may further restrict or weight 
employees who have different skills using the Compare to Person assignment 
criteria.

8 Define employee skills.

After the assignment rules and the corresponding details have been defined, a 
customer service manager must update the employee skill information (such as 
product expertise, language skills, and geography) using the Employee Skills 
view (User Administration >Employees >Employee Skills). Assignment 
Manager uses these attributes when evaluating Compare to Person and Compare 
Object to Person assignment criteria.

9 Release assignment rules.

In the Assignment Rules view, click the Release button. You can then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about Batch Assignment, see “Running Assignment Manager in 
Batch Mode” on page 236.

Figure 9 shows a sample assignment rule for assigning support representatives to a 
service request.

Figure 9. Assignment Rule for a Service Organization
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The assignment rule shown in Figure 9 on page 83:

■ Matches any service request:

■ For Pentium III 600 products

■ With a priority of High

■ Uses two criteria with the following values:

■ Product Wildcard. A list of products that include the value CPU Pentium III 600

■ Service Request Priority. A list of service requests whose priority level is High

Creating Field Service Assignment Rules Using Availability
The service request object—which is often associated with a job, a finite time 
period, and a specific owner—is an example of an object that can be assigned using 
Assignment Manager’s Availability-based assignment feature. The following Field 
Service example creates an assignment rule that evaluates a service request object 
and assigns the object to the highest scoring employee based on the employee’s skill 
level and availability. To use the availability feature, certain setup procedures must 
be performed in the Field Service application before creating the assignment rule. 
See “Availability-Based Assignment” on page 45 for further information on this 
feature and its requirements. Several configurations must also be made to the 
Assignment object before using the availability feature. See “Configuring 
Assignment Objects for Availability-Based Assignment” on page 107. The following 
example assumes that a service region (California Service Region), employees (West 
Coast Service Representative and West Coast Service Manager), and a product 
(Pentium III Desktop) are defined. The server component FieldSvc must also be 
enabled before running the example.
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To set up the Field Service application for availability assignment

1 Verify a schedule exists with valid hours.

Navigate to the Application Administration screen Schedules view. For this 
example, select the 12x5 Support schedule in the All Schedules List and click the 
Schedule Hours tab. Make sure the hours listed are valid. The following figure 
shows this view.

2 Set up a Service Region.

Navigate to the Scheduling Administration screen Service Regions view. For this 
example, select the California Service Region. In the Schedule field, select 12x5 
Support.

3 Set up the parameter set for the Service Region.

With California Service Region selected, navigate to the Parameters Sets view (in 
the Scheduling Administration screen). For this example, select the West Coast 
Parameters used by the California Service Region and click the Parameters tab. 
Update the following parameter records:

■ ABS Days to Start=1

■ ABS Days to End=20

■ ABS Logging Level=4
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4 Set up Server Key Mappings

Navigate to the Server Key Mappings view in the Scheduling Administration 
screen. For this example, create a new record and save it with the following field 
values:

■ Server=Siebel Server

■ Process=0

■ Service Region=California Service Region

■ Component=ApptBook

The following figure shows the Server Key Mappings tab.

5 Associate Employees to the Service Region.

Navigate to the User Administration screen, Employees view. For this example, 
select the West Coast Service Representative and the West Coast Service 
Manager and click the Field Service Details tab. Edit the Schedule and Service 
Region fields with 12x5 Support and California Service Region, respectively.

After the Field Service Application is configured, create the assignment rule that 
uses the assignment availability feature.
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To create the Field Service Assignment Rule

1 Create the Assignment Rule.

Navigate to the Assignment Administration screen, Assignment Rules view and 
create the assignment rule. For this example, name the rule West Coast Service. 
Define the Assignment Object as Service Request and the Assignees From Rule 
as One, Best Fit. The Check Calendar box is the field that activates the 
assignment availability feature. Check this box once to make this feature 
operational.

2 Determine Assignment Criteria.

Navigate to the Assignment Criteria tab and create Product criteria for the 
assignment rule. For this example, service representatives are evaluated with the 
Compare Object to Person based on an employee’s product knowledge.

3 Determine Assignment Criteria Values.

Navigate to the Assignment Criteria Values view and create a new record with 
Pentium III desktop.

4 Define Employees for the Assignment Rule.

Navigate to the Assignment Employee view and add the West Coast Service 
Representative and the West Coast Service Manager to the assignment rule.

5 Release the Assignment Rule.
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Now, when a service request is created with attributes that match both West Coast 
service representatives, Siebel Assignment Manager, through the Field Service 
Appointment Book component, assigns the employee who has available time in his 
or her calendar and work schedule. Optionally, the Appointment Book component 
can create an activity in the assigned employee’s calendar. See “Configuring 
Assignment Objects for Availability-Based Assignment” on page 107 for further 
information. Figure 10 shows the assignment rule described in the preceding 
procedure. 

Figure 10. A Field Service Assignment Rule with the Check Calendar Field Activated
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This chapter explains how to configure Assignment Manager components. 
Configuration tasks outlined in this chapter are performed using Siebel Tools. 
Perform the procedures described in this chapter if you need to:

■ Modify the predefined assignment objects

For more information, see “Configuring Assignment Objects” on page 100.

■ Create new assignment objects

For more information, see “Creating Assignment Objects” on page 98.

■ Define additional assignment criteria types and attributes

For more information, see “Configuring Assignment Criteria” on page 129 and 
“Configuring Assignment Criteria Attributes” on page 133.

■ Remove existing assignment criteria and attributes

For more information, see “To remove seed assignment criteria” on page 118.

■ Disable existing assignment attributes

For more information, see “Disabling an Assignment Attribute” on page 139

■ Create new workflow policy components

For more information, see “Creating Workflow Policy Components” on 
page 145.
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If you plan to use the predefined Assignment Manager components, skip this 
chapter and proceed to Chapter 4, “Assignment Rules.”

NOTE: If you add or change assignment objects, assignment attributes, or assignment 
criteria, you must migrate the repository to the server production database. For 
information on migrating the repository, see Siebel Tools Reference.

CAUTION: The criteria values, skills, and workload conditions components are 
specialized. Do not configure these components.

Before you can successfully configure Assignment Manager, you need to possess a 
solid understanding of how to use Siebel Tools. For more information, see Siebel 
Tools Reference. You should also familiarize yourself with the basics of the 
underlying Siebel application architecture. Assignment Manager object types are 
also related to Workflow Manager object types. For more information, see Siebel 
Business Process Designer Administration Guide.
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Assignment Manager Configuration Concepts
Using Siebel Tools, you can create new assignment object definitions in the 
repository. After you compile the changes, these new assignment objects appear in 
the picklists in your Siebel application for assignment object selection.

Assignment Manager features that you can custom configure using Siebel Tools 
include:

■ List of assignment objects that can be assigned to assignment rules

■ List of attributes that can be incorporated in assignment criteria

■ Behavior of each available assignment object, including whether certain features 
are activated for the assignment object

■ Table and column mappings of assignment objects and attributes

■ Workflow policy component and workflow policy component column mappings 
of attributes used in assignment criteria.
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Assignment Manager Object Types
The following object types are specific to Assignment Manager and can be 
configured using Siebel Tools:

■ Assignment Object. Assignment object definitions are assigned to assignment 
rules in the Object field of assignment rule records. An assignment object 
specifies a business entity to which a candidate can be assigned, what is 
updated to accomplish that assignment, and other assignment behavior 
parameters. For more information, see “Assignment Object Configuration” on 
page 96.

■ Assignment Attribute. An assignment attribute object definition defines an 
attribute that can be referenced in assignment criteria records. It specifies a 
logical attribute that can be chosen from a picklist for defining comparisons. For 
more information, see “Configuring Assignment Attributes” on page 119.

■ Assignment Attribute Column. An assignment attribute column object definition 
assigns an assignment attribute to an assignment object and a workflow policy 
component column. These mappings set up value matching within the 
assignment object and workflow policy object. For more information, see 
“Configuring Assignment Attribute Columns” on page 125.

■ Assignment Criteria. An assignment criteria object definition defines an attribute, 
called an assignment criteria, that can be used in assignment criteria records. 
Assignment criteria appear in the picklist in the Criteria list column when you 
are editing an assignment rule record. For more information, see “Configuring 
Assignment Criteria” on page 129.

■ Assignment Criteria Attribute. An assignment criteria attribute object definition 
assigns an assignment attribute to the parent assignment criteria. Assignment 
criteria attributes make it possible for an assignment criteria to consist of 
multiple attributes. For more information, see “Configuring Assignment Criteria 
Attributes” on page 133.
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Assignment Manager Object Hierarchy and Relationship
Use the Object Explorer in Siebel Tools to view the hierarchical (parent-child) 
relationships of Assignment Manager object types. Figure 11 illustrates the 
hierarchical relationships of these object types (and two related object types in 
Workflow Manager configuration).

Figure 11 shows the following relationships:

■ Assignment object is a child of workflow policy object.

■ Assignment attribute column is a child of assignment attribute.

■ Assignment criteria attribute is a child of assignment criteria.

Figure 11. Parent-Child Relationships Between Assignment Manager Object Types
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In addition to the parent-child relationships between Assignment Manager object 
types, there are one-to-one and one-to-many relationships specified in property 
settings within the object definitions, as illustrated in Figure 12.

Figure 12. Field Value and Property Relationships Among Assignment Manager Object Types
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Figure 12 on page 94 shows the following relationships:

■ Assignment rules (the box with a dashed border at the upper left) have 
assignment criteria children. Assignment rules are actually records of the 
Assignment Group business component, and their child assignment criteria are 
records of the Assignment Rule business component.

■ Each assignment rule points to one or more assignment object definitions, stored 
in a multi-value (MLOV) group attached to the Assignment Objects field in the 
assignment rule (Assignment Group business component) record.

NOTE: If an assignment rule does not specify an assignment object, this means 
that it applies to assignment objects.

■ Each assignment criteria record points to an assignment criteria object 
definition, by means of the value in the Criteria field.

■ Assignment attributes are attached to an assignment object through a property 
setting in each assignment attribute column object definition.

■ An assignment attribute column object definition is mapped to a workflow 
policy component column object definition by means of a pair of property 
settings.
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Assignment Object Configuration
Siebel Assignment Manager uses definitions in the Siebel repository to assign 
objects to assignment rules and candidates.

An assignment object specifies a business entity to which a candidate can be 
assigned and the entities that are updated to accomplish that assignment. For 
example, an employee or position can be assigned ownership of an opportunity or 
account, or made a member of the opportunity’s or account’s sales team. Similarly, 
an employee can be assigned ownership of a service request or product defect. Each 
of the corresponding business components has one or more fields that specify the 
owner or team. An assignment rule includes one or more assignment objects. When 
the rule is satisfied, specific columns underlying these fields are updated with 
replaced or added employee IDs in accordance with the settings in the assignment 
object. 

An assignment object is a child object type of workflow policy object. The parent 
workflow policy object provides a set of available column mappings through its 
child workflow policy component and grandchild workflow policy component 
column object types. These can be specified in assignment attribute column object 
definitions as columns to test for value matches and to monitor in dynamic 
assignment for value changes.

NOTE: Workflow policy objects have a one-to-one or a one-to-zero relationship with 
assignment objects (the Order and Quote workflow policy objects do not have 
predefined child assignment objects). You cannot add more assignment objects to 
workflow policy objects that already have a child assignment object.

Siebel applications provide predefined definitions in the Siebel repository for the 
following objects:

■ Account

■ Activity

■ Campaign

■ Contact

■ Opportunity
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■ Product Defect

■ Project

■ Project Team

■ Service Request

NOTE: The Sample database includes predefined assignment rules for several of 
these predefined objects. For more information about predefined assignment rules, 
see “Activating Assignment Rules” on page 158.

The predefined definitions include mappings for the most commonly used 
attributes for each object. For example, the Opportunity object has the following 
predefined object definitions: Account Name, Account City, Account State, Account 
Zip Code, Account Country, Lead Quality, Revenue, Industry SIC Code, and so on. 
For more information about these assignment attributes and how to configure them, 
see “Configuring Assignment Attributes” on page 119.

NOTE: Siebel Tools allows the creation or configuration of an assignment object with 
both Position- and Employee-based assignment, but Assignment Manager does not 
correctly assign objects with this type of configuration. Only create or configure 
assignment objects for either Position-based or Employee-based assignment, not 
both. 

Assignment objects have a Lock Assignment feature that, when activated by 
checking the column on the object’s list applet, prevents Assignment Manager from 
assigning, or reassigning a position or candidate to the object. You can use this 
feature to exclude an object (such as Account or Opportunity) from being 
reassigned by Assignment Manager. For example, by setting the column defined in 
the Exclude Column for the assignment object, Assignment Manager excludes 
(ignores) the object for assignment. For more information about the Lock 
Assignment feature, see Table 38 on page 276.
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Creating Assignment Objects
You can create new assignment objects by using Siebel Tools. However, adding 
assignment objects can require the addition of skills or other tables and columns. 
Given the complexity of this requirement, contact Technical Support if you need to 
create new assignment objects.

CAUTION: It is recommended that you contact Siebel Technical Support for 
assignment object creation. If you create your own assignment objects, you run the 
risk of Assignment Manager assigning incorrect assignments.

To add an assignment object to a workflow policy object

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select Assignment 
Object.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can 
enable it by selecting View > Options > Object Explorer in the Development 
Tools Options dialog box.

3 In the Workflow Policy Objects window, select the workflow policy object type 
to which you wish to add the new assignment object.

4 Select the Assignment Objects window and choose Edit > New Record.

5 Configure the assignment object by setting values in the appropriate fields for 
each run-time parameter. 

For a list of assignment object parameters and their default values, see 
Appendix A, “Assignment Object Parameters.”

6 Compile the changes.

For more information, see Step 1 in “To update your deployment with new 
configurations” on page 154.
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7 If you are running dynamic assignment, activate an assignment policy for the 
assignment object.

For more information, see “Activating Assignment Policies” on page 229.

8 Update your deployment with the new configurations. 

For instructions, see “Server Administration After Configuration” on page 153.
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Configuring Assignment Objects
Each assignment object uses its own set of run-time parameters that control the 
behavior of Assignment Manager for that assignment object. These run-time 
parameters are stored in the Siebel repository in the assignment object definitions. 
You can use Siebel Tools to modify the default values for these run-time parameters. 
For a list of assignment object parameters and their default values, see Appendix A, 
“Assignment Object Parameters.”

NOTE: If modifying the parameters default employee, default position, or default 
organization, then make sure that the values specified exist in the appropriate base 
table. For example, if you change the default organization to My Organization, there 
must be an entry in the Group Administration > Organizations screen called My 
Organization.

To configure assignment objects

1 Start Siebel Tools.

2 Lock the project to which the assignment object belongs.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object, and select Assignment 
Object.

4 In the Workflow Policy Objects window, select the assignment object that you 
want to configure.
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5 In the Assignment Objects window, configure the assignment object by setting 
values in the appropriate fields for each run-time parameter.

For a list of assignment object parameters and their default values, see 
Appendix A, “Assignment Object Parameters.”

6 Update your deployment with the new configurations. 

For instructions, see Step 2 on page 154 and Step 3 on page 155 in the “To 
update your deployment with new configurations” procedure.

NOTE: It is not necessary to recompile the siebel.srf file when configuring an 
assignment object. For more information on when to recompile, see Table 16 on 
page 153 and Siebel Business Process Designer Administration Guide.
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Figure 13 shows an example of configuring the Account assignment object.

Figure 13. Example of Configuring an Assignment Object
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Configuring Assignment Objects for Interactive Assignment
Interactive assignment allows users to invoke Assignment Manager immediately, 
view the list of assignees generated by Assignment Manager, and then override or 
confirm the assignees in the list. Users can invoke Interactive Assignment by 
clicking the appropriate object’s form Menu button and choosing Assign. Figure 14 
shows the Assign option from the Menu button from the All Service Requests view.

When the user clicks the menu button in the More Info form and chooses Assign 
for the current service request, the Siebel client contacts the assignment server and 
creates a list of qualified employees sorted by descending scores. The list of 
qualified employees appears to the user in the Employees window. The user then 
selects an employee from the list to be the service request owner.

Alternatively, you can allow SmartScript to have Assignment Manager select the 
most qualified candidate from the list. In this case, a list of qualified employees does 
not appear in the Employees window, and the most qualified candidate is assigned.

The Service Request assignment object is configured for Interactive Assignment by 
default. You can use Siebel Tools to configure Interactive Assignment for other 
assignment objects. For more information on Interactive Assignment, see 
“Interactive Assignment” on page 60.

Figure 14. Example of Interactive Assignment
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To configure interactive assignment for an assignment object

1 Verify that Assignment Manager is configured to perform assignment of values 
in the desired field, including the presence of the necessary assignment object 
and assignment rules and values.

2 Verify that the displayed business component is of the CSSBCBase class or one 
of its subclasses and add the Assignment Object business component user 
property to the business component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component.

c In the Class property for that business component, verify the value is 
CSSBCBase (such as in the Account business component).

NOTE: Business components based on other classes cannot be configured for 
interactive assignment. If the class is not CSSBCBase, note the class name 
and locate it in the Object Explorer for the Class object type. Note the value 
in the Super Class property for this class. If the Super Class is CSSBCBase, 
interactive assignment is permitted. If the Super Class is not CSSBCBase, 
check the Super Class property for that class.

d Set the Name property to Assignment Object.

e Set the Value property to the name of the assignment object that is to be used 
in the assignment process.

3 Verify that the appropriate applet is of the CSSFrameBase class or one of its 
subclasses.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet.

c In the Class property for that applet, verify the value is CSSFrameBase (such 
as Account Entry Applet).

NOTE: Applets based on other classes (including CSSFrameListBase) cannot be 
configured for Interactive Assignment. 
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4 Add the Assignment Type business component user property to the business 
component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component, and 
then click Business Component User Prop.

c Set the Name property to Assignment Type.

d Set the Value property to:

❏ People if you are setting up an employee- or position-based assignment

❏ Organizations if you are setting up an organization-based assignment 

5 Optionally, if you want to enable SmartScript, add the Assignment Interactive 
business component user property to the business component.

a Set the Name property to Assignment Interactive.

b Set the Value property to TRUE.

6 Add the Assign selection to the applet menu button.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet to which you want to add the Assign 
functionality.

c In the Object Explorer, select Applet Method Menu Item.

d Select the Applet Method Menu Items window, choose Edit > New Record 
and set the following values:

❏ Command=Assign(SWE)

❏ Menu Text=Assign

❏ Position number = 1 (or to the number corresponding to the preferred 
placement in the menu)
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7 Add the business component that holds assignment results records to the 
business object of the view in which the reconfigured applet is used.

NOTE: This business component already exists, and is either: 1) Assignment 
Results (Position) or Assignment Results (Employee) if Assignment Type is set 
to People (depending on whether you are setting up an employee- or position-
based assignment), or 2) Assignment Results (Organizations) if Assignment 
Type is set to Organizations.

a In the Object Explorer, select Business Object.

b In the Business Objects window, select the Business Object for which you 
want to add a child business object component.

c In the Object Explorer, click Business Objects Components, and in the 
Business Objects Components window, choose Edit > New Record.

d In the new record, enter values in the appropriate fields with the BusComp 
name set to: Assignment Results (Position), Assignment Results (Employee), 
or Assignment Results (Organization).

8 Optionally, the business component user property called Assignment Results 
BusComp and the applet user property called Assignment Results Applet can be 
defined.

NOTE: These user properties are desirable when you need to show additional 
information about the results. For example, the service request assignment 
results can be joined with the CTI tables, and query only qualified service people 
who are not currently using their telephone. The name of the business 
component used to hold data for the additional fields would be specified in an 
Assignment Results BusComp user property in the business component being 
assigned. The name of the applet used to display the assignment results would 
be specified in an Assignment Results Applet user property in the applet from 
which assignment is invoked.
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9 Add one of the following Business Components (depending on what is being 
assigned) to the relevant Business Object: Assignment Group Position, 
Assignment Group Employee, or Assignment Group Organization. 

10 Update your deployment with the new configurations. 

For instructions, see Step 1 on page 154 in the “To update your deployment with 
new configurations” procedure.

NOTE: Other than recompiling the siebel.srf file, there are no additional 
administrative tasks required for this procedure. For more information on when 
to recompile, see Table 16 on page 153 and Siebel Business Process Designer 
Administration Guide.

Configuring Assignment Objects for Availability-Based Assignment
Configuring assignment objects for availability-based assignment allows 
Assignment Manager to review an employee’s calendar as a criterion for 
assignment. If the employee’s calendar has no activities booked at the time required 
by the object, and has a sufficient time period available for the object’s duration, 
the employee qualifies for assignment. For more information on availability-based 
assignment, see “Availability-Based Assignment” on page 45 and “Assigning 
Employees to Assignment Rules Based on Availability” on page 193.

Before configuring the assignment object, make sure the following information is 
satisfied:

■ The Field Service Component Group is enabled.

For more information, see Siebel Server Administration Guide.

■ A mapping of the server to the Field Service components and region exists.

For more information, see Siebel Field Service Guide. 

■ Employees are associated with service regions.

For more information, see Siebel Field Service Guide.

■ The object that you are configuring for assignment availability has the necessary 
columns in its database table (information and procedure follow).
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By default, the Activity assignment object has the required columns in its database 
table for Start Time and Duration; however, one column must be extended if the 
Early Start Time field is desired. All other assignment objects must have their base 
tables extended. To extend an object’s base table for availability-based assignment, 
use the following procedure. As an example, the Service Request Assignment object 
is considered.

CAUTION: You must review the sections on extension tables and columns in Siebel 
Tools Reference before completing this procedure.

To extend the Service Request’s base table for availability-based assignment

1 Start Siebel Tools.

2 In the Object Explorer, expand the Table object, and then select Column.

3 In the Tables window, query for the S_SRV_REQ table.

4 With the S_SRV_REQ table selected, choose Tools > Lock Project to lock the 
project.

The project associated with the S_SRV_REQ table is newtable.

5 In the Columns list, choose Edit > Add New Record to add the records in the 
following table (only Record 1 and 2 are required):

Record 1 Record 2 Record 3 (Optional)

Name X_DURN_MIN X_START_TIME X_EARLY_START_TIME

Physical Type Number UTC Date Time UTC Date Time

Length 22 7 7

Precision 22

Scale 7

LOV Type APPOINTMENT_
DURATION
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6 In the Table column window and after you have created the new records you 
need, click Apply.

This sends the new columns to the appropriate tables in the database.

7 Complete the fields in the Apply Schema dialog box.

a In the Tables field, click the select button, and choose one of the following:

❏ All

❏ Current Query

❏ Current Row

b In the Table owner password field, enter the appropriate value.

c Click Apply.

The S_SRV_REQ table is now extended with the following three columns: 
X_DURN_MIN, X_EARLY_START_TIME, and X_START_TIME.

With the appropriate columns in place, use the following procedure to configure 
availability criteria for the assignment object. 

To configure Availability-based Assignment for an assignment object

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

Cascade Mode Ignore Ignore Ignore

TxnLog Code TRUE TRUE TRUE

Record 1 Record 2 Record 3 (Optional)
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3 In the Object Explorer, expand Workflow Policy Object and select the assignment 
object.

4 In the Assignment Objects list, select the object you want to configure, and set 
the column values, as shown in the following table:

NOTE: The fields in the preceding table are specified as one value string for that 
property.

Column Required Value

Calendar Start 
Time Column

Yes The table column that references the start time of the 
object. For example, X_START_TIME.

Calendar Duration 
Column

Yes The table column that references the duration of the 
object. For example, X_DURATION.

Calendar Early 
Start Time Column

No The table column that references the early start time 
of the object. For example, X_EARLY_START_TIME.

Calendar Create 
Activity

No Check this column if you want an activity created for 
the assigned employee.

TRUE = Activity is created in employee’s calendar
FALSE =Activity is not created in employee’s 
calendar 

Note: You must check this field if you plan to use the 
Appointment Booking System to detect conflicts. For 
more information about the Appointment Booking 
System, see “Availability-Based Assignment” on 
page 45 in this guide and Siebel Field Service Guide.

Calendar Activity 
Additional Fields

No When this field is specified, Assignment Manager sets 
the field value to the row ID of the assignment object 
when it creates the activity. Assignment Manager also 
sets the additional fields to the specified field values. 
For example, for the Service Request object, you can 
specify the following fields: Activity SR Id, Type, To 
Do.
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If a value is not specified for the field specified in the Calendar Start Time Column 
column for an assignment object, Assignment Manager does not check calendars 
when assigning that object, even if the assignment rule has the Check Calendar flag 
checked. Instead, Assignment Manager assigns all candidates who meet the criteria 
for the rule. For example, if you don't specify the Start Date or Due Date for an 
activity, Assignment Manager does not check calendars when assigning this 
activity, even if the assignment rule has the Check Calendar flag checked. Instead, 
Assignment Manager assigns all candidates who meet the criteria for the rule.

After these fields are configured for the assignment object, they must be made 
visible to the end user by adding them to the appropriate business component and 
applets. For these procedures, see Siebel Tools Reference.
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Configuring Assignment Objects for Multitiered Assignment
Configuring assignment objects for multitiered assignment allows Assignment 
Manager to consider the relationship between people and organizations when 
determining the proper assignment. By default, Assignment Manager assigns 
people and organizations independently. Multitiered assignment runs in a variety 
of modes. For more information on multitiered assignment and the assignment 
modes, see “Multitiered Assignment” on page 52 and “Using Multitiered 
Assignment with Sales Assignment Rules” on page 78.

To configure an object for multitiered assignment

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select the assignment 
object.

4 For the assignment object, change the Assignment Mode field to the multitiered 
assignment mode operation of interest (choices are Independent, Org & Person-
oriented, Organization-oriented, and Person-oriented) as shown in Figure 15 on 
page 113.
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Figure 15. Selecting the Multitiered Mode

Select the multitiered
assignment mode from

the drop-down menu.
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Configuring Assignment Objects for Team Scoring
Configuring Team Scoring allows Assignment Manager to save candidates’ scores to 
the team table for those candidates who are assigned to an assignment object. 
These scores can be then used by other Siebel applications or exposed through the 
user interface. See “Assignment Scoring” on page 51 for more information.

Before configuring the assignment object, make sure the object has the necessary 
columns in its database table. To extend an object’s database table for team scoring 
use the following procedure. As an example, the Opportunity object is considered. 

CAUTION: You must review the sections on extension tables and columns in Siebel 
Tools Reference before completing this procedure.

To extend the Opportunity object’s base table for team scoring

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Table object and select Column. 

4 In the Tables list, query for the S_OPTY table.
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5 In the Columns window, add the records shown in the following table (the 
values and records shown are examples and can be modified, as appropriate, for 
your deployment):

6 Select each new record and click the Apply button.

7 Enter the appropriate value for tableowner password.

The S_OPTY table is now extended with the following columns: X_POS_SCORE 
and X_ORG_SCORE.

After the necessary base table columns are in place, use the following procedure to 
configure the assignment object for team scoring.

To configure assignment objects for team scoring

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select Assignment 
Object.

Record 1 Record 2

Name X_POS_SCORE X_ORG_SCORE

Physical Type Data(Public) Data(Public)

Length 22 22

Precision 22 22

Scale 7 7

Cascade Mode Ignore Ignore

TxnLog Code TRUE TRUE
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4 In the Workflow Policy Objects list, select the object you want to configure.

5 In the Assignment Objects list, select the object, and set one of the column 
values as shown in the following table:

For information on modifying the appropriate components that expose the scoring 
information to the user interface, see Siebel Tools Reference.

Column Value

Employee Team Score The table column that references a Number column in the 
assignment object’s employee team table.

Org Team Score The table column that references a Number column in the 
assignment object’s organization team table.

Position Team Score The table column that references a Number column in the 
assignment object’s position team table.
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Assignment Criteria Configuration
You can add new assignment attributes and assignment criteria using Siebel Tools.

Assignment attributes allow you to associate a single criteria value to multiple fields 
in the application. For example, you can define an assignment rule that matches 
candidates based on State. However, State is stored in a different field in the 
application for different objects. Assignment attributes map the places that State is 
defined into a single criteria value.

Assignment attributes can be either column-based or skill-based. Column-based 
attributes are stored as columns in the object (such as Opportunity). You can use 
existing columns in the object, or use Siebel Database Extensibility to add new 
extension columns to the object. Skills-based attributes are stored as rows in the 
object’s skill tables (if any).

If you are adding an assignment attribute to a new table, you need to modify the 
existing Workflow Manager definitions in the Siebel repository. For more 
information, see Siebel Business Process Designer Administration Guide.

An assignment criteria can consist of one or more assignment attributes, such as 
the criteria Account City, Account State, and Account Country. These assignment 
attributes are grouped as assignment criteria. In this case, a single assignment 
criteria includes three assignment attributes. Assignment criteria correspond to the 
Criteria column in the Assignment Administration views. To add or change drop-
down fields that define assignment criteria in an assignment rule, you should define 
or modify assignment criteria. Assignment criteria attributes enumerate assignment 
attributes for the assignment criteria.

When you create new assignment criteria, you typically perform the following 
procedures (in the order listed):

■ Create new assignment attributes

■ Create new assignment attribute columns to map new assignment attributes to 
existing assignment objects

■ Create new assignment criteria to group new assignment attributes
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■ Create assignment criteria attributes to enumerate assignment attributes for the 
assignment criteria

NOTE: Assignment criteria configured to include multiple assignment attributes 
cannot have these attributes based on columns in different tables. 

To eliminate default assignment criteria appearing in the Assignment Criteria view, 
use the following procedure.

To remove seed assignment criteria

1 Delete from any assignment rules the use of the criteria you want removed from 
the assignment criteria (Assignment Rules > Criteria).

2 In Siebel Tools, inactivate the assignment attribute column, the assignment 
attribute, the assignment criteria attribute, and the assignment criteria.

For more information, see “Disabling an Assignment Attribute” on page 139.

3 Recompile all projects (not just the locked projects) in the .srf file.

For instructions, see Step 1 on page 154 of the “To update your deployment with 
new configurations” procedure.
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Configuring Assignment Attributes
An assignment attribute object definition defines an attribute that can be referenced 
in assignment criteria records. It specifies a logical attribute that can be chosen from 
a picklist for defining comparisons; it does not directly specify a particular database 
column or combination of columns. Column mapping is accomplished through the 
child assignment attribute column object definitions, one for each assignment 
object that uses the parent assignment attribute.

An assignment attribute also specifies the picklist that appears in the Values list in 
the Assignment Criteria view when you are entering an attribute in a value record, 
as shown in Figure 16.

An assignment criteria attribute object definition implements each list column in 
the Values applet, as described in “Configuring Assignment Criteria Attributes” on 
page 133. The assignment criteria attribute is based on an assignment attribute, as 
specified in its assignment attribute property. The referenced assignment attribute 
identifies a picklist. This is the picklist that appears when you click the drop-down 
arrow to the right of the list column cell.

The Assignment Attribute object type functions as an intermediary between the 
assignment criteria on the one hand and the assignment objects on the other, as 
shown in Figure 12 on page 94.

Figure 16. Picklist for Populating an Attribute in a Value Record

This list column is based on
an assignment attribute...

...in whose definition this 
picklist is specified.
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An assignment criteria attribute references an assignment attribute through its 
assignment attribute property. In turn, each of the assignment attribute’s child 
assignment attribute columns specifies an assignment object and a workflow policy 
component/column combination. 

An assignment attribute is a logical grouping of similar mappings to different 
assignment objects that can use the same picklist for value selection. For example, 
the Account State assignment attribute has ten child assignment attribute column 
object definitions. Each of these assignment attributes is used for selection of the 
state in which an account is located, but five of them are used for different 
assignment objects (Activity, Account, Campaign Contact, and Order), and the 
other five are used for different account state attributes in the Opportunity 
assignment object (such as Primary Account State and Indirect Account Primary 
State).

NOTE: To generate a trigger based on an assignment attribute, a corresponding 
assignment attribute column must be configured. See Configuring Assignment 
Attribute Columns on page 125. 
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To create new assignment attributes

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object, and then choose 
Edit > New Record.

4 In the Assignment Attributes window, configure the assignment attribute object 
by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment attribute.

b In the Project field, select a project.

c Optionally, if the attribute supports a range of values (such as revenue), 
check the Use Range field.

d In the Data Type field, select a data type for the attribute.

e Optionally, if you want a picklist for the attribute to allow users to select 
values for the assignment attribute, enter a value in the Picklist field.

f Optionally, you can use a pick field for the attribute to allow users to select 
values for the assignment attribute, enter a value in the Pick Field field.

For a description of these properties, see Table 10 on page 123.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 153.
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Figure 17 shows an example of creating an assignment attribute called Example of 
data type Varchar. This attribute also has the optional Assignment Attribute Picklist 
and the Employee Skill pick field selected.

Figure 17. Example of Creating an Assignment Attribute
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Table 10 shows some of the properties of the Assignment Attribute object type.

Table 10. Properties of Assignment Attributes

Property Required Description

Bounded Optional When checked, the picklist is bounded (you can select 
a value from the picklist). When unchecked, you can 
enter a value that does not appear in the list.

Data Type Required Data type for the assignment attribute. Number, 
UtcDateTime, and Varchar are supported.

Name Required Name of the assignment attribute. Must be unique 
within the repository.

Order By LOV Type Optional Not used.

Pick Field Optional Name of the field to select from the picklist.

Pick List Optional Name of the picklist that supplies the selection values 
for populating any list column in the Values list (in the 
Assignment Criteria view) that is based on this 
assignment attribute.

Use Range Optional Specifies whether a single list column or a pair of list 
columns, indicating a range, appears for assignment 
criteria attributes based on this assignment attribute. 
For example, the Revenue assignment attribute, which 
has a TRUE value for Use Range, appears as two list 
columns, Revenue Low and Revenue High. You can 
enter 50000 in the former and 100000 in the latter in a 
value record to indicate the range $50,000–100,000.

Translate Optional When checked, enables MLOV capability for the 
attribute. For more information on enabling this 
feature, see “Configuring MLOV for Assignment 
Attributes” on page 124.
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Configuring MLOV for Assignment Attributes
Multilingual List of Values (MLOV) capability allows assignment attributes to be 
stored in a form that can be retrieved and displayed in a variety of supported client 
languages. For detailed information on MLOV, see Siebel Tools Reference. To enable 
assignment attributes for MLOV, use the following procedure.

To enable assignment attributes for MLOV

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object.

4 Select the Assignment Attribute in the list of attributes that requires translation.

5 Locate the Translate column for this attribute, and select the check box to assign 
this property with a TRUE value.

6 Locate the Translate Pick Field for the assignment attribute, and select from the 
Translate Pick Field dialog box the field in the Pick List Business Component that 
stores the Language Independent Code (in most cases this is the Name field).

You can also configure the application to enable MLOV for workload criteria, criteria 
values, and skills. For more information, see Siebel Tools Reference.
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Configuring Assignment Attribute Columns
An assignment attribute column object definition maps an assignment attribute to 
an assignment object and a workflow policy component column, as shown in 
Figure 12 on page 94. These mappings set up value matching within the assignment 
object and workflow policy object for criteria that use the parent assignment 
attribute.

The parent assignment attribute is an abstract logical attribute to test for a value 
match, which you can specify in an assignment criteria. The child assignment 
attribute columns specify the actual mappings to assignment objects and workflow 
policy component columns. Each assignment attribute column can specify a 
different assignment object to search, or a different attribute within the same 
assignment object.

To map assignment attributes to an existing assignment object 

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Attribute object, and select the 
Assignment Attribute Column object.

4 In the Assignment Attributes window, select the assignment attribute for which 
you want to map the logical location in the database schema.

5 In the Assignment Attribute Columns window, choose Edit > New Record.

6 Configure the assignment attribute object by setting values in the appropriate 
fields.

a In the Name field, type the name of the new assignment attribute column.

b In the Assignment Object field, select an assignment object to which the 
assignment attribute is applied.
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c In the Workflow Policy Component field, select a workflow policy component 
to which the workflow policy object is applied.

d In the Workflow Policy Component field, select a workflow policy component 
column to which the workflow policy component is applied.

e In the Sequence field, type in a sequence value.

For descriptions of these properties, see Table 11 on page 128.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 153.
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Figure 18 shows an example of mapping an assignment attribute called Example to 
the Service Request assignment object. This attribute is also mapped to the Service 
Request workflow policy object, the Product workflow policy component, the 
Product ID workflow policy component column, and a sequence value of 1.

Figure 18. Mapping an Assignment Attribute to an Assignment Object
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Table 11 shows some of the properties of the Assignment Attribute Column object 
type.

Table 11. Properties of Assignment Attribute Columns

Property Required Description

Assignment Object Required Assignment object that is checked for a value match 
with the parent assignment attribute.

Name Required Name of the assignment attribute column. The typical 
format for the name is:

assignment_object: workflow_component_column

For example: 

Service Request: Account Area Code 

Sequence Required A unique sequence number for the assignment 
attribute column within the assignment attribute. If an 
assignment attribute has multiple assignment attribute 
columns, Assignment Manager searches for attribute 
values in the order of the values in this property.

Workflow Policy 
Component

Required Name of the workflow policy component, within the 
specified workflow policy object, with which this 
assignment attribute column is associated.

Workflow Policy 
Component Column

Required Name of the workflow policy component column, 
within the specified workflow policy component, with 
which this assignment attribute column is associated.

Workflow Policy 
Object

Required Name of the workflow policy object with which the 
assignment attribute column is associated. When an 
assignment object is selected, the workflow policy 
object defaults to this selection.
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Configuring Assignment Criteria
An assignment criteria object definition defines an attribute, called an assignment 
criteria, that can be used in assignment criteria records. Assignment criteria appear 
in the picklist in the Criteria list column when editing an assignment criteria record 
in Siebel applications.

The Criteria list column in an assignment criteria record specifies the assignment 
criteria that is tested for a match against one or more attributes of the assignment 
object or candidate. For example, in an assignment criteria that determines whether 
the state is California, the assignment item would be State, Home State, or Account 
State, and the value California (CA) would be specified in a child value record.

When you click the drop-down arrow button in the Criteria list column, a picklist 
appears for selection of an assignment criteria. The picklist lists the available 
assignment criteria (assignment criteria object definitions in the repository). When 
you select an assignment criteria, its name is stored in the Criteria Name field in the 
current Assignment Rule business component record.

NOTE: The business component that holds assignment criteria is called Assignment 
Rule. The business component that holds assignment rules is called Assignment 
Group.

An assignment criteria includes one or more assignment criteria attributes, stored 
as child assignment criteria attribute object definitions. For information on 
assignment criteria attributes, see “Configuring Assignment Criteria Attributes” on 
page 133.

After you create and recompile an assignment criteria object definition, it becomes 
available for selection from the Criteria list column picklist in assignment criteria 
records.
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To create assignment criteria

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Criteria object, then choose 
Edit > New Record.

4 Configure the assignment criteria by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment criteria.

b In the Project field, select the Assignment project.

c In the Display Name field, type the name that appears for the assignment 
criteria.

d Optionally, if you want the assignment criteria stored in the skill table, check 
the Employee Skill field.

For information about skill tables, see “Creating Criteria Values as Skills with 
Expertise Codes” on page 177.

e Optionally, if you want expertise codes stored for the skill, check the Use 
Expertise field.

If you check this field, Assignment Manager uses expertise codes to match 
objects to candidates.

f Optionally, if you do not want the assignment criteria to appear in the Criteria 
picklist, uncheck the Display Flag field.

For descriptions of these properties, see Table 12 on page 131.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 153.
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Figure 19 shows an example of creating an assignment criteria called Example 
Criteria. This assignment criteria has a display name of Example, and uses both 
skills and expertise codes to match objects to candidates.

The assignment criteria object definition has two properties to specify the name 
(internally and as displayed) and two properties that are used to configure skill 
tables (Employee Skill and Use Expertise). Most of the behavior of an assignment 
criteria is configured in the assignment criteria attribute children. Table 12 shows 
some of the properties of the assignment criteria object type.

Figure 19. Creating an Assignment Criteria

Table 12. Properties of Assignment Criteria

Property Required Description

Display Flag Optional When checked, the assignment criteria appears in the Criteria 
picklist.

Display Name Optional Name that appears for this assignment criteria in the picklist 
and the Criteria list column in the Criteria list in the Criteria 
view (Assignment Rule> Criteria). If not specified, the value 
in the Name property is used instead.

Employee Skill Optional A TRUE/FALSE property that specifies whether the 
assignment criteria is stored in the skill table. For more 
information about skill tables, see “Creating Skills and Using 
Skill Tables” on page 141.
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Name Required Name of the assignment criteria.

Use Expertise Optional A TRUE/FALSE property that applies to assignment criteria 
that are skills. It specifies whether expertise codes are stored 
for the skill. If so, Assignment Manager uses the expertise 
code to match the assignment object to people. 

Table 12. Properties of Assignment Criteria

Property Required Description
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Configuring Assignment Criteria Attributes
An assignment criteria includes one or more assignment criteria attributes. 
Assignment criteria attributes are implemented as object definitions of the 
assignment criteria attribute object type. This is a child object type of assignment 
criteria. Assignment criteria attributes make it possible for an assignment criteria to 
consist of multiple attributes.

For example, the Account Wildcard assignment criteria includes an Account and 
Site, both of which correspond to a specific column. This setup is accomplished by 
creating two assignment criteria attribute children, Account and Site, of the Account 
Wildcard assignment criteria.

NOTE: Many assignment criteria have only a single assignment criteria attribute.

The set of assignment criteria attributes in an assignment criteria determines the set 
of list columns to appear in the Values list, as shown in Figure 20. 

Figure 20. List Columns in the Values List

The Account 
Wildcard 
assignment 
criteria...

...has the Account and Site 
columns in its value record.
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One list column appears in the Values list for each assignment criteria attribute in 
the assignment criteria. In Figure 20 on page 133, the Account Wildcard assignment 
criteria (the Account Name assignment criteria with a display name of Account 
Wildcard) has an Account and a Site list column in the display of its child Value 
records. Both the Account and Site list columns correspond to the Account Name 
assignment criteria attribute (with a display name of Account and Site, 
respectively). Figure 21 shows how this is accomplished in Siebel Tools.

If there were more assignment criteria attributes for this assignment criteria, each 
would have a list column in the Values list. The Score list column is automatically 
provided, and the Expertise Code list column appears in this instance because the 
assignment criteria has a Use Expertise property setting of TRUE.

Assignment criteria attributes make it possible for an assignment criteria to consist 
of multiple attributes, each mapping to a specific assignment attribute object 
definition. For information on assignment attributes, see “Configuring Assignment 
Attributes” on page 119.

Figure 21. Assignment Criteria and Child Assignment Criteria Attribute

Account Name
assignment criteria

Account Name assignment 
criteria attribute
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To create assignment criteria attributes

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Criteria object, and select the 
Assignment Criteria Attribute object.

4 In the Assignment Criteria window, select the assignment criteria for which you 
want to enumerate assignment attributes.

5 Select the Assignment Criteria Attributes window, then choose Edit > New 
Record.

6 Configure the assignment criteria attribute by setting values in the appropriate 
fields.

a In the Name field, type the name of the new assignment criteria attribute.

b In the Assignment Attribute field, select the assignment attribute for this 
assignment criteria.

c In the Display Name field, type the name for the assignment criteria attribute.

d In the Store Column field, specify the column in the assignment factor items 
table where the value for the assignment criteria attribute is stored.

e In the Display Sequence field, specify the sequence in which the assignment 
criteria attribute appears.

f Optionally, in the Pick Applet field, choose a pick applet for the assignment 
criteria attribute to allow users to view or select values for the assignment 
criteria attribute.

For more information on these properties, see Table 13 on page 138.
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7 Update the siebel.srf file.

For instructions on updating the siebel.srf file, see Step 1 on page 154 of the “To 
update your deployment with new configurations” procedure.

8 Check in the Assignment project before using the assignment criteria attributes.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select Assignment, and choose Tools > Check In.

9 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the “To update your deployment with 
new configurations” procedure.
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Figure 22 shows an example of creating an assignment criteria attribute called 
Example Criteria Attribute. This criteria attribute applies to the Example assignment 
attribute, has a display name of Example, and uses the Assignment Results 
(Employee) list applet.

Figure 22. Creating an Assignment Criteria Attribute
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 137



Assignment Manager Configuration

Assignment Criteria Configuration
Table 13 shows some of the properties of the assignment criteria attribute object 
type.

Table 13. Properties of Assignment Criteria Attributes

Property Required Description

Assignment Attribute Required Name of the assignment attribute that this 
assignment criteria attribute is based on. Selected 
from a drop-down list.

Display Name Required List column label that appears for this assignment 
criteria attribute in the Values list. If omitted, the 
Name is used in the list column label.

Display Sequence Required Order in which the list column for this assignment 
criteria attribute appears in the list applet, relative to 
those of other assignment criteria attributes in the 
assignment item. A lower number places the list 
column further to the left.

Name Required Name of the assignment criteria attribute, for 
identification. This name must be unique within the 
parent assignment criteria.

Pick Applet Optional If a picklist is defined for the associated assignment 
attribute, you specify the name of a pick applet to 
display the picklist for selection of a value in the 
attribute’s list column.

Store Column Required Specifies the column in the assignment factor items 
table (S_ASGN_RULE_ITEM) in which to store the 
value for the assignment criteria attribute. There are 
four columns of each data type (Number, 
UtcDateTime, and Varchar) provided for storage of 
assignment criteria attribute values in each 
assignment criteria. You must specify a unique value, 
between 1 and 4 inclusive, for each assignment 
criteria attribute of the same data type. The data type 
can be determined from the Data Type property in 
the referenced assignment attribute object definition.
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Disabling an Assignment Attribute
In some cases, you may need to disable an existing assignment attribute. To do so, 
you must also disable the assignment attribute column, assignment criteria, and 
assignment criteria attribute definitions.

To disable an existing assignment attribute

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 Disable the assignment attribute definition.

a In the Object Explorer, select the Assignment Attribute object.

b In the Assignment Attributes window, select the assignment attribute you 
want to disable.

c Check the Inactive field.

4 Disable the assignment attribute column definition.

a In the Object Explorer, expand the Assignment Attribute object, and then 
select the Assignment Attribute Column object.

b In the Assignment Attribute Columns window, select the assignment 
attribute column you want to disable.

c Check the Inactive field.

5 Disable the assignment criteria definition.

a In the Object Explorer, select the Assignment Criteria object.

b In the Assignment Criteria window, select the assignment criteria you want 
to disable.

c Check the Inactive field.
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6 Disable the assignment criteria attribute definition.

a In the Object Explorer, expand the Assignment Criteria object, and then 
select the Assignment Criteria Attribute object.

b In the Assignment Criteria Attributes window, select the assignment criteria 
attribute you want to disable.

c Check the Inactive field.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 153.
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Creating Skills and Using Skill Tables
Skills are assignment criteria values attributed to specific assignment rules, objects, 
employees, positions, and organizations. Assignment Manager uses skills to match 
assignment rules, objects, employees, positions, and organizations.

Creating New Skills
The Siebel application provides several predefined skills, however, you can create 
new skills using Siebel Tools. This section explains how to view the predefined skills 
and create new skills.

To view predefined skills

1 Start Siebel Tools.

2 In the Object Explorer, click to select the Assignment Criteria object.

3 In the Assignment Criteria applet, query for criteria with Employee Skill equal 
to TRUE.

The predefined skills appear (see Table 14) as well as any new skills you create.

Table 14 provides the predefined skills.

For most deployments, the predefined skills are sufficient. However, you can create 
new skills using Siebel Tools. The following procedure explains how to create a new 
skill that can be used in any Siebel application. 

Table 14. Predefined Skills

Skill Name Skill Name

■ Activity Category

■ Email Language Code 

■ Email Recipient Profile

■ Industry

■ Language

■ Product

■ Product Line

■ Product Line Wildcard

■ Product Wildcard

■ Revenue
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To create a new skill

1 Create an assignment attribute.

For more information, see “To create new assignment attributes” on page 121. 

2 Create an assignment criterion. 

For more information, see “To create assignment criteria” on page 130. When 
prompted in Step 4 of this procedure, you must check the Employee Skill field 
because you are configuring the criterion as a skill.

3 Add the assignment attribute created in Step 1 above as a child object to the 
Assignment Criterion created in Step 2 above.

For more information, see “To create assignment criteria attributes” on page 135. 
When prompted in Step 6 of the “To create assignment criteria attributes” 
procedure, select the assignment attribute created in Step 1 above.

NOTE: To use Assignment Manager to use a skill for the purpose of assignment, 
additional configuration is required. For more information, see “Assignment Criteria 
Configuration” on page 117. 
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Using Skill Tables
A skill is a generic attribute that qualifies an object. For example, if an employee 
speaks English and Spanish, language is the skill he or she possesses, and English 
and Spanish are the skill items. Employee, position, and organization skills are used 
to store skills possessed; the skill tables for objects are used to store skills required. 
Assignment Manager uses skill tables to do skill matching by comparing the skills 
on the object with the skills of an employee, position, or organization to determine 
who passes the rule.

The skill and skill item tables are child and grandchild tables, respectively, of the 
object used to store skills, and skill items for assignment objects that are not stored 
as columns in the parent table itself. The employee skill table is used to store skills 
possessed by employees, such as languages spoken, product expertise, and so on. 
For example, for an employee who speaks English and Spanish, there is one record 
in the employee skill table that specifies the skill name as Language. And there are 
two records in the child employee skill item table that correspond to this skill 
record: one record for English, and another record for Spanish. For more 
information on how to assign skills to candidate objects, see “Assigning Skills to 
Employees, Positions, and Organizations” on page 68.

For example, the following procedure explains how to configure Assignment 
Manager so that only employees who speak Spanish are assigned a service request.

To configure Assignment Manager to assign a service request only to employees 
who speak Spanish

1 Create a service request with Language as the skill and Spanish as the skill item. 

a In the Service Request skill table for the service request, create one record 
and specify Language as the skill. 

b In the child Service Request skill item table, create one record and specify 
Spanish as the skill item.

For more information about how to perform this step, see “Creating Criteria 
Values as Skills with Expertise Codes” on page 177.

2 Create an assignment rule that filters employees based on their language skills.

a Create an assignment rule and apply the Service Request assignment object.
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b Create a criterion called Language and use the Compare to Person 
assignment rule comparison method.

This criterion, and therefore the rule, passes only employees who have the 
Spanish language skill.

NOTE: The above example used the Compare to Person comparison method, 
however, skill matching can be used with other comparison methods. For more 
information about comparison methods, see “Assignment Criteria” on page 32.

Assignment Manager can also do skill matching with expertise codes and can use 
weighting factors to assign weighted scores to different expertise codes. For more 
information, see “Skills” on page 46, “Expertise Codes” on page 47, and “Weighting 
Factors” on page 48.
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Creating Workflow Policy Components
In some cases, you can create an assignment rule that assigns candidates to two 
objects while using only one of the object’s criteria. For example, you may want the 
ability to assign both Accounts and Opportunities based on the criteria Opportunity 
Lead Quality. To configure Assignment Manager to assign Accounts based on this 
criteria, you must configure and expose the Opportunity Lead Quality column to the 
Account Assignment object. 

The following procedure explains how to create assignment rules that assign two 
objects using only one object criteria. 

NOTE: Assignment based on calculated fields is not possible. A calculated field does 
not have a corresponding database table field, which is a key requirement for the 
definition of an assignment criterion. There is no database table field because 
configuration of Assignment Attribute Column requires Workflow Policy 
Component and Workflow Policy Component Column information, and a Workflow 
Policy Component Column references a database table column.

To create an assignment rule that assigns two objects using only one object criteria

1 Create a workflow policy component for both objects.

For procedures using a specific example, see “Phase 1: Creating a Workflow 
Policy Component for Both Objects” on page 146.

2 Map the workflow policy component to the assignment criteria.

For procedures using a specific example, see “Phase 2: Mapping a Column to the 
Workflow Policy Component” on page 148.

3 Map the workflow policy component to the assignment attribute.

For procedures using a specific example, see “Phase 3: Mapping the Workflow 
Policy Component to the Assignment Attribute” on page 150.

4 Define an assignment rule for two objects using one assignment (object) criteria.

For procedures, see “Creating Assignment Rules to Assign Two Objects” on 
page 250.
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For more information about workflows in general, see Siebel Business Process 
Designer Administration Guide.

Example of Creating a Workflow Policy Component
This section explains how to create a workflow policy component based on a 
specific scenario of creating an assignment rule that assigns candidates to two 
objects (Account and Opportunity) using only one of the object’s criteria 
(Opportunity Lead Quality). The example for accomplishing this is divided into four 
phases; perform each phase and the steps within each phase in the order provided.

■ “Phase 1: Creating a Workflow Policy Component for Both Objects” on page 146

■ “Phase 2: Mapping a Column to the Workflow Policy Component” on page 148

■ “Phase 3: Mapping the Workflow Policy Component to the Assignment 
Attribute” on page 150

■ “Phase 4: Administration Tasks After Configuration” on page 152

Phase 1: Creating a Workflow Policy Component for Both Objects
In this first phase, you create a workflow policy component for both objects.

To create a workflow policy component

1 Start Siebel Tools.

2 Lock the project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

For this example, select Assignment (SSE).

c Check the Locked field.

3 Select the workflow policy object for which you want to create a workflow policy 
component.

a In the Object Explorer, select Workflow Policy Object.
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b In the Workflow Policy Objects window, select the object.

For this example, select Account.

4 Add a new workflow policy component record.

a In the Object Explorer, expand Workflow Policy Component.

b In the Workflow Policy Component window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the workflow policy component.

For this example, type Account/Opportunity.

b In the Source Table Name field, select the source table for the workflow 
policy component.

For this example, select S_OPTY.

c In the Source Column Name field, select the source column for the workflow 
policy component.

For this example, select PR_DEPT_OU_ID.

d In the Target Component Name field, select the target component for the 
workflow policy component.

For this example, select Account.

e In the Target Column Name field, select the target column for the workflow 
policy component.

For this example, select ROW_ID. 

Figure 23 on page 149 shows an example of creating the Opportunity workflow 
policy component that maps to the Opportunity source table and the Account target 
table.
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Phase 2: Mapping a Column to the Workflow Policy Component
After you create the workflow policy components for both objects, you need to map 
the workflow policy component to the assignment criteria. You do this by mapping 
a column to one of the workflow policy components. In this example, you map the 
Opportunity workflow policy component to the Opportunity Lead Contact 
assignment criteria.

To map a column to the workflow policy component

1 With the Account/Opportunity record still selected, expand the Workflow Policy 
Component object in the Object Explorer, and then select the Workflow Policy 
Component Col object.

2 In the Workflow Policy Component Columns window, choose Edit > New 
Record.

3 In the Workflow Column Name field, select the workflow column for the 
workflow policy component.

For this example, select Opportunity Lead Quality.

Figure 23 on page 149 shows an example of mapping the Account/Opportunity 
workflow policy component to the Opportunity Lead Quality assignment criteria.
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Figure 23. Mapping Workflow Policy Components to Assignment Criteria
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Phase 3: Mapping the Workflow Policy Component to the 
Assignment Attribute
After you map a column to the workflow policy component, you map the workflow 
policy component to the assignment attribute. In this example, you map the 
Account/Opportunity policy component to the Lead Quality Code assignment 
attribute.

To map the workflow policy component to the assignment attribute

1 In the Object Explorer, select the Assignment Attribute object.

2 In the Assignment Attributes window, select Lead Quality Code.

3 In the Object Explorer, expand the Assignment Attribute object and select the 
Assignment Attribute Column object.

4 In the Assignment Attribute Columns window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the assignment attribute column.

For this example, type Account: Lead Quality.

b In the Assignment Object field, select the assignment object to which 
candidates are assigned for the assignment rule.

For this example, select Account.

c In the Workflow Policy Component field, select the workflow policy 
component to map to this assignment attribute.

For this example, select Account/Opportunity.

d In the Workflow Policy Component Column field, select the workflow policy 
component column to map to this assignment attribute.

For this example, select Opportunity Lead Quality.

e In the Sequence field, specify the sequence of this assignment attribute.

For this example, type 2.
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6 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 153.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or 
delete any assignment object types, assignment criteria, and assignment 
attributes. Make sure all projects are recompiled—not only the locked projects—
if you inactivate or delete a top-level object type or assignment criteria. For more 
information on when to recompile the siebel.srf file, see Table 16 on page 153.

Figure 24 shows an example of mapping the Account/Opportunity workflow policy 
component to the Opportunity: Lead Quality assignment attribute.

Figure 24. Mapping Workflow Policy Components to Assignment Attributes
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Phase 4: Administration Tasks After Configuration
After the workflow policy component is mapped to the assignment attribute, the 
siebel.srf file must be updated and various server administration tasks run. To make 
sure your configurations are recognized, complete steps in “To update your 
deployment with new configurations” on page 154.

Workflow Policy Components Inactivated by Default
The Workflow Policy Components, shown in Table 15 for the Opportunity Workflow 
Policy Object, are inactivate by default for Assignment Manager.

If these Workflow Policy Components are required for your deployment, activate the 
components by following the procedures in “Defining a Workflow Policy 
Component” section of Siebel Business Process Designer Administration Guide.

Table 15. Inactive Assignment Manager Workflow Policy Components

Workflow Policy Object Workflow Policy Component

Opportunity Indirect Account

Opportunity Indirect Account Address

Opportunity Indirect Account Industry

Opportunity Indirect Account Primary Address

Opportunity Indirect Account Synonym

Opportunity Indirect Account/Industry

Opportunity Opportunity/Indirect Account

Opportunity Primary Account Address
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Server Administration After Configuration
After configuring Assignment Manager objects and attributes, it is often necessary 
to recompile the .srf file and restart various server components and tasks. Table 16 
summarizes the required administration tasks based on the type of configuration 
process. 

CAUTION: You must recompile the siebel.srf file whenever you add, inactivate, or 
delete any assignment object types, assignment criteria, and assignment attributes. 
Make sure all projects are recompiled—not only the locked projects—if you 
inactivate or delete a top-level object type or assignment criteria. 

Table 16. Summarization of Server Administration After Configuration

Configuration Process
Compile .srf 
File

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart Workflow 
Monitor Agent 
(for dynamic 
assignment)

Add, inactivate, or delete 
assignment objects

Yes Yes Yes Yes

Configure assignment objects No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment attributes

Yes Yes Yes Yes

Configure assignment 
attribute columns

No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria

Yes Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria 
attributes

Yes Yes Yes Yes
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Use the following procedure to update your deployment with new configurations.

NOTE: Some steps may not be required for your particular deployment. See Table 16 
on page 153 and the particular procedure for the necessary steps.

To update your deployment with new configurations

1 Compile changes to the siebel.srf file, if necessary, and deploy it to the server.

a Choose Tools > Compile Projects.

b In the Object Compiler dialog box, select the project (or projects) you want 
to compile.

NOTE: For the procedures provided in this chapter, select either the 
Assignment, or the Assignment (SSE) project, or both.

c Select the Siebel client repository file (default is siebel.srf) located in the 
Objects subdirectory within the Siebel client root directory.

d Click Compile.

For more information on when to recompile the siebel.srf file, see Table 16 on 
page 153 and Siebel Tools Reference. For information on distributing the 
siebel.srf file, see Siebel Anywhere Administration Guide.

NOTE: It is not necessary to recompile the siebel.srf file whenever you configure 
an assignment object or an assignment attribute column, but you must 
recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, or assignment attributes.

Make sure all projects are recompiled—not only the locked projects—if you 
inactivate or delete a top-level object type or assignment criteria. 

2 If you are running dynamic assignment, perform the following steps:

a Stop the Workflow Monitor Agent server component.
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b Regenerate triggers by running the Generate Triggers server component.

c Release assignment rules (if rules have changed) by clicking Release in the 
Assignment Rules view.

For more information on releasing assignment rules, see “Releasing 
Assignment Rules” on page 202.

d Restart the Workflow Monitor Agent server component. 

For more information on stopping and restarting server components, see Siebel 
Server Administration Guide.

3 If your are running dynamic assignment, stop and restart the Assignment 
Manager server component for the changes to take effect.

a Stop the Workflow Monitor Agent server component.

b Stop the Assignment Manager server component.

c Start the Assignment Manager server component.

d Start the Workflow Monitor Agent server component.

For more information on stopping and restarting server components, see Siebel 
Server Administration Guide.

NOTE: You must stop and restart the Assignment Manager server component 
whenever you add, inactivate, or delete any assignment object types, 
assignment criteria, or assignment attributes.
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This chapter provides a procedure for activating assignment rules and explains how 
to define and use assignment rules in the Siebel client.

NOTE: Even if you intend to use predefined assignment objects, you must define 
assignment rules by completing the tasks in this chapter.
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 157



Assignment Rules

Activating Assignment Rules
Activating Assignment Rules
Assignment Manager comes with predefined assignment rules. If you plan to use 
these predefined rules, you must activate them first. To activate these rules, use the 
following procedure.

To activate an assignment rule

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rule list, select an assignment rule.

3 In the Expiration field, either null the existing value or set the value to a later 
date. 
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Defining Assignment Rules
To define and use assignment rules, you need to perform the following tasks in the 
Siebel client:

■ Create the assignment rule.

For more information, see “Creating Assignment Rules” on page 161.

■ Create assignment rule groups.

For more information, see “Creating Assignment Rule Groups” on page 165.

■ Create key server mappings.

For more information, see “Defining Server Key Maps” on page 168.

■ Create assignment criteria.

For more information, see “Creating Criteria Values” on page 174 and “Creating 
Criteria Values as Skills with Expertise Codes” on page 177.

■ Create criteria values (optional when using the Compare Object to Person 
comparison method).

For more information, see “Creating Criteria Values” on page 174and “Creating 
Criteria Values as Skills with Expertise Codes” on page 177.

■ Create the assignment workload (optional).

For more information, see “Defining Assignment Workload” on page 182.

■ Assign employees, positions, or organizations to the assignment rule (optional 
if All People is checked).

For more information, see “Adding Employees, Positions, and Organizations to 
Assignment Rules” on page 189.

■ Release the assignment rule.

For more information, see “Releasing Assignment Rules” on page 202.
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The following sections explain how to perform each of these tasks using the 
Assignment Administration views. The sections are organized to present 
information in a sequence roughly corresponding to the order in which you are 
likely to be concerned with the subjects described when defining new assignment 
rules.
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Creating Assignment Rules
This section explains how to create assignment rules. For more information on 
assignment rules, see “Assignment Rules” on page 23.

To create assignment rules

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rules list, click New. 

3 In the new record, click in the available fields to enter relevant information for 
the new rule.

Table 17 shows the predefined fields.

Table 17. Assignment Rule Fields

Field Description Example

Activation1 Start date of the assignment rule. 

All Organizations If selected, evaluates all organizations in the 
Siebel database as candidates for this 
assignment rule. However, individual 
organizations and attributes associated with the 
rule are ignored. 

For more information, see the “Minimum Score” 
description in this table.

All People If selected, evaluates all employees or positions 
in the Siebel database as candidates for this 
assignment rule. However, individual people 
and attributes associated with the rule are 
ignored.

For more information, see the “Minimum Score” 
description in this table.

Assignees from Rule Methods used by Assignment Manager to 
determine which potential assignees are 
assigned. For explanations of each method, see 
Table 4 on page 24. This is a required field.

One, Best Fit
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Check Calendar If selected, activates Assignment Manager to 
check employees’ calendars when determining 
assignment eligibility. Used only for employee-
based objects.

Comments Type in your comments here.

Exclusive If selected, candidates for this assignment rule 
supersede candidates that qualified for any 
other non-exclusive assignment rules. 

For more information on the use of the exclusive 
feature with scoring, see Step 8 on page 57 in 
the “Assignment Methodology” section.

Expiration1 End date of the assignment rule.

Minimum Score Minimum score required for candidates to 
qualify for this assignment rule.

Note: You cannot run assignment rules for 
specific candidates and also designate one of the 
All flags (All Organizations or All People) for 
that assignment rule. This is because the two 
settings are mutually exclusive functionalities. If 
the All Organizations or All People flags or both 
flags are checked, then individual organizations 
or people associated with the rule are ignored. 
None of the attributes set for that organization 
or people associated with the rule are 
considered.

Name Name of the assignment rule. High Priority 
Modem Service

Object Objects applied to this rule. If no objects are 
specified, then all objects are applied to this 
rule.

Service 
Request

Table 17. Assignment Rule Fields

Field Description Example
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Primary Employee Primary employee for this assignment rule. 
Typically used for service-related assignments. 
Applicable only if this employee is included for 
the assignment rule. If the Assignee from Rule 
type is One, Best Fit, then do not select a 
primary employee, because the highest-scoring 
employee is still selected and the primary 
employee is ignored.

Primary Organization Primary organization for this assignment rule. 
Applicable only if this organization is included 
for the assignment rule. If the Assignee from 
Rule type is One, Best Fit, then do not select a 
primary organization, because the highest-
scoring organization is still selected and the 
primary organization is ignored.

Primary Position Primary position for this assignment rule. 
Typically used for sales-related assignments. 
Applicable only if this position is included for 
the assignment rule. If the Assignee from Rule 
type is One, Best Fit, then do not select a 
primary position, because the highest-scoring 
position is still selected and the primary position 
is ignored.

Rule Group Assignment rule groups applied to this rule. For 
more information, see “Assignment Rule 
Groups” on page 25.

Score Score given to candidates who qualify for this 
assignment rule

20

Sequence Sequence number for this rule. By default, 
assignment rules do not have a sequence 
number—one must be assigned by the 
administrator. For more information, see 
“Assignment Rule Sequencing” on page 26.

1. Set the machine on which the assignment server resides to Greenwich Mean Time (GMT). 
For more information about GMT, see Global Deployment Guide.

Table 17. Assignment Rule Fields

Field Description Example
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Figure 25 shows an example of creating an assignment rule.

Figure 25. Example of Creating an Assignment Rule
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Creating Assignment Rule Groups
This section explains how to create new assignment rule groups and how to view 
the assignment rules associated with a particular assignment rule group. For more 
information about assignment rule groups, see “Assignment Rule Groups” on 
page 25.

NOTE: An assignment rule does not have to be associated with a rule group. If you 
do not associate rule groups with any of your rules, and you do not specify a 
particular rule group for Assignment Manager to load at startup, then Assignment 
Manager, by default, loads all active rules into memory. For more information about 
running Assignment Manager, see Chapter 5, “Running Assignment Manager.”

To create a new assignment rule group

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rule Groups.

2 In the Assignment Rule Groups list, click New.

3 In the new record, click in the available fields to enter relevant information for 
the new group.

a In the Name field, enter a name for the assignment rule group.

b In the Description field, type in a description for the assignment rule group.

NOTE: When you create a new assignment rule, the assignment rule group field 
defaults to Default Group. For more information about the Default Group, see 
“Assignment Rule Groups” on page 25.
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Table 18 shows the predefined fields.

Table 18. Assignment Rule Group Fields

Field Description

Activation1

1. Set the machine on which the assignment server resides to Greenwich Mean Time (GMT). 
For more information about GMT, see Global Deployment Guide.

Start date of the assignment rule group. 

Note: By default, rules within a group inherit the activation date from 
the group date. However, if you specify an activation date for a 
particular rule, it overrides that date.

Description A description of the rule group.

Expiration1 End date of the assignment rule group. 

Note: By default, rules within a group inherit the expiration date from 
the group date. However, if you specify an activation date for a 
particular rule, it overrides that date.

Key Based Indicates the rule group is intended for key-based routing and usually 
has a corresponding server key mapping.

By checking this flag, even if there is no server key mapping defined 
for the rule group, this makes sure that the rules that belong to this 
rule group are not processed when running the assignment server in 
Default Group mode.

For more information about key-based routing and server key maps, 
see “Server Key Maps” on page 29. For more information about the 
Default Group, see “Assignment Rule Groups” on page 25.

Note: The Key Based field may be a hidden column on the 
Assignment Rule Groups list. You can enable the Key Based field by 
selecting it through the Columns Displayed feature.

Name Name of the assignment rule group.
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Figure 26 shows an example of creating an assignment rule group.

Figure 26. Example of Creating an Assignment Rule Group
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Defining Server Key Maps
This section explains how to define new server key maps. For more information 
about server key mapping, see “Server Key Maps” on page 29. For more information 
about running Assignment Manager using server key maps, see “Running 
Assignment Manager in Interactive Mode” on page 216.

To define a new server key map

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Server Key Map.

2 In the Assignment Server Key Mappings list, click New.

3 In the new record in the More Info form, click in the available fields to enter 
relevant information.

a In the Siebel Server field, enter a server name.

b In the Assignment Rule Group field, select an assignment rule group.

Table 19 shows the predefined fields.

Table 19. Server Key Map Fields

Field Description

Assignment Rule 
Group

A group of assignment rules associated with a particular instance of 
Assignment Manager. For more information, see “Assignment Rule 
Groups” on page 25.

Siebel Server The name of the Siebel Application Server that is running that 
instance of Assignment Manager. For more information, see Siebel 
Server Administration Guide.
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Figure 27 shows an example of creating a new server key map.

Figure 27. Example of Defining a New Server Key Map
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Defining Assignment Rule Sequences
This section explains how to define sequences for assignment rules. For more 
information about assignment rule sequences, see “Assignment Rule Sequencing” 
on page 26.

NOTE: You can use sequencing even if you are not using rule groups. However, if 
some of the rules in the group have sequence numbers and others do not, the rules 
with no specified sequence number are considered to have a sequence number of 
0 and are evaluated first. Therefore, you should give every rule a sequence number 
if you use sequencing.

To define a sequence for an assignment rule

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rules list, select the assignment rule for which you want to 
define rule sequencing.

3 In the Sequence field in the More Info form, enter a sequence number.

Figure 28 shows an example of an assignment rule with a sequence number of 2.

Figure 28. Example of an Assignment Rule with a Sequence
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Creating Assignment Criteria
This section explains how to create assignment criteria for assignment rules. For 
more information on assignment criteria, see “Assignment Criteria” on page 32.

NOTE: Assignment rules can be created with no criteria. A rule of this nature 
functions to make sure data items of a particular type are assigned, that is, objects 
of the defined type pass. Use these rules carefully as a rule defined with no criteria 
can make assignments that are not required. Although assignment criteria are not 
required for an assignment rule, assignment rules with no criteria and no 
assignment object specified are ignored by Assignment Manager.

To create assignment criteria

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rules list, select the assignment rule for which you want to 
create assignment criteria, and then click the Criteria view tab.

3 In the Criteria list, click New.

4 In the new criterion record, click in the available fields to enter the relevant 
information.

NOTE: If you want to query for an assignment criteria, you must use the name of 
the assignment criteria, not the display name. For example, if the name of the 
Account assignment criteria is ACCOUNT_ID, then you must use this name for 
your query, although the display name is Account. The queries for seed 
assignment criteria must also be made with their English names, that is, these 
queries do not accept non-English characters. 
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Table 20 shows the predefined fields.

Table 20. Assignment Criteria Predefined Fields

Field Description Example

Comments Type your comments here.

Comparison Method Methods used by Assignment Manager to 
determine how objects and candidates 
are matched. For explanations of each 
method, see Table 6 on page 32.

Compare to Object

Criteria Type of assignment criteria. Product Defect Priority

Inclusion Methods used by Assignment Manager to 
determine how criteria values and 
candidates are matched. For more 
information on inclusion methods, see 
Table 7 on page 34.

Include

Minimum Score Minimum score required to qualify for 
this criteria.

Required Determines whether the criteria is 
required. For required criteria, candidates 
must meet all conditions of the criteria to 
qualify for the assignment rule. There are 
three choices: Always, Never, and When 
Available.

Always

Score Score for this criteria. Candidates that 
satisfy this criteria have this score added 
to their total score.
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Figure 29 shows an example of creating assignment criteria using values from 
Table 20. This example creates a required Product Defect Priority assignment 
criteria for an assignment rule that is compared to service objects.

Figure 29. Example of Creating Assignment Criteria
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Creating Criteria Values
This section explains how to create criteria values. Each assignment criteria uses 
different predefined criteria values. You determine the number of criteria values and 
define each value by setting assignment attributes (shown as fields in the Values list 
applet). For more information on criteria values, see “Criteria Values” on page 41.

NOTE: Only assignment criteria that use the Compare to Object, Compare to Person, 
or Compare to Organization comparison methods use criteria values. Criteria value 
scores are calculated only for criteria that use the Include inclusion method.

To create criteria values

1 With the appropriate assignment criterion selected in the Criteria list (View > 
Site Map > Assignment Administration > Assignment Rules > Criteria), scroll 
down to the Values list.

2 In the Values list, click New. 

3 In the new record, click in the available fields to enter the relevant information. 

NOTE: The assignment attributes for criteria values that are available differ 
depending on the assignment criterion you select in Step 1.
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Table 21 shows examples of assignment attributes for the assignment criteria 
created in the last section.

NOTE: It is possible to create duplicate criteria values for an assignment criteria. If 
both criteria values use scores in this case, then both scores are added to the 
assignment criteria if the criteria value passes. This can happen when you create 
criteria values that use ranges (such as criteria values for the Revenue assignment 
criteria).

Wildcard characters can also be used when defining specific criteria values. This 
option allows for a greater range of assignment object matches. For example, if you 
create an assignment rule for Account objects with the Account City as assignment 
criteria, the corresponding criteria value City can be defined as A*. This setting 
matches Accounts in cities beginning with the letter A.

If a criteria value includes special characters “?”, “*”, and “\” that are used as 
literals, the escape identifier character (\) must be added before the special 
character in the value field. For example, the criteria value Tri*Laptop is entered 
into the Values field as Tri\*Laptop.

Criteria values that include alphanumeric entries are stored as string values. These 
values are sorted lexicographically, that is, in dictionary order, when determining 
specific ranges for assignment rules. For example, the value AB10 is sorted between 
AB1 and AB9 even though you may require AB10 placed greater than AB9. 

Table 21. Available Assignment Attributes

Criteria Value Example

Score 10
5

Product Defect Priority 1—Very High
2—High
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Figure 30 shows an example of creating a Product Defect Priority criteria value 
using the procedure “To create criteria values” on page 174 and the values in 
Table 21 on page 175.

Figure 30. Example of Creating Criteria Values
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Creating Criteria Values as Skills with Expertise Codes
Creating criteria values as skills with expertise codes is a preconfigured feature of 
assignment criteria values and works with assignment rules for service objects (or 
any object configured to use skills). Creating skills is similar to creating criteria 
values. This section explains how to create skills with expertise codes and how to 
use weighting factors for the skills that you create by describing the following tasks:

■ “Creating Expertise Codes” on page 178

■ “Defining Weighting Factors” on page 179

For more information on creating assignment criteria values, see “Creating Criteria 
Values” on page 174.

Figure 31 shows an example of creating a required Product Line Wildcard 
assignment criterion that is compared to candidates. This criterion requires a 
minimum score of 10 and the modem product skill with an expertise level of 
intermediate or better.

In this example, only candidates with an intermediate or expert expertise qualify for 
this skill and receive 20 points.

Figure 31. Example of Creating a Skill with an Expertise Code
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 177



Assignment Rules

Creating Assignment Criteria
Creating Expertise Codes
When defining a criteria value as a skill, select the desired expertise code from the 
Expertise Code field. For more information on skills, see “Skills” on page 46. 

To create expertise codes, use the procedure in this section. For more information 
on expertise codes, see “Expertise Codes” on page 47.

CAUTION: You should perform the procedures in this section only if the default 
expertise codes (novice, intermediate, and expert) do not meet the requirements of 
your organization.

To create expertise codes

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 In the List of Values list, click New.

3 In the new record, click in the fields to enter the relevant information for the 
expertise code.

a In the Type field, click the select button, query for EXPERTISE_CD in the Pick 
Value Type dialog box, and then click OK.

b In the Display Value field, type the name of the expertise code as you want 
it to appear.

c In the Language-Independent Code field, type in the exact value that you 
entered in Step b.

d In the Language Name field, click the select button to select the appropriate 
language in the Pick Language Name dialog box, and then click OK.

e In the Translate field, click to place a check mark (if not already checked).
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f In the Order field, type a numerical value for the rank of the expertise code.

The numerical value you type in this field determines the rank of the 
expertise code. Use a higher value to apply a greater rank to the expertise 
code, and a lower value to apply a lesser rank.

The new expertise value appears in the List of Values list and also becomes a 
valid expertise code selection in the criteria value drop-down menu when 
defining skills.

For information on multilingual list of values (MLOV), see Siebel Tools Reference.

Figure 32 shows an example of creating a Manager expertise code that is ranked 
higher than the default expertise codes.

Defining Weighting Factors
If you use weighting factors to weigh the expertise codes, candidates with different 
expertise receive different scores. For example, if you use the weighting factors 
described in Table 9 on page 49:

■ Candidates who possess an intermediate expertise in the modem product skill 
receive 20 points and qualify for this criterion.

■ Candidates who possess an expert expertise receive 10 points and qualify for this 
criterion.

■ Candidates who possess a novice expertise fail this criteria (because an expertise 
level of intermediate or better is required), and fail the assignment rule (because 
the criterion is required).

■ Candidates who possess an intermediate expertise are thus favored, because 
they receive a higher score.

Figure 32. Example of Creating Expertise Codes
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This section explains how to define weighting factors to weigh skill scores. For more 
information on weighting factors, see “Weighting Factors” on page 48. For 
information on defining skills for objects, employees, positions, and organizations, 
see Applications Administration Guide.

To define weighting factors 

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 Display the list of values of type EXPERTISE_CD.

a In the List of Values list, click Query.

b In the Type field, click the select button.

c In the Pick Value Type dialog box, query for EXPERTISE_CD, click Go, and 
then click OK.

d In the List of Values list, click Go to complete the query.

3 For each of the resulting display values (default values are Novice, Intermediate, 
and Expert), click in the Weighting Factor field and type in a numerical value.

The numerical value you type in this field, relative to the maximum weighting 
value defined, represents the percentage applied to the skill score. 

NOTE: If the Weighting Factor field is not visible when the List of Values appear, 
use the Columns Displayed feature to make it visible (right-click, select Columns 
Displayed, use the arrows to move Weighting Factor from Available Columns to 
Selected Columns, and then click Save).
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Figure 33 shows an example of defining the weighting factors for the default 
expertise codes using the values listed in Table 9 on page 49.

Figure 33. Example of Defining Weighting Factors
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Defining Assignment Workload
This section explains how to create workload rules and define workload criteria. For 
more information on workload criteria, see “Workload Criteria” on page 43. 
Optionally, you can also create workload rules that can be used in workload criteria. 
After you have created your workload rules (or you can use the predefined 
workload rules instead), you can define workload criteria in assignment rules for 
employees and positions, or for organizations.

To create workload rules

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Workload Rules.

NOTE: If you plan to use the predefined workload rules, skip to Step 4.

2 In the Workload Rules list, click New.

3 In the new record, click in the available fields to enter the relevant information 
for the workload rule.

a In the Name field, type a name for the workload rule.
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b In the Assignment Object field, select the assignment object of the workload 
rule. 

The following table shows the predefined workload rules:

NOTE: The workload rule’s assignment object must match the assignment rule’s 
assignment object; otherwise, the assignment workload criteria is ignored or a 
runtime error occurs (dependent on the assignment rule assignment object’s 
Ignore Extra Attributes runtime parameter setting).

4 With the appropriate workload rule selected, in the Workload Conditions view, 
click New.

5 In the new record, click in the available fields to enter the relevant information 
for the workload conditions.

a In the Field field, select a value to define the workload condition. 

The fields that are available depend on the assignment object selected in 
Step 3 on page 182.

b In the Comparison field, select a comparison method.

NOTE: When specifying values for the comparison operands (LIKE, NOT LIKE, 
IN, NOT IN, and BETWEEN), the Value field must be in a form that the 
underlying database expects. For more information about comparisons, see 
Siebel Business Process Designer Administration Guide.

Workload Rule Name Assignment Object

Excellent Leads Opportunity

Critical Service Requests Service Request

Open Opportunities Opportunity

Total Open Service Requests Service Request
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c In the Value field, select a value with which you want to compare the 
workload condition.

The values that are available depend on the workload condition selected in 
Step 3 on page 182.

NOTE: If the drop-down arrow does not appear when you select the Value 
field, you need to enter an appropriate value. For example, if you are creating 
a workload rule for an Opportunity object and using Position Id as the 
workload condition, you need to enter the physical ROW_ID of the positions.

NOTE: If the assignment object selected for the workload criteria is team-based, 
workload criteria using this workload rule should be associated with an assignment 
rule only if the workload rule object has the team table (or owner field) referenced 
by one of its workflow components. 

Figure 34 shows an example of creating a workload rule called Example for the 
Account assignment object. The workload condition requires that the account state 
equal CA.

To define workload criteria for employees and positions

1 With the appropriate assignment rule selected (View > Site Map > Assignment 
Rules), click the Workload Criteria view tab.

Figure 34. Creating Workload Rules
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2 In the Workload Criteria list, click New. 

3 In the new record, click in the available fields and enter the relevant information.

Table 22 shows the available predefined fields.

Table 22. Workload Criteria Fields for Employees and Positions

Field Description Example

Assignment Object Type of assignment object related to this 
workload rule.

Service Request

Comments Type your comments here.

Max Load The maximum workload allowed for this 
workload rule. For more information on how 
this value affects the workload score, see 
“Workload Criteria” on page 43.

2

Required Determines whether the workload rule is 
required for the assignment rule. Choices are: 
Always and Never. For more information, see 
“Assignment Criteria” on page 32.

Score Score to apply for this workload rule. For 
more information on workload scores, see 
“Workload Criteria” on page 43.

50

Workload Rule Name of the workload rule to apply to the 
assignment rule. The Workload Rule should 
already be defined as shown in “To create 
workload rules” on page 182.

Total Open Service 
Requests
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Figure 35 shows an example of defining a workload criteria for employees and 
positions using values specified in Table 22.

Figure 35. Example of Defining Workload Criteria for Employees and Positions
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To define workload criteria for organizations

1 With the appropriate assignment rule selected (View > Site Map > Assignment 
Rules), click the Organization Workload Criteria view.

2 In the Organization Workload Criteria list, click New. 

3 In the new record, click in the available fields and enter the relevant information.

Table 23 shows the available predefined fields.

Table 23. Workload Criteria Fields for Organizations

Field Description Example

Assignment Object Type of assignment object related to this workload 
rule.

Opportunity

Comments Type your comments here.

Max Load The maximum workload allowed for this 
workload rule. For more information on how this 
value affects the workload score, see “Workload 
Criteria” on page 43.

3

Required Determines whether the workload rule is required 
for the assignment rule. Choices are: Always and 
Never. For more information, see “Assignment 
Criteria” on page 32.

Score Score to apply for this workload rule. For more 
information on workload scores, see “Workload 
Criteria” on page 43.

10

Workload Rule Name of the workload rule to apply to the 
assignment rule. The workload rule should 
already be defined as shown in “To create 
workload rules” on page 182.

Excellent Leads
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Figure 36 shows an example of adding a workload criteria for organizations using 
values specified in Table 23 on page 187.

Figure 36. Example of Defining Workload Criteria for Organizations
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Adding Employees, Positions, and Organizations to 
Assignment Rules

This section provides procedures for adding employees, positions, and 
organizations to assignment rules as follows:

■ “Adding Employees to Assignment Rules”

■ “Assigning Employees to Assignment Rules Based on Availability” on page 193

■ “Adding Positions to Assignment Rules” on page 195

■ “Adding Organizations to Assignment Rules” on page 199

For more information about employees, positions, and organizations, see 
“Candidates” on page 20. For information about assigning skills to employees, 
positions, and organizations, see “Assigning Skills to Employees, Positions, and 
Organizations” on page 68.

Adding Employees to Assignment Rules
This section explains how to add employees to an assignment rule. Service 
organizations typically add employees to objects. For more information on 
employees, see “Employees” on page 20.

NOTE: Assignment Manager does not prevent you from adding employees to an 
assignment rule that requires position assignment. Before adding employees, make 
sure that the objects for the assignment rule allow employee assignment.

To add employees to an assignment rule

1 With the appropriate assignment rule selected in the Assignment Rules view 
(View > Site Map > Assignment Administration > Assignment Rules), click 
the Employees view tab.

2 In the Employees list, click New.
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3 In the Add Employees dialog box, select the employees to include for this 
assignment rule, and then click OK.

NOTE: To select multiple employees, hold down the CTRL key while selecting 
employees.

4 In the new record in the Employees list, click in the available fields to enter or 
edit the relevant information.

Table 24 shows select predefined fields available.

Table 24. Employees List Fields

Field Description Example

Activation Date/Time1

1. Set the machine on which the assignment server resides to Greenwich Mean Time (GMT). 
For more information about GMT, see Global Deployment Guide.

Start date of the assignment rule employee. 4/10/01 3:01:00 PM

Expiration Date/Time1 End date of the assignment rule employee. 4/10/01 3:01:00 PM

Score An initial score for each employee is 
permitted in this field to differentiate 
between other employees for potential 
assignment.

20
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Employees added to assignment rules are stored in a file called rulecache.dat. If new 
employees are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new employees are not recognized. For more 
information about the rulecache.dat file, see “Releasing Assignment Rules” on 
page 202.

NOTE: Assignment Manager caches employee skills in the rulecache.dat file when 
the Siebel Server is started. Every time rules are released, employee skills are 
updated and cached in the new rulecache.dat file that is created. If you want to 
automatically refresh employee skills and recreate the rulecache.dat file at a 
periodic interval, set the value of the AsgnSrvr component parameter to the desired 
interval of update. For more information about employee skills, see “Assigning Skills 
to Employees, Positions, and Organizations” on page 68. For information about the 
AsgnSrvr component parameter, see “Running Interactive Assignment Using the 
Command-Line SRVRMGR Utility” on page 218.

Figure 37 shows an example of adding employees.

Figure 37. Example of Adding Employees
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Assignment Manager can also assign employees based on their association with 
their parent organization. For example, only employees associated with a specific 
organization can be assigned to an assignment object even if other employees not 
associated with the organization qualify. This functionality is called multitiered 
assignment and must be configured for the appropriate assignment object. For more 
information on this feature, see “Multitiered Assignment” on page 52.
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Assigning Employees to Assignment Rules Based on Availability
Assignment rules can be created for employee-based objects using availability-
based assignment, which allows Assignment Manager to check an employee’s 
calendar and to consider the employee’s availability when determining assignment 
eligibility. Assignment objects must be preconfigured before using the assignment 
availability criteria feature. For more information on configuring assignment 
availability, see “Configuring Assignment Objects for Availability-Based 
Assignment” on page 107.

When an assignment object is configured for availability, a user specifies three 
times for the assignment object: an Early Start Time, a Must Start Time, and a 
Duration. 

■ Early Start Time is the earliest time the assignment object can be scheduled. (If 
this time is not specified, it defaults to the Must Start Time.)

■ Must Start Time is the latest time that the assignment object can be started.

■ Duration is the time in minutes required to finish the assignment object’s task.

Each of these times is accessed by Assignment Manager when determining the 
availability of an employee. Assignment Manager then uses the availability 
information like other criteria when evaluating employees for the assignment 
object. Assignment Manager can also be configured to add an activity to the 
calendar of the employee who is assigned the assignment object. For example, if a 
service request is created with times indicating a service duration of four hours, 
Assignment Manager evaluates the object’s times and employees’ schedules, and 
selects only employees who are available for the four hours indicated by the service 
object. Assignment Manager then selects the highest scoring employee available 
and creates an activity for the employee (if the object is configured to assign 
activities). Employees can manually insert activities into their calendar to block 
assignments during specific periods. Similarly, an employee can delete activities 
created by the original assignment so further assignments can be made.

Assignment Manager functions for both single employees and teams. If an object is 
assigned to a team, every employee within the team is assigned an activity for the 
duration of the assignment (if the object is configured to assign activities). 
Assignment Manager can assign activities for the same object at different times 
based on the calendars of individual team members. A calendar activity, however, 
cannot be split up across multiple dates and times.
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When administrators define a new rule, selecting the Check Calendar box on the 
Assignment Rules form activates the assignment availability criteria (see Figure 38).

Figure 38. Check Calendar Box in the Assignment Rule Form

Click the Check Calendar box to
activate assignment by availability.
194 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Assignment Rules

Adding Employees, Positions, and Organizations to Assignment Rules
Adding Positions to Assignment Rules
This section explains how to add positions to an assignment rule. Sales 
organizations typically assign positions to objects. For more information on 
positions, see “Positions” on page 20.

NOTE: Assignment Manager does not prevent you from adding positions to an 
assignment rule that requires employee assignment. Before adding positions, make 
sure that the objects for the assignment rule allow position assignment.

To add positions to an assignment rule

1 With the appropriate assignment rule selected (View > Site Map > Assignment 
Administration > Assignment Rules), click the Positions view tab.

2 In the Positions list, click New.

3 In the Add Positions dialog box, select the positions to include for this 
assignment rule, and then click OK.

NOTE: To select multiple positions, hold down the CTRL key while selecting 
positions. 

4 In the new record in the Positions list, click in the available fields to enter or edit 
the relevant information.
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Table 25 shows select predefined fields available for editing.

NOTE: You can configure Assignment Manager to define additional fields for 
Positions associated with an assignment rule. For more information, see 
“Configuring Assignment Objects to Copy Additional Columns to the Team Table” 
on page 266.

Table 25. Positions List Fields

Field Description Example

Activation Date/Time1

1. Set the machine on which the assignment server resides to Greenwich Mean Time (GMT). 
For more information about GMT, see Global Deployment Guide.

Start date of the assignment rule position. 4/10/01 3:01:00 PM

Expiration Date/Time1 End date of the assignment rule position. 4/10/01 3:01:00 PM

Score An initial score for each position is 
permitted in this field to differentiate 
between other positions for potential 
assignment.

20
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Figure 39 shows an example of adding a position for an assignment rule.

After you add positions for an assignment rule, only the active employees for each 
position are available. If Assignment Manager assigns the position, employees for 
the position have visibility to the assigned object.

To delete system-assigned positions from individual assignment objects, or to 
manually assign other positions, see the procedure in “Maintaining the Manually 
Assigned Primary Position” on page 261. 

Figure 39. Example of Adding Positions
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Positions assigned to assignment rules are stored in a file called rulecache.dat. If 
new positions are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new positions are not recognized. For further 
information, see “Releasing Assignment Rules” on page 202.

NOTE: Assignment Manager caches position skills in the rulecache.dat file when the 
Siebel Server is started. Every time rules are released, position skills are updated 
and cached in the new rulecache.dat file that is created. If you want to automatically 
refresh position skills and recreate the rulecache.dat file at a periodic interval, set 
the value of the AsgnSrvr component parameter to the desired interval of update. 
For more information about position skills, see “Assigning Skills to Employees, 
Positions, and Organizations” on page 68. For information about the AsgnSrvr 
component parameter, see “Running Interactive Assignment Using the Command-
Line SRVRMGR Utility” on page 218.

Assignment Manager can also assign positions based on their association with their 
parent organization. For example, only positions associated with a specific 
organization can be assigned to an assignment object even if other positions not 
associated with the organization qualify. This functionality is called multitiered 
assignment and must be configured for the appropriate assignment object. For more 
information on this feature, see “Multitiered Assignment” on page 52.
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Adding Organizations to Assignment Rules
This section explains how to add organizations to an assignment rule. For more 
information on organizations, see “Organizations” on page 21.

To add organizations to an assignment rule

1 With the appropriate assignment rule selected (View > Site Map > Assignment 
Administration > Assignment Rules), click the Organizations view tab.

2 In the Organizations list, click New.

3 In the Add Organization dialog box, select the organizations to include for this 
assignment rule, and then click OK.

NOTE: To select multiple organizations, hold down the CTRL key while selecting 
organizations, and click OK.

4 In the new record in the Organizations list, click in the available fields to enter 
or edit the relevant information.

Table 26 shows select predefined fields available for editing.

Table 26. Organizations List Fields

Field Description Example

Activation Date/Time1

1. Set the machine on which the assignment server resides to Greenwich Mean Time (GMT). 
For more information about GMT, see Global Deployment Guide.

Start date of the assignment rule 
organization.

4/10/01 3:01:00 PM

Expiration Date/Time1 End date of the assignment rule 
organization.

4/10/01 3:01:00 PM

Score An initial score for each organization is 
permitted in this field to differentiate 
between other organizations for potential 
assignment.

20
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Figure 40 shows an example of adding an organization to an assignment rule.

Organizations added to assignment rules are stored in a file called rulecache.dat. If 
new organizations are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new organizations are not recognized. For further 
information, see “Releasing Assignment Rules” on page 202.

NOTE: Assignment Manager caches organization skills in the rulecache.dat file when 
the Siebel Server is started. Every time rules are released, organization skills are 
updated and cached in the new rulecache.dat file that is created. If you want to 
automatically refresh organization skills and recreate the rulecache.dat file at a 
periodic interval, set the value of the AsgnSrvr component parameter to the desired 
interval of update. For more information about position skills, see “Assigning Skills 
to Employees, Positions, and Organizations” on page 68. For information about the 
AsgnSrvr component parameter, see “Running Interactive Assignment Using the 
Command-Line SRVRMGR Utility” on page 218.

Figure 40. Example of Adding Organizations
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Assignment Manager can also assign organizations based on the positions 
associated within the organization. For example, positions assigned to an 
assignment object can also have their associated organizations assigned. This 
functionality is called multitiered assignment and must be configured for the 
appropriate assignment object. For more information on this feature, see 
“Multitiered Assignment” on page 52.

Alternatively, you can set a default organization for assignment objects. For 
example, if you want records for a given assignment object assigned to a certain 
organization, you can change the Default Org property on the assignment object 
using Siebel Tools. For more information about setting the Default Org property, see 
Siebel Tools Reference.
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Releasing Assignment Rules
After you have created and defined assignment rules, you must release them to 
instruct Assignment Manager to use these rules. Releasing assignment rules also 
updates the rulecache.dat file, which includes information on employees, positions, 
and organizations available for assignment.

CAUTION: The following procedure releases all assignment rules simultaneously. Do 
not release assignment rules while associated server tasks are running.

To release assignment rules 

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rules list, click Release. 

The assignment rules are released and the rulecache.dat file is updated.

NOTE: You can also refresh (update) the rule cache by deleting the rulecache.dat file 
(siebel_server\bin\rulecache.dat) and restarting the Siebel Server.

When a new Siebel Server is installed—for instance, as part of an upgrade— 
pending assignment rules are released (the rule cache is recreated) on the first 
startup. It is recommended that you release assignment rules after installation so 
that servers in the deployment recreate the same rule cache. 
202 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Assignment Rules

Migrating Assignment Rules
Migrating Assignment Rules
You use Siebel Enterprise Integration Manager (EIM) to migrate assignment rules 
from one system to another, such as from a test environment to a production 
environment. For more information about migration, see Siebel Enterprise 
Integration Manager Administration Guide. 

If you add or change assignment objects, assignment attributes, or assignment 
criteria, you must also migrate the repository to the server production database. For 
information on migrating the repository, see Siebel Tools Reference.
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This chapter explains how to run Assignment Manager in the following modes:

■ Interactive (see “Running Assignment Manager in Interactive Mode” on 
page 216)

■ Dynamic (see “Running Assignment Manager in Dynamic Mode” on page 220)

■ Mobile (see “Running Assignment Manager in Mobile Mode” on page 235)

■ Batch (see “Running Assignment Manager in Batch Mode” on page 236)

NOTE: Assignment Manager uses many Siebel Server resources. It is recommended 
you monitor the Siebel Servers whenever Assignment Manager is invoked, 
especially if you run multiple instances at the same time. For more information 
about running multiple instances of Assignment Manager, see “Running Multiple 
Instances of Assignment Manager in Batch Mode” on page 246.

Before running Assignment Manager, you must already have created your 
assignment rules. For information on creating assignment rules, see Chapter 4, 
“Assignment Rules.” You also need to perform several preparation tasks. For more 
information, see the next section, “Preparing to Run Assignment Manager” on 
page 207.

Assignment Manager obtains information required for operation from the following 
sources:
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■ The assignment rules and criteria as well as employees, positions, and 
organizations that are read from the rulecache.dat file.

NOTE: If you want to automatically refresh skills without restarting the 
Assignment Manager component, set the value of the Refresh people skills 
interval component parameter to the desired update interval (the value must be 
greater than zero seconds). Then, when rules are released, Assignment Manager 
refreshes skills and recreates the rulecache.dat file at the periodic interval set. 
For more information about the Refresh people skills interval, see the 
MaxSkillsAge AsgnSrvr component parameter in Table 30 in “Running 
Interactive Assignment Using the Command-Line SRVRMGR Utility” on 
page 218.

■ The run-time parameters of assignment objects and their properties, the list of 
values for the picklists, and employee skills from the database.

■ The assignment rule groups, assignment rule sequences, and server key maps, 
given you have defined these features; otherwise, they are ignored.

Make sure the rulecache.dat file is updated (see “Releasing Assignment Rules” on 
page 202 for this procedure) and the .srf file is compiled with the latest 
configurations (see “Server Administration After Configuration” on page 153 or 
Siebel Tools Reference for information on this procedure) before running 
Assignment Manager.
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Preparing to Run Assignment Manager
Before running Assignment Manager, you must first perform preparation tasks. 
These tasks include:

■ “Checking the Assignment Manager and Server Request Broker Components” on 
page 208

■ “Configuring the Assignment Manager Component” on page 209

■ “Configuring Assignment Manager Event Logs” on page 212

In addition to the preparatory tasks, there are server administration requirements 
that should be addressed before running Assignment Manager. These include:

■ “Server Administration Requirements for Assignment Modes” on page 214

■ “Server Administration Requirements After Configuration” on page 215
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Checking the Assignment Manager and Server Request Broker 
Components

Before running Assignment Manager, you must first make sure that the Siebel 
Server can start one or more multi-threaded assignment servers by checking the 
Assignment Manager and Server Request Broker components.

To check Assignment Manager and Server Request Broker components

1 From the application-level menu, choose View > Site Map > Server 
Administration > Servers.

2 In the Servers list, select the server on which the Assignment Manager and 
Server Request Broker components run, and then click the Server Components 
view tab.

3 In the Component State field in the Server Components list, verify the state of 
each of the following components:

■ Assignment Manager component is Online.

■ Server Request Broker component is Running.

NOTE: If these components are not in their required state, check the log file for 
errors, and then make the necessary corrections.
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Configuring the Assignment Manager Component
Before running Assignment Manager, you should configure the Assignment 
Manager component to enhance its performance for your implementation by 
adjusting the appropriate parameters. Table 27 on page 210 shows the parameters 
you can change.

To configure the Assignment Manager component

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 In the Name field in the Components list, select the Assignment Manager 
component, and make sure it is running on the correct server.

3 Click the Component Parameters view tab.

4 In the Component Parameters list, select the component parameters of interest, 
and adjust the values as required by your implementation to achieve optimal 
performance.

5 After you have determined the optimal settings, make sure that the 
MinMTServers parameter is set to a current value greater than 0, and then restart 
the Siebel Server.

This starts the specified number of Assignment Manager components. For more 
information about starting and restarting the Siebel Server, see Siebel Server 
Administration Guide.
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Table 27 shows the parameters used by Assignment Manager that you can change. 
For a list of predefined server components and generic parameters, see Siebel Server 
Administration Guide.

The following bulleted points explain why you might want to configure some of the 
various Assignment Manager component parameters:

■ Check version iterations. Changing this parameter to a small value, such as 1, 
reduces the potential for invalid assignment. For example, running Interactive 
Assignment before Assignment Manager detects that the Release button was 
recently pressed causes assignment based on the previous version of assignment 
rules. By having a small iteration value, Assignment Manager checks for a newer 
version of assignment rules more frequently. Test your deployment with this 
lower parameter value to make sure it does not interfere with any other database 
activity.

Table 27. Assignment Manager Component Parameters

Parameter Name Parameter Alias Data Type Description DefaultValue

Check version iterations CheckVerIter Integer The lag time before the component 
checks if there is a change to the 
rules version, that is, when the 
Release button was pressed. One 
integer value equals ten seconds 
(minimum value is 1).

6

Default Tasks DfltTasks Integer Default number of service tasks to 
start (server mode only).

0

Log txn only on change LogTxnChgOnly Boolean Log transaction only when there is a 
net change in assignment (for 
example, sales team updated).

TRUE

Maximum MT Servers MaxMTServers Integer Maximum number of active servers 
for a multi-threaded service.

1

Maximum Tasks MaxTasks Integer Maximum number of running tasks 
for a service.

2

Minimum MT Servers MinMTServers1 Integer Minimum number of active servers 
for a multi-threaded service.

1

1. Applies only to the assignment server and other multi-threaded request-based servers.
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■ Maximum MT Servers. This parameter controls the maximum number of 
Assignment Manager server processes that are running at any time (when 
MaxMTServers >MinMTServers). Generally, the default value is sufficient for 
most deployments as server processes and Assignment Manager have large 
resource requirements.

■ Maximum Tasks. This parameter controls the maximum number of server threads 
that can run at any time. For Assignment Manager, this controls the maximum 
number of assignments that can be processed concurrently. The value of this 
parameter should be set to the maximum anticipated concurrent requests 
(dependent on your server’s capabilities).

■ Minimum MT Servers. This parameter controls the number of Assignment 
Manager server processes that are started when the Siebel servers starts up. If 
this value is set to zero, Assignment Manager is disabled. It is recommend to use 
the default value of one, as server processes and Assignment Manager have large 
resource requirements.
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Configuring Assignment Manager Event Logs
Before running Assignment Manager, you can configure event logs to view results. 
The Assignment Manager, Batch Assignment, and Workflow Monitor Agent server 
components are configured to use events. For information on the event log system 
and viewing log files, see Siebel Server Administration Guide.

NOTE: The Trace Flags and Error Flags parameters are no longer used with 
Assignment Manager. 

In addition to the events used for other server components, the Assignment 
Manager, Batch Assignment, and Workflow Monitor Agent server components use 
two specific events to log information related to assignments: Object Assignment 
and Rules Evaluation.

The Object Assignment event is used to trace assignment information. Setting the 
log level for this event type to 3 prints a list of assignment rules and candidates that 
pass. 

The Rules Evaluation event is used to trace matching information. If you set the log 
level for this event type to 3, Assignment Manager prints a list of evaluated 
assignment rules and whether or not they passed. If you set the log level for this 
event type to 4, Assignment Manager prints a list of evaluated assignment rules and 
related criteria values, and whether or not they passed.

NOTE: You can set the log level of both event types to print a list with combined 
results. However, when assigning too many objects, these settings may create 
extremely large log files. 

To set the log level of Assignment Manager events

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 In the Components list, select the Assignment Manager, Batch Assignment, or 
Workflow Monitor Agent component, depending on which component you want 
to set a log level; make sure the selected component is running on the correct 
server.
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3 Select the Component Event Configuration view tab.

4 In the Log Level field in the Component Event Configuration list, adjust the 
values as required by your implementation as follows:

a Select Rules Evaluation; type in 3 if you want to print a list of assignment 
rules and candidates that passed

b Select Object Assignment; type in:

❏ 3 if you want to print a list of evaluated assignment rules and whether or 
not they passed

❏ 4 if you want to print a list of evaluated assignment rules and related 
criteria values, and whether or not they passed

Figure 41 shows an example of setting the log level of event types for the 
Assignment Manager server component.

For more information on configuring event logs, see Siebel Server Administration 
Guide.

Figure 41. Configuring Event Logs for Assignment Manager
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Server Administration Requirements for Assignment Modes
Assignment Manager requires various functioning server components and tasks 
based on the selected assignment mode. Table 28 summarizes the required server 
components and tasks that must be online or started when selecting a particular 
mode of assignment. When Mobile Assignment is selected, use the information 
provided for either Interactive or Dynamic Assignment based on your deployment 
requirements. Detailed information on starting these components and tasks is 
covered in the remainder of this chapter.

Table 28. Summarization of Server Requirements for Assignment Modes

Assignment Mode
Set Assignment 
Manager Online

Start Workflow 
Monitor Agent

Start Server Request 
Broker 

Interactive Mode Yes No Yes

Dynamic Assignment Mode No1 Yes No1

1. This information is based on the default “Assignment Request (In Process)” seeded 
action.

Batch Assignment Mode No No No
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Server Administration Requirements After Configuration
After configuring Assignment Manager objects and attributes or altering assignment 
policies, it is often necessary to stop and restart various server tasks and 
components. Table 29 summarizes the required server tasks and components that 
must be restarted based on the type of configuration process. For further 
information on Assignment Manager configuration, see Chapter 3, “Assignment 
Manager Configuration.” Detailed information on how and when to run these 
server tasks and components is provided in the remainder of this chapter. 

Table 29. Summary of Server Administration After Configuration

Configuration Process

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart 
Workflow 
Monitor Agent

Adding or configuring an assignment object, 
assignment attribute, or assignment criteria

Yes Yes Yes

Changing assignment policies No Yes Yes

Activating or deactivating assignment policies No Yes Yes
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Running Assignment Manager in Interactive Mode
This section explains how to run Assignment Manager in interactive mode. Use 
Interactive Assignment to assign people in real time. The Activity and Service 
Request objects are predefined to use Interactive Assignment. This feature allows 
you to assign employees to activities and service requests in real time by clicking 
the Menu button and choosing Assign. You can also configure other assignment 
objects to use Interactive Assignment. For more information on Interactive 
Assignment, see “Interactive Assignment” on page 60. For more information on 
configuring assignment objects, see “Configuring Assignment Objects” on page 100.

You can run Interactive Assignment using the Siebel Dedicated Web Client, the 
Siebel Web Client (also known as zero footprint client), or the command-line 
SRVRMGR utility. The following subsections explain how to run Interactive 
Assignment for these environments:

■ “Running Interactive Assignment for a Service Request—An Example” on 
page 217

■ “Running Interactive Assignment Using the Command-Line SRVRMGR Utility” 
on page 218

NOTE: Before running Interactive Assignment using the Siebel Dedicated Web Client, 
it is recommended that you verify that the correct parameter settings exist in your 
Siebel client configuration (.cfg) file.  The parameters identified in this configuration 
file specify the location of the Siebel Server where Assignment Manager is running 
and are automatically created during installation of the Siebel client. For 
information about the Siebel client installation process and configuration file, see 
Siebel Web Client Administration Guide and the Siebel server installation guide for 
the operating system you are using.

Interactive Assignment requires the following server components to be:

■ Online

■ Assignment Manager

■ Running

■ Server Request Broker
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You are now ready to run Interactive Assignment. For an example, see “Running 
Interactive Assignment for a Service Request—An Example.”

Running Interactive Assignment for a Service Request—An Example
The Activity and Service Request assignment objects are predefined to use 
Interactive Assignment. The following procedure is an example of running 
Interactive Assignment for service requests and is applicable for use with the Siebel 
Dedicated Web Client as well as the Siebel Web Client. 

To run Interactive Assignment for a service request

1 From the application-level menu, choose View > Site Map > Service 
Requests > All Service Requests.

2 In the Service Requests list, select an open Service Request for assignment.

3 In the More Info form, click the Menu button and select Assign to start 
Interactive Assignment.

4 Choose an assignee from the list of best candidates provided by Assignment 
Manager.

The Siebel client:

■ Communicates with the Siebel Assignment Manager on the Siebel Server and 
creates a list of qualified employees for the service request.

■ Displays the list of qualified employees to the Siebel user, sorted by descending 
scores.

■ Sets the service request owner to the employee that you choose.
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Running Interactive Assignment Using the Command-Line SRVRMGR 
Utility

Interactive Assignment can be run from the command-line interface using the 
AsgnSrvr command and the parameters in Table 30. The command-line interface of 
the Server Manager is the srvrmgr program. For more information on using the 
command-line interface, see Siebel Server Administration Guide. 

Table 30. Interactive Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

AllowDupPostn Allow Duplicate 
Position

Allows assignment of duplicate 
positions to the team

For more information, see 
“AllowDupPostn” on page 242.

FALSE

AsgnKey Assignment Key Rule set used for key-based 
routing

For more information, see 
“AsgnKey” on page 242.

All AM Rule 
Set

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign 
before committing for interactive 
assignment

100

EventDate Event Date Date of the event that caused this 
assignment request

IgnoreCache Ignore assignment 
rule cache

Ignore assignment rule cache 
and read from the database

FALSE

LogTxnChgOnly Log txn only on 
change

Log transaction only when the 
assignment has changed

TRUE
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MaxSkillsAge Refresh people 
skills interval

Interval in which people skills 
are refreshed in seconds (must 
be greater than zero seconds).

Note: This parameter is only 
applicable to interactive 
assignment.

0

ObjWhereClause Object Where 
Clause

WHERE clause of the object for 
interactive assignment

For more information, see 
“ObjWhereClause” on page 242.

UseForUpdate Use FOR UPDATE Use FOR UPDATE to lock 
primary table row

TRUE

Table 30. Interactive Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value
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Running Assignment Manager in Dynamic Mode
Use Dynamic Assignment to reassign people when changes are made to the 
assignment objects (such as Account and Service Request). As other users and 
server programs make changes to the assignment object records, Dynamic 
Assignment automatically assigns the objects to the appropriate people and 
organizations.

This section explains how to run Assignment Manager in dynamic mode. The 
processes described are:

■ “Generating Triggers” on page 222

■ “Running Dynamic Assignment Using the Command-Line SRVRMGR Utility” on 
page 225

■ “Running Workflow Monitor Agents” on page 226

■ “Activating Assignment Policies” on page 229

■ “Assignment Manager Performance in Dynamic Mode” on page 234

To run Dynamic Assignment, the following server components need to be:

■ Enabled:

■ Generate Triggers

■ Running:

■ Workflow Monitor Agent

■ Set and activated:

■ Assignment Policies

NOTE: For performance reasons, do not run Dynamic Assignment when running 
Batch Assignment. Also, do not try to run Dynamic Assignment for a specified rule 
group. When the Workflow Monitor process starts for Dynamic Assignment, only 
assignment rules in the Default Group are loaded into memory.
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You must run Generate Triggers to create triggers that monitor changes in the 
database.

NOTE: To regenerate triggers, you need to run Generate Triggers to remove existing 
triggers, and a second time to recreate new triggers.

The triggers created by the Generate Triggers server component detect changes in 
the Siebel database and trigger the Workflow Monitor Agent to alert the Assignment 
Server. However, triggers generated for Assignment Manager can reference other 
database columns not associated with assignment rules. It is important to make 
sure that triggers are generated only for an assignment policy’s criteria. Large data 
loads can experience performance issues otherwise.

To check and edit triggers

1 Use Siebel Tools, or view the trigger.sql file (/Siebel Root/Siebsrvr/trigger.sql), 
to examine the appropriate table columns.

For more information, see Siebel Tools Reference.

2 Disable the inappropriate columns by inactivating the assignment attribute 
column.

For detailed information, see “Disabling an Assignment Attribute” on page 139.

3 Drop and regenerate new triggers (see the following section, “Generating 
Triggers”).

4 Recheck the trigger.sql file, to confirm that the trigger is no longer active. 

NOTE: When Dynamic Assignment is running, some users may receive the following 
error when attempting to modify a record: “The selected record has been 
modified by another user since it was received. Please continue.” 
This may occur because Assignment Manager updated the record by assigning it 
while the user was trying to edit it. In this situation, the user’s changes may be lost. 
The solution is to refresh the query and reenter the user’s changes. 
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Generating Triggers
To run Dynamic Assignment, you need to run the Generate Triggers server 
component after:

■ Creating or changing an Assignment Object, Assignment Attribute, or 
Assignment Criteria object type in Siebel Tools

■ Changing assignment policies

■ Installing or upgrading the Siebel Server

NOTE: When amending an assignment rule, criteria, or value, or when making 
changes to assignment positions in dynamic mode, you do not have to drop and 
then regenerate database triggers.

Use the Generate Triggers server component to generate the database triggers used 
by Workflow Manager to detect changes in the database. For more information 
about starting and using Generate Triggers, see Siebel Business Process Designer 
Administration Guide.

NOTE: You cannot create custom triggers on the Siebel database. The only supported 
triggers allowed on the Siebel database are those generated during installation or 
from running the Generate Triggers server component. 

To run Generate Triggers

1 From the application-level menu, choose View > Site Map > Server 
Components Requests > My Component Requests.

2 In the Component Requests list, click New.

A new record appears with a system-defined ID automatically generated with a 
status of Creating.
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3 In the My Components Requests form, enter the relevant information for the 
new component request record.

a In the Components/Job field, click the select button.

b In the Components/Job dialog box, query for Generate Triggers, and then 
click OK.

c In the Server field, type the name of the Siebel Server for which you want to 
run Generate Triggers.

d In the Request Key field, type in the name of the request key.

e Complete the rest of the fields, if needed.

4 In the Component Request Parameters list, click New to create a new record for 
the Table Owner Password, and enter the relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for TableOwnPass, and then click 
OK.

c In the Value field, type in the password for your tableowner.

NOTE: If you are using a Microsoft SQL Server database, you need to set the Table 
Owner Password value to the user password with tableowner privileges. Also 
make sure that the Table Owner value is set to dbo.
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5 For the Microsoft SQL Server database, run the generated trigger.sql file against 
the database independently.

a Select EXEC.

b Click in the Value field.

c Type FALSE.

NOTE: If the EXEC parameter is set to TRUE, the Generate Trigger component 
automatically creates the SQL script and applies it to the server database.

Also, if you are creating a large number of triggers because there are too many 
workflow policies, the triggers should be applied by the user and not by the 
Generate Triggers server process. The EXEC parameter should be set to FALSE in 
this case.

For more information on the EXEC parameter, see Siebel Business Process 
Designer Administration Guide.

6 In the My Component Requests form, click the Menu button, and then click 
Submit request.
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Running Dynamic Assignment Using the Command-Line SRVRMGR Utility
Dynamic Assignment can be run using the GenTrig command-line interface 
command and the parameters in Table 31. The command-line interface of the Server 
Manager is the srvrmgr program. For more information on using the command-line 
interface, see Siebel Server Administration Guide.

Table 31. GenTrig Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

EXEC EXEC Install Triggers to DB directly FALSE

Mode Mode Assignment Server and/or Workflow 
mode (ASGN, WORK, or ALL)

ALL

Remove Remove Remove All Triggers Mode FALSE

TAMode TAMode All Territory or Contact Only mode ALL

TrigFile Trigger File Name Output trigger script file name trigger.sql
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Running Workflow Monitor Agents
To run Dynamic Assignment, the Workflow Monitor Agent needs to be running. 
This server component monitors the S_ESCL_REQ table. Database triggers, when 
fired because of object changes, create records in the S_ESCL_REQ table. The 
Workflow Monitor Agent reads these new records and processes requests for 
Assignment Manager policies. Affected objects are then dynamically assigned. For 
more information about Workflow Monitor Agent, see Siebel Business Process 
Designer Administration Guide. 

NOTE: Dynamic Assignment does not log information into S_ESCL_LOG. For more 
information about log files, see Siebel Server Administration Guide.

To start Workflow Monitor Agent from the command-line interface

1 Determine the workflow group that you want Workflow Monitor Agent to 
monitor. 

a From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies. 

b In the Group field in the Assignment Policy list, choose the workflow group 
(the default group is Assignment Group).

2 Start the srvmgr program. 

For detailed information on this process, see Siebel Server Administration Guide. 
After the program starts, the prompt changes to:

srvmgr: server_name>

3 At the prompt, enter the following information to start the Workflow Monitor 
Agent server component task; use the Group information gathered from Step 1 
(Assignment Group used in this example):

start task for component workmon with GroupName=”Assignment 
Group”
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4 Configure other component parameters, if needed.

For more information about other configurable parameters, see Table 32 on 
page 228.

NOTE: Separate the parameters and their values in the command-line statement 
with commas.

5 Alternatively, you can configure a Workflow Monitor Agent to start 
automatically to process assignment requests whenever the Siebel Server starts. 

For detailed information, see Siebel Business Process Designer Administration 
Guide.

This command starts a new task running in the background and returns to the 
Server Manager immediately. For detailed information on starting, stopping, and 
monitoring server tasks, see Siebel Server Administration Guide. For further 
information about the Workflow Monitor Agent, see Siebel Business Process 
Designer Administration Guide.

NOTE: It is possible to set up multiple Workflow Monitor Agents for Dynamic 
Assignment. For more information, see the “Monitoring and Tuning Performance ” 
section of Siebel Business Process Designer Administration Guide.
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Table 32 shows the Workflow Monitor Agent command-line interface parameters.

Table 32. WorkMon Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

ActionAgent Use Action Agent Use Action Agent FALSE

ActionInterval Action Interval Do not re-execute actions 
within specified interval in 
minutes

3600

BatchMode Processes the batch 
policies

Process the batch Policies FALSE

CheckLogCacheSz Cache size of Policy 
violations

Number of policy violations 
to store in cache

100

DeleteSize Request delete size Request delete size 500

GenReqRetry Number of seconds 
to retry

Number of seconds to retry 
sending a Generic Request 
message

120

GroupName Group Name Group Name

IgnoreError Ignore errors Ignore errors while 
processing requests

FALSE

KeepLogDays Number of days to 
keep violation 
information

Number of days worth of 
violation information that 
should be retained

30

LastUsrCacheSz Cache size of last 
user information

Number of last user 
information items to cache

100

MailServer Mail Server Name of email server to send 
notification of abnormal 
termination

MailTo Mailing Address Mail address to review 
notification of abnormal 
termination

ReloadPolicy Reload Policy Reload Policy Interval in 
seconds

86400

Requests Requests per 
iteration

Requests per iteration 5000
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Activating Assignment Policies
Siebel applications include predefined assignment policies for each of the 
predefined assignment objects. You should use these predefined assignment 
policies. However, you can create new assignment policies for Dynamic 
Assignments.

Each Workflow Monitor Agent can monitor one or more assignment policies. You 
can use a single Workflow Monitor Agent to monitor all assignment policies by 
placing all assignment policies in the same workflow group (the predefined 
assignment policies are defined this way). You can also place the assignment 
policies in separate workflow groups and dedicate Workflow Monitor Agents for 
each workflow group.

Assignment Policies should be associated only with the Assignment Request (In 
Process) assignment action. 

CAUTION: Assign a workflow policy group to only one Workflow Monitor Agent. 
Multiple Workflow Monitor Agents running the same workflow policy group cause 
unpredictable completion times and possible multiple actions created for one 
trigger. For more information, see Siebel Business Process Designer Administration 
Guide.

Also, you should not associate customized workflow actions with assignment 
policies. For more information about workflow actions, see Siebel Business Process 
Designer Administration Guide. 

To enable Dynamic Assignment for an assignment object, activate the assignment 
policy for that object. To disable Dynamic Assignment for an assignment object, 
deactivate the assignment policy for that object.

The rest of this section explains how to activate, deactivate, set the workflow group 
for, and create actions for assignment policies. The procedures are:

■ “To set the workflow group for assignment policies” on page 230

■ “To activate an assignment policy” on page 230

■ “To deactivate an assignment policy” on page 231

■ “To create an action for an assignment policy” on page 231
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To set the workflow group for assignment policies

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want 
to set the workflow group.

3 In the Group field, click the select button.

4 In the Workflow Groups dialog box, select a workflow group (the default is 
Assignment Group), and then click OK. 

Figure 42 shows an example of successfully setting Assignment Group to the 
Account object assignment policy.

To activate an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to activate.

3 In the Expiration Date/Time field, click to either null the existing value or set the 
value to a later date.

Figure 42. Example of Setting a Workflow Group for an Assignment Policy
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Workflow components process only active assignment policies that have not 
expired. Figure 43 on page 232 shows an example of activating the Account object 
assignment policy.

To deactivate an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to 
deactivate.

3 In the Expiration Date/Time field, set the value to a date that has already passed.

Workflow components process only active assignment policies that have not 
expired; therefore, you can deactivate an assignment policy by expiring it.

To create an action for an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want 
to create an action.

3 In the Actions list, click New.

4 In the new record, enter values for the relevant information.

a In the Assignment Action field, click the drop-down arrow and select 
Assignment Request (In Process).

b In the Assignment Mode field, click the down-arrow button and select 
MatchAssign.

NOTE: By default, every assignment policy has an action. You need to follow the 
preceding steps only if you accidentally remove an action or create a new 
assignment policy. 
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Figure 43 shows an example of successfully creating an action for the Account 
object assignment policy.

Activating Contact Denormalization
Perform the following procedure to activate contact denormalization. The policy is 
inactivated by default.

NOTE: When Assignment Manager runs in Contact Denormalization mode, it does 
not evaluate assignment rules. Therefore, you do not need to select the Contact 
Denormalization object for the assignment rule to run Assignment Manager in 
Contact Denormalization mode. 

To activate contact denormalization

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select Contact Denormalization, and then 
perform the following:

a In the Group field, click the select button.

b In the Workflow Groups dialog box, select a workflow group (the default is 
Assignment Group), and then click OK.

Figure 43. Example of Creating an Action for an Assignment Policy
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c In the Expiration Date/Time field, either clear the existing value or set the 
value to a later date.

3 In the Actions list, click New to create a new record and enter the relevant 
information.

a In the Assignment Action field, click the drop-down arrow and select 
Assignment Request (In Process).

b In the Assignment Mode field, click the down-arrow button and select 
Denorm.

Figure 44 shows an example of successfully enabling Contact Denormalization for 
Dynamic Assignment.

NOTE: Dynamic assignment can refresh employee, position, and organization skills 
from the database if changes were made to these items. The program argument, 
MaxSkillsAge, forces Assignment Manager to reload this information if activated. By 
default, this argument is not set. In Siebel Tools, select the Assignment Request (In 
Process) workflow policy program to change the MaxSkillsAge argument. For 
information about how to set this parameter using command-line interface, see 
“Running Interactive Assignment Using the Command-Line SRVRMGR Utility” on 
page 218. For more information about setting the parameter, see Siebel Tools 
Reference and Siebel Business Process Designer Administration Guide.

Figure 44. Enabling Contact Denormalization for Dynamic Assignment
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Assignment Manager Performance in Dynamic Mode
If users experience slow response time while running Assignment Manager in 
dynamic mode, you can implement one or more of the following to improve 
Dynamic Assignment performance:

■ Increase the Requests (Requests per iteration) workflow monitor parameter (the 
default is set to 5,000).

■ Decrease the DeleteSize workflow monitor parameter (the default is set to 500).

■ Decrease the SleepTime workflow monitor parameter (the default is 60 
seconds).

■ Increase the ReloadPolicy workflow monitor parameter to a much larger 
number, for example, 86,400 seconds (the default is 600 seconds).

■ Distribute each assignment policy into its individual group and then invoke 
several Workflow Monitor Agents concurrently (one on each Siebel Server, if 
available).
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Running Assignment Manager in Mobile Mode
This section includes procedures to run Assignment Manager in mobile mode. Use 
Mobile Assignment to reassign people based on changes uploaded by mobile 
clients. Assignment Manager assigns objects after a mobile client synchronizes with 
the Siebel Server and uploads assignment requests or any changes to objects and 
assignment rules. Depending on the configuration of Generate Triggers, the 
Workflow Monitor detects these changes and activates Assignment Manager to 
dynamically reassign affected objects. For more information, see “Mobile 
Assignment” on page 62.

NOTE: If a disconnected client sends an assignment request to the Siebel Server while 
running Mobile Assignment, the request is sent as an asynchronous request. 
Because of this, the request does not override the Keep Manual Assign flag.

To run Mobile Assignment

1 Be sure that you have run the Generate Triggers server component. 

For instructions, see “Generating Triggers” on page 222.

2 Start the Workflow Monitor Agent. 

For instructions, see “Running Workflow Monitor Agents” on page 226.

3 Start the Server Request Broker server component (if running Interactive 
Assignment). 

For instructions, see Siebel Server Administration Guide.
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Running Assignment Manager in Batch Mode
This section explains how to run Assignment Manager in batch mode. Use Batch 
Assignment to assign an assignment object in a single batch. You must run 
Assignment Manager in batch mode if you change non-object data that can affect 
assignments. This happens whenever you:

■ Modify assignment rules and want these changes to affect existing objects. You 
modify assignment rules when you:

■ Add or remove employees, positions, or organizations

■ Add, remove, or update assignment criteria or criteria values

■ Associate a rule with a different rule group or change the rule sequence 
number

■ Change scores

■ Change activation and expiration dates

■ Change exclusive mode

■ Modify the list of employees, positions, or organizations and you want these 
changes to affect existing objects. You modify the list of employees, positions, or 
organizations when you:

■ Add new employees, positions, or organizations (if you use assignment rules 
with the All People setting)

■ Change skills of employees, positions, or organizations (these values are 
cached in memory)

■ Change the Assignment Manager configuration in Siebel Tools and you want 
your changes to affect existing objects. You change the Assignment Manager 
configuration when you:

■ Change Assignment Attribute definitions

■ Change Assignment Criteria definitions

■ Change Assignment Object definitions

■ Change Workflow Policy Object definitions
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■ Use EIM (Enterprise Integration Manager) to perform initial loads (if you do not 
run Generate Triggers to create the appropriate triggers).

NOTE: When using EIM to load assignment rules, make sure the column 
ASGN_TYPE_CD includes a value. If it is left NULL, which is permissible in EIM, 
the rules are loaded but Assignment Manager fails. 

■ Feel that existing assignments may not be accurate. Assignment Manager does 
not change assignments if the existing assignments are correct.

NOTE: When batch mode is run on correct assignments, although there are no 
changes to the team or primary, an update of the record occurs. This situation 
can disturb other workflow policies relying on various record fields. For 
example, a workflow policy relying on PR_POSTN_ID field to trigger an action 
does not work properly if this field is updated from a new batch assignment. If 
your deployment uses SQL Server, this note does not apply. 

If you run both Batch Assignment and Dynamic Assignment in your environment, 
the Batch Assignment can activate Dynamic Assignment due to triggers created in 
the database required to run Dynamic Assignment. Before running Batch 
Assignment, you should deactivate all assignment policies and drop related triggers 
to prevent Dynamic Assignment from processing modified rules, objects, and 
candidates. For more information, see “To deactivate an assignment policy” on 
page 231 and “To run Generate Triggers” on page 222. After completing Batch 
Assignment, you can activate the assignment policies and re-enable Dynamic 
Assignment. For more information on batch assignment, see “Batch Assignment” 
on page 62. For more information, see “To activate an assignment policy” on 
page 230.

NOTE: For performance reasons, do not run Batch Assignment while running 
Dynamic Assignment.
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You can have a batch assignment task load only a particular group of rules into 
memory by specifying the ROW ID of the rule group in the Assignment Key 
parameter when you start the task. If no rule group is specified for this parameter, 
the batch task loads all rules in the Default Group into memory. If no rule groups 
have been defined in the application, then all active rules in the database load. For 
more information, see “Assignment Rule Groups” on page 25.

To run Batch Assignment 

1 From the application-level menu, choose View > Site Map > Server Component 
Requests > My Component Requests.

2 In the My Component Requests form, click New.

A new record appears with a system-defined ID automatically populated with a 
status of Creating.

3 In the new record, enter the relevant information for the new component 
request.

a In the Components/Job field, click the select button.

b In the Components/Jobs dialog box, query for Batch Assignment, and then 
click GO.

c In the Server field, type the name of the server on which you want to run this 
batch request.

d Optionally, if you want to run a specific rule group for this batch, type the 
Row ID of the assignment rule group for which you want rules processed for 
the AsgnKey parameter.

e Complete the rest of the fields for the new record, if needed.

4 In the Component Request Parameters list, click New to create a new record, and 
enter relevant information for the assignment object that you want to assign as 
part of this batch request.

a In Name field, click the select button.

b In the Job Parameters dialog box, select Assignment Object Name, and then 
click OK.
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c In the Value field, enter the name of the assignment object for the parameter.

Use the exact name found in Siebel Tools, such as Service Request or 
Order (Sales Credit Assignment).

NOTE: Because Batch Assignment cannot run more than one assignment object 
per batch, you should run Batch Assignment on only one assignment object for 
each batch.

5 While still in the Component Request Parameters list, click New to create a new 
record so that Assignment Manager uses the Object WHERE clause to limit the 
number of rows processed at one time.

a In Name field, click the select button.

b In the Job Parameters dialog box, query for ObjWhereClause, click Go, and 
then click OK.

c In the Value field, enter a WHERE clause to select the object instance that 
you want to process; the WHERE clause can include up to 100 characters.

For example, to select object instances beginning with ibm, type:

WHERE name like ‘ibm%’ 

NOTE: If you leave the value field blank, all object instances are selected. 
However, it is strongly recommended that you limit the number of rows that 
Assignment Manager processes to make sure that sufficient rollback space is 
available.

For more information about using the Object WHERE clause, see Table 33 on 
page 241 and further description following table.
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6 Optionally, if you want to enable Contact Denormalization for Batch 
Assignment, add two more component request parameter records with 
values from the following table:

7 Optionally, if you want to save changes to the database during batch processing, 
add another component request parameter as follows:

a In Name field, click the select button.

b In the Job Parameters dialog box, query for Batch Size, and then click Go.

c In the Value field, enter the number of objects to assign before committing 
each batch.

8 In the My Component Requests form, click the menu button and choose Submit 
request.

CAUTION: Batch Assignment updates the ASGN_DT and timestamp fields if there is a 
net change (for example, if there is a change in at least one of the primaries or if 
there is a change in at least one of the team tables), and all columns are updated 
(primaries, ASGN_DT, and system columns). However, if there is no net change, 
only the ASGN_DT column is updated. 

Parameter Name Value

Assignment Object Name Contact Denormalization

Assignment Mode Denorm
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Running Batch Assignment Using the Command-Line SRVRMGR Utility
Batch Assignment can be run from the command-line interface using the AsgnBatch 
command and the parameters in Table 33. The command-line interface of the Server 
Manager is the srvrmgr program. For more information on using the command-line 
interface, see Siebel Server Administration Guide.

Table 33. Batch Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

AllowDupPostn Allow Duplicate 
Position

Allows duplicate positions.

For more information, see 
“AllowDupPostn” on page 242.

FALSE

AsgnKey Assignment Key Used to specify a particular rule 
group for a batch assignment 
task.

For more information, see 
“AsgnKey” on page 242.

All AM Rule 
Set

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign 
before committing for Batch 
Assignment

100

EventDate Event Date Date of the event that caused 
this assignment request

IgnoreCache Ignore Assignment 
Rule Cache

Ignore assignment rule cache 
and read from the database

FALSE

LogTxnChgOnly Log txn only on 
change

Log transaction only when the 
assignment has changed

TRUE

ObjWhereClause Object Where 
Clause

WHERE clause of the object for 
Batch Assignment

For more information, see 
“ObjWhereClause” on page 242.

UseForUpdate Use FOR UPDATE Use FOR UPDATE to lock 
primary table row

TRUE
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Additional Parameter Characteristics
The following bulleted points provide additional information about some of the 
parameters shown in Table 33 on page 241.

■ AllowDupPostn

When this parameter is set to TRUE (set to FALSE by default), Assignment 
Manager attempts to insert duplicate positions (positions with the same id) in 
the team table, given these positions do not violate the user key constraints of 
the table. The third field of the PositionTeamDenorm (Y, N value) user property 
specifies which destination columns are part of the user key. Assignment 
Manager checks whether or not positions with the same Id that pass violate the 
uniqueness of these key columns. If Assignment Manager detects a violation, the 
position with the lower score is ignored. Otherwise, Assignment Manager inserts 
both positions in the team table.

If Assignment Manager detects a violation, only the first position encountered is 
inserted and the other is ignored.

■ AsgnKey

The AsgnKey parameter is the row id of the assignment rule group that is 
associated with the rules you want to evaluate. When using AsgnSrvr, the 
AsgnKey parameter must be the row id of one of the rule groups defined for the 
Server in the Server Key Mappings view. For AsgnBatch, it can be the row id of 
any of the available rule groups. The default value of the parameter is All AM 
Rule Set, in which case all active rules are evaluated.

■ ObjWhereClause

Standard SQL WHERE statements are used for the Object WHERE Clause and 
can include up to 2048 characters when a batch assignment server task is started 
using the command-line interface. However, when you start a batch assignment 
server task from the Component Requests screen, you can only specify up to 100 
characters. Also, when using wildcards in the object WHERE clause, make sure 
you use the correct wildcard specific to your database.

The Object WHERE Clause can be used to restrict which records are retrieved 
and processed in Batch Assignment. The following conditions apply:
242 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Running Assignment Manager

Running Assignment Manager in Batch Mode
■ Joins are allowed in the Object WHERE Clause. 

An example of a join is as follows:

Assignment Object = Account

Object Where Clause = where pr_postn_id in (select row_id from 
s_postn where name = 'Sales Rep') 

The Object WHERE Clause assumes the base table is coming from the 
assignment object specified. 

For example, if you start Batch Assignment specifying the assignment object 
as Account and the Object Where Clause is where row_id = '1-232', then 
Batch Assignment attempts to assign only the row_id = '1-232' from the 
S_ORG_EXT table.

The following is an example of a batch assignment using the command-line 
interface:

start task for component AsgnBatch with AsgnObjName= “Account”, 
AsgnMode=“MatchAssign”, ObjWhereClause=“where name like 'B%'”

This command batch assigns accounts starting with B. Optionally, you can 
use the command-line interface and the Object WHERE Clause to run only a 
select number of assignment rule groups. The following is an example of this:

start task for comp asgnbatch with asgnobjname="Account", 
objwhereclause="where name like 'B%'", asgnkey="12-4DR56"

In this example, 12-4DR56 is the Row Id of an assignment rule group, and 
only those rules belonging to this group are evaluated when this parameter 
is passed in the request.

NOTE: When using the command-line interface, use double quotation marks 
for the ObjWhereClause parameter; otherwise, it is treated as a SRVRMGR 
command option that changes the case.
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Assignment Manager Performance in Batch Mode
If users experience slow response time while running Assignment Manager in batch 
mode, review the settings on virus software installed on the applicable server. 
Implement one or more of the following settings to improve batch assignment 
performance.

■ Virus scan only program files.

■ Exclude all outbound files from virus scanning.

■ Exclude the RDBMS directory where all msb files are located from virus 
scanning.

Make sure to run a full virus scan on all files during the weekend or off-peak time 
if the preceding settings were used.

You can also implement one or more of the following to boost batch performance 
in batch mode:

■ Increase the BatchSize parameter, for example, set the batch size to 500 (the 
default is set to 100).

This increases the number of records that are processed within a transaction 
before a commit occurs, resulting in less resources used and faster assignment.

NOTE: Only set large batch sizes when there are no or very few users on the 
system.

■ Create multiple instances of Batch Assignment (using WHERE clause 
statements). See “Running Multiple Instances of Assignment Manager in Batch 
Mode” on page 246.

■ Select a good filter.

This reduces the time it takes to retrieve Object records.

NOTE: Use indexed field or fields for comparison in the object WHERE clause, 
such as Name for Account and Opportunity, or Last Name for Contacts.
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■ Use better logic.

For example, if you want to run Account Assignment based on account name, 
you can create multiple batches so that the first batch starts with names 
beginning with the letter C through K, the second batch starts with the letter L 
through R, and so on. 

Consider the following logic:

Object Where Clause: WHERE NAME > ‘B’ AND NAME < ‘L’

Although this causes the database to retrieve account records with names 
starting with the letter C through K, the WHERE clause is specified in such a 
manner that if accounts starting with the letter M through Z are encountered, 
they are passed on the first round because the values are > B. They are then 
eliminated in the second round (< ‘L’) by the database. These records are not 
needed in the batch because there is a cap of account names less than L.

It is better logic to use:

Object Where Clause: WHERE NAME < ‘L’ AND NAME >‘B’

By switching the order of the conditions, the extra parsing required by the 
database in the second round is eliminated because most of the names start with 
a letter greater than B.
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Running Multiple Instances of Assignment Manager in Batch Mode
When there are many objects that need to be assigned, you can run multiple 
instances of Assignment Manager in batch mode to improve performance. First, 
develop a strategy for specifying multiple batches using the Object Where Clause 
parameter in the Batch Assignment component. Then, start multiple instances of 
Batch Assignment specifying the appropriate Object Where Clause for each 
instance.

For example, you can run one instance of Batch Assignment for accounts that 
changed today and a different instance of Batch Assignment for accounts that 
changed yesterday. Use the Object Where Clause parameter to specify the following:

■ For the batch that processes accounts changed today: 

Object Where Clause: WHERE LAST_UPD = SYSDATE

■ For the batch that processes accounts changed yesterday:

Object Where Clause: WHERE LAST_UPD = SYSDATE - 1

To process mutually exclusive sets of records when running multiple instances of 
Assignment Manager simultaneously for the same assignment object, you should 
specify an Object Where Clause for each assignment task. For more information 
about the Object Where Clause parameter, see “ObjWhereClause” on page 242.

There are several instances where you should not run multiple simultaneous batch 
jobs:

■ If multiple Assignment batches are executed for the same object, then the results 
can potentially vary and may not be as desired

■ If the batch jobs update rows on the same table or tables

■ If one batch job updates records in a table or tables used by another batch job 
as input

■ If the batch jobs use workload criteria to assign the same object

NOTE: If multiple assignment batches are executed for the same object using 
workload criteria, the results can potentially vary and may not be as desired.
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Examples of when you should not run multiple simultaneous batch jobs include:

■ Contact and Contact Denormalization because the same tables are updated

■ Account and Contact Denormalization because Contact Denormalization uses 
Account team as input

■ Opportunity and Contact Denormalization because Contact Denormalization 
uses Opportunity team as input

NOTE: The ASGN_PROC_ID column in the S_ORG_EXT table is no longer used. If 
you have updated this column to run multiple batches of Batch Assignment in 
previous versions, note that as of version 6.0 you can no longer do so.
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Assignment Manager allows the creation of very advanced assignment 
configurations. This chapter is intended for users familiar with the preceding 
chapters and who require further information on refining their Assignment Manager 
deployment.

Before beginning any of the following procedures, review background knowledge in 
the Siebel software architecture, Siebel Tools, and Siebel Workflow Manager. 
Consult the following documentation for this information: Siebel Tools Reference 
and Siebel Business Process Designer Administration Guide.

For further information or assistance on any of these procedures, contact Siebel 
Technical Support.
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Creating Assignment Rules to Assign Two Objects
In some cases, you may want to create an assignment rule that assigns candidates 
to two objects while using only one object’s criteria. This section uses a specific 
scenario as an example in which you create an assignment rule to use only an 
Opportunity criteria to assign candidates to both the Opportunity and Account 
objects. This rule can be used to assign candidates to opportunities and their 
associated accounts.

To create assignment rules that assign two objects using only one object criteria, 
you need to create and map workflow policy components using Siebel Tools.

To define an assignment rule for two objects using one assignment criteria

1 Create an assignment rule and specify the assignment objects that are assigned 
using this rule.

For this example, create an assignment rule called Account/Opportunity and add 
the Account and Opportunity objects to this rule. For more information about 
creating assignment rules, see “Creating Assignment Rules” on page 161. 

2 Create an assignment criteria that applies to only one of the assignment objects 
in this assignment rule.

For this example, configure the Lead Quality Code assignment criteria (an 
Opportunity object criteria). For more information on creating assignment 
criteria, see “Defining Server Key Maps” on page 168.

3 After the assignment rule is defined, create a workflow policy component that 
maps to both objects.

For information on creating a workflow policy component, see “Phase 1: 
Creating a Workflow Policy Component for Both Objects” on page 146.
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4 Map the workflow policy component you created with the column.

For information on mapping a workflow policy column, see “Phase 2: Mapping 
a Column to the Workflow Policy Component” on page 148.

5 Map the workflow policy component you created to the assignment attribute.

For information on mapping a workflow policy component to assignment 
attributes, see “Phase 3: Mapping the Workflow Policy Component to the 
Assignment Attribute” on page 150.

Figure 45 shows an example of defining an assignment rule for the Account and 
Opportunity objects using only the Lead Quality Code assignment criteria. 

Figure 45. Example of Defining an Assignment Rule for Two Objects Using One Assignment 
Criteria
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Assigning Objects Based on the Primary Address
An assignment rule with address criteria, by default, passes objects (Account, 
Contact, and Opportunities, for example) based on any one of the multiple 
addresses associated with the objects. However, Assignment Manager is 
configurable to assign based on only the primary address. This configuration is 
completed through Siebel Tools in the following procedure. The Account 
assignment object is used in this example.

NOTE: For Siebel Life Sciences, Assignment Manager can populate the Primary 
Address field for the system-assigned positions for the contacts on the intersection 
table (S_POSTN_CON).

To assign objects based on the primary address

1 Start Siebel Tools.

2 Select the assignment object.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Objects list, select Account.

3 Select the workflow policy component to change the Source Column and Target 
Column fields.

a In the Object Explorer, select Workflow Policy Component.

b In the Workflow Policy Component window, select Account Address.

c Change Source Column Name to ROW_ID (from OU_ID).

d Change Target Column Name to PR_ADDR_ID (from ROW_ID).

4 Repeat Step 2 and Step 3 for the Contact and Opportunity assignment objects.

5 Check in the projects to the server.

For more information about checking in projects, see Siebel Tools Reference.
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6 Drop and regenerate triggers by running the Generate Triggers server component 
(if using dynamic assignment or workflow policies).

See “Generating Triggers” on page 222 for more information on stopping and 
restarting this server component. Alternatively, see Siebel Server Administration 
Guide.
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Assigning Child Accounts Based on Parent’s Primary 
Address

A common business requirement involves the configuration of Assignment 
Manager to assign children accounts based on the primary account’s address. This 
configuration is completed through Siebel Tools using the following procedure.

To assign child Account objects based on the parent’s primary address

1 In the Object Explorer, select the Workflow Policy object and click the Account 
record; expand the Workflow Policy object in the Object Explorer and select the 
Workflow Policy Components object.

2 Create two new workflow policy components, Parent Account and Parent 
Account Address, with the properties in the following table:

3 While the new Parent Account Address record is selected, expand the Workflow 
Policy Component object and click the Workflow Policy Component Column 
object. Create a new record with the properties in the following table:

Name: Parent Account Parent Account Address

Source Table Name: S_ORG_EXT S_ADDR_ORG

Source Column Name: ROW_ID ROW_ID

Target Component Name: Account Parent Account

Target Column Name: PAR_OU_ID PR_ADDR_ID

Name: State

Alias Parent Account State
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4 In the Object Explorer, select the Assignment Attributes object and create a new 
record with the properties in the following table:

5 While the new assignment attribute Parent Account State is selected, expand the 
Assignment Attributes object and click the Assignment Attributes Column 
object. Create a new record with the properties in the following table:

6 In the Object Explorer, select the Assignment Criteria object and create a new 
record with the properties in the following table:

Name: Parent Account State

Data Type: Varchar

Pick List: PickList State

Pick Field: Value

Name Account: Parent Account State

Assignment Object Account

Workflow Object: Account

Workflow Component: Parent Account Address

Workflow Component Column: Parent Account State

Sequence: 1

Name: Parent Account State

Display Name Parent Account State

Use Expertise FALSE
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7 While the new assignment criteria Parent Account State is selected, expand the 
Assignment Criteria object and click the Assignment Criteria Attribute object; 
create a new record with the following properties:

After the configurations are complete, the project must be checked into the server, 
and various server administration procedures must be run. To update your 
deployment with these new configurations, see “Server Administration After 
Configuration” on page 153.

For more information on compiling projects, see Siebel Tools Reference. For 
information on distributing the siebel.srf file, see Siebel Anywhere Administration 
Guide.

An assignment rule can now be created that assigns child accounts based on the 
parent’s primary address.

NOTE: Make sure the child account has a value in the PAR_OU_ID column pointing 
to a parent account that has the primary address.

Name: Account: Parent Account State

Assignment Attribute: Parent Account State

Store Column: 1

Display Sequence: 1

Display Name: Parent Account State
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Reassigning Accounts to a Different Primary Position
To reassign Account assignment objects to another position, use the following 
procedure. This procedure provides an example of mapping the PR_POSTN_ID 
column of the Account’s base table (S_ORG_EXT) to a new assignment attribute 
named Account Primary Position. Configuration in Siebel Tools is required for this 
process.

NOTE: The following procedure can be employed anytime you want to use a base 
table column as an assignment attribute.

To reassign accounts to a different position

1 Start Siebel Tools (see Siebel Tools Reference for more information on proper 
Siebel Tools configuration procedures).

2 In the Object Explorer, select the Workflow Column object and create a new 
record with the following properties:

■ Name: Account Primary Position Id

■ Table: S_ORG_EXT

■ Column: PR_POSTN_ID

3 Select Workflow Policy Object > Account > Workflow Policy Component > 
Account record; drill down to the Workflow Policy Component Column and add 
a new record called Account Primary Position Id.

4 In the Object Explorer, select Assignment Attribute and create a new record 
called Account Primary Position; drill down to Assignment Attribute Column 
and add a new record with the following properties:

■ Name: Account: Account Primary Position Id

■ Assignment Object: Account

■ Workflow Policy Object: Account

■ Workflow Component: Account

■ Workflow Policy Component Column: Account Primary Position Id
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■ Sequence: 1

5 In the Object Explorer, select Assignment Criteria and create a new record called 
Account Primary Position; drill down to the Assignment Criteria Attribute and 
create a new record called Account Primary Position Id with the following 
properties:

■ Name: Account Primary Position Id

■ Assignment Attribute: Account Primary Position Id

■ Store Column: 1

■ Display Sequence: 1

■ Display Name: Id

6 Check in the project to the server, compile changes to the siebel.srf file, and 
distribute it to your users.

a Choose Tools > Compile.

b In the Object Compiler dialog box, select the Assignment project.

c Select the Siebel client repository file (default is siebel.srf file) located in the 
Objects subdirectory within the Siebel client root directory.

d Click Compile.

7 In the updated Client, create a new assignment rule based on the assignment 
object Account; add a new criterion for this rule, and select the Account Primary 
Position; under the values applet, select the ROW_ID of the position you want 
to reassign.

8 Navigate to the Positions view of this new Assignment Rule; select the new 
position that is to replace the previous position.

9 Release assignment rules by clicking Release in the Assignment Rules view.

10 Run a Batch Assignment against a test account that includes the old position; 
use the following parameters:

■ Object: Account

■ Object WHERE clause: WHERE ROW_ID=’<your_value>’ 
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11 Confirm that the test account is reassigned and then run a Batch Assignment to 
reassign the other accounts to the new position; use the following parameters:

■ Object: Account

■ Object WHERE clause: WHERE PR_POSTN_ID=’<your_value>’

Thoroughly test this assignment rule before applying it to your production 
environment. After your Accounts have been reassigned, it is recommended that 
you expire this rule. 

12 Depending on your situation, run Contact Denormalization to update the 
contact access list.

13 To set up Position in the Values applet as a picklist, select the appropriate picklist 
and applet when configuring the Workflow Column and Assignment Criteria 
Attribute for the Account Position Id. 
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Routing of Assignments to Mobile Users
The component parameter LogTxnChgOnly controls whether transactions with no 
change to Assignment primary or team members are routed to mobile or remote 
users. This parameter has a default setting of TRUE for Batch Assignment, 
Interactive Assignment (Assignment Manager), and implicitly Dynamic Assignment 
(Workflow Monitor Agent). As a result, transactions with no change to Assignment 
primary or teams are not routed to mobile users. To change the LogTxnChgOnly 
parameter for dynamic assignment, use the following steps. This procedure requires 
configuration in Siebel Tools.

To change the LogTxnChgOnly parameter

1 Stop the Workflow Monitor Agent processing the assignment policies.

2 Start Siebel Tools (see Siebel Tools Reference for more information on proper 
Siebel Tools configuration procedures).

3 In the Object Explorer, select the Workflow Policy Program and select 
Assignment Request (In Process).

4 Drill down to Workflow Policy Program Arguments in the Object Explorer and 
select the LogTxnChgOnly parameter.

5 Change the value to TRUE or FALSE.

6 Check in the project to the server.

7 Restart the Workflow Monitor Agent. 

NOTE: You do not need to recompile the .srf file.
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Maintaining the Manually Assigned Primary Position
Assignment Manager maintains an assignment object’s manually assigned primary 
position only when PR_REP_MANL_FLG=Y. By default, this value is set to N.

For example, when an assignment opportunity object is created in the Siebel UI, the 
creator is added to the opportunity object’s team as the primary. For this position 
to be recognized as the manually assigned primary by Assignment Manager, an 
employee with Data Administration rights must set this property in the appropriate 
administrative screen. This action changes PR_REP_MANL_FLG to Y so Assignment 
Manager does not reset the primary when run.

To maintain the object’s primary position

1 Start your Siebel application. 

2 Access the Data Administration screen (check your responsibility if this screen 
is not visible).

3 Navigate to the Opportunity (or other assignment object) screen.

4 Locate and select the assignment object of interest.

5 Click the Sales Team select button to launch the Sales Team window.

6 Click the Primary check box of another position in the list; then reselect the 
Primary check box of the original position.

This process changes the system PR_REP_MANL_FLG value to Y and updates 
PR_REP_SYS_FLG to N. 

This procedure can also be used to add positions to the object or delete system-
assigned positions from the object. 
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Stopping Assignment of the Default Organization
If you want to override the assignment of all organizations to an assignment object, 
you must remove the assignment property Org Primary Column from a selected 
assignment object. The default value is set to BU_ID. After this value is set to null, 
Assignment Manager does not assign any organization to the assignment object. 
The following procedure details this configuration. The account assignment object 
is used as an example.

To stop assignment of the default organization to Account object

1 Start Siebel Tools and select the appropriate project.

2 In the Object Explorer, expand Workflow Policy Object.

3 Select Assignment Object.

4 Select the Account Record.

5 In the Properties Window, find the property called Org Primary Column.

6 Delete the value for this property. (The default value is BU_ID.)

After the assignment object is modified, various server administration procedures 
must be run to make sure your configurations are recognized by Assignment 
Manager.

■ If you are using Batch Assignment, start a new task.

■ If you are using Dynamic Assignment, stop and restart the Workflow Monitor 
Agent. 

■ If you are using Interactive Assignment, stop and restart the Assignment 
Manager Server Component.

NOTE: It is not necessary to recompile the .srf file when configuring an assignment 
object to stop assignment of the default organization. 
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Stopping Assignment of Organizations for Accounts
If you do not want Assignment Manager to reassign the organizations that you have 
setup for an account, you must change the default values for the Account 
assignment object properties in Siebel Tools. 

To stop reassignment of organizations for accounts

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object.

3 In the Workflow Policy Object list, select Account.

4 In the Object Explorer, click Assignment Object.

5 In the Assignment Objects list, set the following values:

■ Default Organization = <blank> 

■ Org Primary Column = <blank>

■ Org Table = <blank>

■ Set Primary Org = FALSE

NOTE: Where <blank> is a null value.

After these values are set, Assignment Manager does not reassign any 
organizations for accounts.

6 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the “To update your deployment with 
new configurations” procedure.

NOTE: It is not necessary to recompile the .srf file. However, you should check-in 
the changes to the server database.
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Setting the Lock Assignment Default Value for Activity 
Assignment Objects

Assignment objects contain a lock assignment feature that, when activated by 
checking the Lock Assignment column on the object's list applet in Siebel Tools, 
prevents Assignment Manager from assigning or reassigning a position or candidate 
to that object.

The Lock Assignment parameter for activity objects is, by default, set to TRUE. This 
setting does not allow Assignment Manager to assign these objects. Therefore, 
Assignment Manager does not assign activity records. However, the Field Service 
Activity object is the one exception and is, by default, available for assignment (the 
Lock Assignment parameter is set to FALSE). Other activity objects must have the 
Lock Assignment parameter set to FALSE or null for assignment to occur. In the 
Siebel application, the lock assignment feature for activity records (except for Field 
Service activity records) defaults to “Y”.

Using Siebel Tools, you can implement assignment of all types of activities by 
setting the default value of the Assignment Excluded field to FALSE at the business 
component level.

The following procedure explains how to set the Lock Assignment default value so 
that Assignment Manager assigns activity objects. A similar procedure can be used 
for other assignment objects.

To set the lock assignment default value to assign activity objects

1 Start Siebel Tools.

2 In the Object Explorer, expand the Business Component object.

3 In the Business Components list, select Action.

4 In the Object Explorer, click Field. 

5 In the Fields list, select Assignment Excluded, and change the Post Default Value 
field to “N”.

6 Check-in the changes to the server.

For more information about checking in changes, see Siebel Tools Reference. 
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7 Recompile the .srf file.

For more information about recompiling the .srf file, see “To update your 
deployment with new configurations” on page 154.

8 Make sure that all Siebel clients that create activity records have the new .srf file.

NOTE: This step applies only to mobile or dedicated clients.

Assignment Manager now assigns activity records based on the defined 
assignment rules.

For more information about the Activity assignment object, see “Activity Object 
Parameters” on page 295.
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Configuring Assignment Objects to Copy Additional 
Columns to the Team Table

When an item, such as an account or opportunity, is assigned to a team of people, 
the team field (the actual name of the field varies depending on the view) for that 
record shows a list of the people assigned to that item. This list of names is known 
as the team table for the given record. When making assignments, Assignment 
Manager passes information about the team members to the team table, such as the 
name of the person, that person’s position and user ID, and so on. This section 
explains how to configure assignment objects to add additional information about 
team members to the team table.

Using Siebel Tools, you configure assignment objects to copy additional columns to 
the team table. The following procedure details this configuration. As an example, 
copying columns to the team table S_ORD_CRDT_ASGN of the Order (Sales Credit 
Assignment) assignment object is considered; data is copied from the 
S_ASGN_GRP_POSTN rule group position table.

To configure an assignment object to copy additional columns to the team table

1 Start Siebel Tools.

2 Select the assignment object for which you want to copy additional columns to 
the team table.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Object window, select the object.

For this example, select Order.

c In the Object Explorer, expand Assignment Object, and then select 
Assignment User Prop.
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3 In the Assignment User Properties window, choose Edit > New Record to define 
user properties for the assignment object.

a In the Name field, type a name for the property starting with 
PositionTeamDenorm followed by a digit (for example, 
PositionTeamDenorm1, PositionTeamDenorm2). 

b In the Value field, use the following syntax to enter values (for value 
descriptions, see Table 34 on page 268):

source column,destination column,flag,default value

For this example, the following table shows the valid user properties for the 
Order (Sales Credit Assignment) assignment object:

Name Value

PositionTeamDenorm1 DATE1,START_DT,N

PositionTeamDenorm2 CHAR2,SLS_TERR_ID,Y

PositionTeamDenorm3 CHAR1,CRDT_RULE_ID,N

PositionTeamDenorm4 NUM1,ALLOC_PCT,N

PositionTeamDenorm5 CHAR3,FROM_BTM_NODE_FLG,N

PositionTeamDenorm6 NUM2,ROLLUP_PCT,N
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 267



Advanced Configuration

Configuring Assignment Objects to Copy Additional Columns to the Team Table
Table 34 provides descriptions for each field of the assignment user property values.

When Assignment Manager runs, the user property values are copied to the team 
table. For more information about running Assignment Manager using the copy 
columns features, see Chapter 5, “Running Assignment Manager.”

For more information about team tables, see “Assignment Scoring” on page 51, 
“Contact Denormalization” on page 63, and “Configuring Assignment Objects for 
Team Scoring” on page 114.

Table 34. Assignment User Property Values

Value Description

source column The name of the column in the assignment rule group position table 
whose value is copied to the destination column of the team table. The 
source column can be one of the following columns: CHAR1, CHAR2, 
CHAR3, CHAR4, NUM1, NUM2, NUM3, NUM4, DATE1, DATE2.

For this example, the values are copied from the S_ASGN_GRP_POSTN 
table.

destination 
column

The name of the column in the team table where the values are copied. 
The destination column must be one of the user data columns in the 
team table of the assignment object.

For this example, SLS_TERR_ID is one of the columns of the 
S_ORD_CRDT_ASGN table, which is the team table of the Order 
assignment object.

flag Indicates whether or not (Y = TRUE) the respective destination column 
is part of the user key of the team table. Without this flag specified, 
duplicate positions cannot be inserted in the team table. For more 
information about duplicate positions, see “AllowDupPostn” on 
page 242.

default value Specifies the values that are inserted in the destination columns if the 
assignee is the default.

For this example, the default values are null.

Note: This value is optional if the default position is not specified.
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This chapter provides a summary of the changes and compatibilities between 
Territory Assignment in Version 4.x and Assignment Manager in version 5 and 
higher. Major differences between Territory Assignment and Assignment Manager 
covered in this chapter include:

■ System preferences

■ Tables

■ Command line options

NOTE: The Territory List and Detail views will eventually be phased out from the 
Assignment Administration screens. If your configuration currently uses these 
views, note that they can migrate to the existing Assignment Rule views with no loss 
of functionality or data. For further information, contact Siebel Technical Support. 
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System Preferences Compatibility 
Territory Assignment System Preferences (Version 4.x) are no longer used in 
Version 5 and higher; these preferences are referred to now as assignment object 
properties. Assignment Manager preferences are now set in Siebel Tools by 
navigating to Workflow Policy Object in the Object Explorer. Each assignment object 
is defined as a Workflow Policy Object. To define the preferences for an assignment 
object, expand the corresponding Workflow Policy Object, select Assignment 
Object, and locate the preference. Preferences appear as assignment object 
properties. Object preferences are similar to System preferences but allow you to 
define how Assignment Manager behaves for each object, rather than system 
preferences that apply to all objects. 

Table 35 shows the system preferences used in Territory Assignment and the system 
preferences used in Assignment Manager.

Table 35. Comparison of System Preferences

Territory Assignment 
System Preferences (Version 4 or 4.x)

Assignment Manager Compatibility (Version 5 and 
Higher)

Allow User Exclusive Lock Assignment Column in 
Siebel Tools Assignment Object

Assignee of Unowned Default Employee, Default Employee, or Default 
Organization

Copy Opportunity Revenue Position Team Copy Columns in Assignment Object

Keep Creator Keep Creator Flag

Keep Manually Assigned Keep Manual Assigned Flag

(Re)determine Primary Rep Set Primary Position or Set Primary Employee Flag

Update or Add To Add Team Members Flag
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Table 36 shows the tables used in Territory Assignment and the tables used in 
Assignment Manager.

Table 36. Comparison of Tables

Territory Assignment Tables (Version 4 or 4.x)
Assignment Manager Compatibility (Version 5 
and Higher)

S_TERR S_ASGN_GRP

S_TERR_ITEM S_ASGN_RULE
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Table 37 shows the command-line options used in Territory Assignment and the 
corresponding options used in Assignment Manager.

Table 37. Comparison of Command Line Options

Territory Assignment 
Command-Line Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)

/Address 0

/Address 1

/Address 2

Set in Assignment Attribute columns. For the Opportunity Workflow Policy Object, 
you can specify workflow components for the Opportunity’s primary address or the 
Opportunity’s primary account address.

To generate the same results as using:

■ /Address 0 (use both Opportunity and Account primary addresses), set Workflow 
Components Opportunity Primary Address to Active, and set Primary Account 
Address to Active.

■ /Address 1 (use Opportunity primary address only), set Workflow Components 
Opportunity Primary Address to Active, and set Primary Account Address to 
Inactive.

■ /Address 2 (use Account primary address only), set Workflow Components 
Opportunity Primary Address to Inactive, and set Primary Account Address to 
Active.

You must also inactivate the corresponding Assignment Attribute columns of the 
component under the workflow policy object. After this step is finished, recompile 
the .srf file and, if you are using dynamic assignment, regenerate triggers. 

In Version 4.x, Territory Assignment uses the Account primary address for 
assignments of the Account object. In Version 5 and higher, Assignment Manager 
uses all addresses for assignments of the Account object.

/Bypass Use Batch Assignment to reassign existing objects.

/Group Use Batch Assignment with WHERE clauses.

/Ignore Ignore the Extra Attributes flag on Siebel Tools Assignment Object.
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/Indirect Set in Assignment Attribute columns. For the Opportunity Workflow Policy Object, 
you can specify workflow components for the Opportunity’s indirect accounts.

To generate the same results as using:

■ /Indirect YES (use attributes from the opportunity’s indirect accounts), set all 
Workflow Components named Indirect Account to Active.

■ /Indirect NO (do not use attributes from the opportunity’s indirect accounts), set 
all Workflow Components named Indirect Account to Inactive.

Note: You need to change this option for the Account ID Assignment Attribute. The 
default value for Opportunity's indirect accounts (Opportunity/Indirect Account and 
Indirect Account Synonym) are inactive in the Assignment Attribute Column. Also, 
the Opportunity/Indirect Account and Indirect Account Synonym Workflow 
Components for the Opportunity Workflow Object are active by default.

/KeepCreator Set the Keep Creator flag on Siebel Tools Assignment Object.

/Mode Use one or more Workflow Monitors to process requests for assignment objects.

Use the Group Name parameter to specify the name of the assignment policy group 
to assign. The assignment policy group specifies the list of assignment objects to 
dynamically assign.

When running Batch Assignment, use the assignment object parameter to specify the 
name of the assignment object to assign.

/OutputFile No longer applicable. Output goes to Siebel Server trace files.

/NumRec Use Workflow Monitor to specify the number of requests per iteration.

/Phase Not used at this time. Use Workflow Monitor to detect requests.

/PrimaryAddressId Not used at this time.

/PrimaryRep Set Primary Position or Set Primary Employee Flag on Siebel Tools Assignment 
Object.

/RecID Use batch mode with a WHERE clause.

/RollBack Use the SIEBEL_ROLLBACK_SEG environment variable to specify rollback segments 
for Siebel Server tasks.

/RunTotal No longer applicable.

Table 37. Comparison of Command Line Options

Territory Assignment 
Command-Line Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)
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/Sleep Now applicable only in Dynamic Assignment, and the parameter is Sleep Time in 
Workflow Monitor.

/Synch No longer applicable.

Table 37. Comparison of Command Line Options

Territory Assignment 
Command-Line Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)
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Siebel Assignment Manager uses definitions in the Siebel repository to assign 
objects to assignment rules and candidates. The predefined definitions include 
mappings for the most commonly used attributes for each object. Each assignment 
object uses its own set of run-time parameters that control the behavior of 
Assignment Manager for that assignment object. These run-time parameters are 
stored in the Siebel repository in the assignment object definitions. This appendix 
includes usage comments and tables for the assignment object run-time parameters 
and their default values.

To configure assignment objects, you need to modify their run-time parameters 
using Siebel Tools. For procedures on how to configure assignment objects, see 
“Configuring Assignment Objects” on page 100.
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Table 38 shows the usage comments for the object run-time parameters.

NOTE: The run-time parameter name is shown as it appears in the Siebel Tools 
Assignment Objects list applet. The property name is shown as it is appears in the 
Siebel Tools Properties window. In this table, the property name for a parameter is 
shown only if the property name differs from the run-time parameter name.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments

Assignment Mode Determines whether or not Assignment 
Manager performs filtering based on 
organizations or people. Valid values are: 
Independent, Org & Person-oriented, 
Organization-oriented, and Person-oriented.

Assignment Scoring 
Mode

If this parameter is set to Person-based (the 
default), the assignment rule score is set to 
the score of the highest-scoring employee or 
position for the rule. If this parameter is set 
to Organization-based, the assignment rule 
score is set to the score of the highest-
scoring organization for the rule.

Auto Reassign When this parameter is checked—parameter 
equals TRUE—Assignment Manager 
automatically reassigns objects if 
assignment attribute values change. The 
Generate Triggers server task looks for this 
flag when it generates triggers for the active 
assignment policy. If the parameter is 
unchecked—parameter equals FALSE—no 
trigger is created for the update; the 
assignment occurs once when the record is 
inserted. The default value is TRUE.
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Calendar Activity 
Additional Fields

A string that provides extra information for 
use when creating an activity through 
availability-based assignment. This string 
follows a format of “parent field”, “field 1", 
“value1”, “field 2", “value2”.

Calendar Create 
Activity

When this parameter is checked—parameter 
equals TRUE—Assignment Manager creates 
an activity in the employee calendar of every 
final assignee, blocking off the time needed 
to finish the task. When this parameter is 
not checked—parameter equals FALSE—no 
activity is created in the employee calendar.

Calendar Duration 
Column

The table column that references the 
duration of the object. This column is 
required for availability-based assignment.

Calendar Early Start 
Time Column

The table column that references the early 
start time of the object. This column can be 
used for availability-based assignment but is 
optional.

Calendar Start Time 
Column

The table column of the assignment object 
that references the start time of the object. 
This column is required for availability 
based assignment

Default Employee Assignment Manager assigns this employee 
when a conflict or a tie occurs and the 
appropriate employees cannot be assigned.

If the Default Employee property for an 
assignment object is not specified and all 
rules have failed for a request for that 
assignment object, Assignment Manager 
sets the owner id field in the object row to 
No Match Row Id.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 277



Assignment Object Parameters

Assignment Object Parameter Usage
Default 
Organization

Default Org Assignment Manager assigns this 
organization when a conflict or a tie occurs 
and the appropriate organizations cannot be 
assigned.

If the Default Organization property for an 
assignment object is not specified and all 
rules have failed for a request for that 
assignment object, Assignment Manager 
sets the owner id field in the object row to 
No Match Row Id. 

Default Position Assignment Manager assigns this position 
when a conflict or a tie occurs and the 
appropriate positions cannot be assigned.

If the Default Position property for an 
assignment object is not specified and all 
rules have failed for a request for that 
assignment object, Assignment Manager 
sets the owner id field in the object row to 
No Match Row Id.

When the Default Position property of an 
assignment object is set to null and that 
object does not qualify for any defined 
assignment rules, then Assignment Manager 
does not set Primary position on the object.

Employee Column Name of the column in the employee 
intersection table that points to rows in the 
employee table (S_EMPLOYEE).

Employee Primary 
Column

Name of the column in the primary table 
that stores the primary employee (on a 
team) or single-owner employee.

Employee Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary employee 
is assigned by the denorm program.

Employee Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary employee 
is manually assigned.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Employee Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary employee 
is system assigned.

Employee Table Name of the employee intersection table. If 
the assignment object can be assigned to 
multiple employees, this intersection table 
stores the set of employee IDs that are 
assigned to assignment object IDs.

Employee Team 
Copy Columns 

Employee Primary 
Column List

Comma-separated list of column names in 
the employee intersection table that should 
be copied when the primary employee 
changes. Assignment Manager copies values 
from these columns from the old primary 
employee to the new primary employee.

Employee Team 
Denorm Column 

Employee Denorm 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is assigned by the denorm 
program.

Employee Team 
Manual Column 

Employee Manual 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is manually assigned.

Employee Team 
Score Column

Numeric column in assignment object team 
table that stores the score of the assigned 
employee.

Employee Team 
System Column 

Employee System 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is system assigned.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Ignore Extra 
Attributes

Ignore Assignment 
Attributes

When this parameter is checked, 
Assignment Manager ignores the 
assignment criteria that are not relevant to 
the assignment object being assigned. For 
example, if you have an assignment rule that 
uses Service Request Priority as an 
assignment criteria, Assignment Manager 
ignores this assignment criteria when 
assigning opportunities and accounts 
because Service Request Priority is relevant 
only to service requests. When this 
parameter is unchecked, the assignment rule 
fails.

Inactive When this parameter is checked—parameter 
equals TRUE—the object is no longer 
enabled (active). By default, this parameter 
is set to FALSE.

Keep Creator When this parameter is checked, 
Assignment Manager never deletes the 
object creator from the team.

Keep Man Asgn 
Primary Org

For teams only. When this parameter is 
checked, Assignment Manager does not set 
the primary organization if the user 
explicitly sets the primary organization; 
Assignment Manager actually checks the 
Primary Organization manual flag in the 
object’s primary table. 

By default, this manual flag is unchecked 
when the object is first created.

Keep Manual 
Assigned

Keep User Assigned For teams only. When this parameter is 
checked, Assignment Manager keeps 
manually assigned assignees and 
assignment rules.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Keep Manual 
Primary Employee

Keep Man Asgn 
Primary Employee

When this parameter is checked, 
Assignment Manager does not set the 
primary employee if the user explicitly sets 
the primary employee; Assignment Manager 
actually checks the Primary Employee 
manual flag in the object’s primary table.

By default, this manual flag is unchecked 
when the object is first created.

Keep Manual 
Primary Position

Keep Man Asgn 
Primary Position

When this parameter is checked, 
Assignment Manager does not set the 
primary position if the user explicitly sets 
the primary position; Assignment Manager 
actually checks the Primary Position manual 
flag in the object’s primary table. 

By default, this manual flag is unchecked 
when the object is first created.

For more information about setting the 
primary position, see the run-time 
parameter “Set Primary Position” on 
page 287.

Keep Manual 
Primary Rule

Keep Man Asgn 
Primary Group

For teams only. When this parameter is 
checked, Assignment Manager does not set 
the primary rule if the user explicitly sets the 
primary rule; Assignment Manager actually 
checks the Primary Assignment Rule manual 
flag in the object’s primary table. 

By default, this manual flag is unchecked 
when the object is first created.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Lock Assignment 
Column

Exclude Column When this parameter is set to a column 
name, the object is not assigned or 
reassigned if the column value is TRUE. If 
you want Assignment Manager to assign or 
reassign the object, set this parameter to 
null, or set the column value to FALSE. This 
column is not a property of the assignment 
object itself, but a property of the business 
component associated with the assignment 
object.

Note: Every assignment object base table has 
an ASGN_USR_EXCLD_FLG column, and for 
some objects, this column is exposed in the 
Siebel application as a field named Lock 
Assignment. However, for assignment 
objects that do not have this column 
exposed, you can query the database for the 
ASGN_USR_EXCLD_FLG column in the 
appropriate table.

Organization Table Org Table Name of the organization intersection table. 
If the assignment object can be assigned to 
multiple organizations, this intersection 
table stores the set of organization IDs that 
are assigned to assignment object IDs.

Org Column Name of the column in the organization 
intersection table that points to rows in the 
organization table (S_ORG_INT).

Org Denorm 
Column

Name of the column in the organization 
intersection table that specifies whether the 
organization is assigned by the denorm 
program.

Org Manual Column Name of the column in the organization 
intersection table that specifies whether the 
organization is manually assigned.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Org Primary Column Name of the column in the primary table 
that stores the primary organization (on a 
team) or single-owner organization. To 
prevent organization assignment for an 
object, set this property to null.

Org Primary Column 
List

Comma-separated list of column names in 
the organization intersection table that 
should be copied when the primary 
organization changes. Assignment Manager 
copies values from these columns from the 
old primary organization to the new primary 
organization.

Org Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary 
organization is assigned by the denorm 
program.

Org Primary Manual 
Column

Name of the column in the primary table 
that specifies whether the primary 
organization is manually assigned.

Org Primary System 
Column

Name of the column in the primary table 
that specifies whether the primary 
organization is system assigned.

Org System Column Name of the column in the organization 
intersection table that specifies whether the 
organization is system assigned.

Org Team Score 
Column

Numeric column in assignment object team 
table that stores the score of the assigned 
organization.

Position Column Name of the column in the position 
intersection table that points to rows in the 
position table (S_POSTN). 

Position Primary 
Column

Name of the column in the primary table 
that stores the primary position (for teams) 
or single-owner position.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Position Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary position 
is assigned by the denorm program.

Position Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary position 
is manually assigned.

Position Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary position 
is system assigned.

Position Table Name of the position intersection table. If 
the assignment object can be assigned to 
multiple positions, this intersection table 
stores the set of position IDs that are 
assigned to assignment object IDs.

Position Team Copy 
Columns 

Position Primary 
Column List

Comma-separated list of column names in 
the position intersection table that should be 
copied when the primary position changes. 
Assignment Manager copies values from 
these columns from the old primary position 
to the new primary position.

Position Team 
Denorm Column 

Position Denorm 
Column

Name of the column in the position 
intersection table that specifies whether the 
position is assigned by the denorm program.

Position Team 
Manual Column 

Position Manual 
Column 

Name of the column in the position 
intersection table that specifies whether the 
position is manually assigned.

Position Team Score 
Column

Numeric column in assignment object team 
table that stores the score of the assigned 
position.

Position Team 
System Column 

Position System 
Column

Name of the column in the position 
intersection table that specifies whether the 
position is system assigned.

Primary Table Base table of the assignment object.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Replace Team 
Members

Add Team Members When this parameter is checked, 
Assignment Manager deletes existing 
candidates from the teams and deletes 
existing assignment rules in the assignment 
rule intersection table that do not qualify.

When this parameter is unchecked, 
Assignment Manager never deletes existing 
candidates or assignment rules from the 
object, even if they do not qualify.

Rule Column Group Column Name of a row ID column in the rule 
intersection table that points to the 
Assignment Rule table (S_ASGN_RULE). 
This column serves as a foreign key to the 
Assignment Rule table, uniquely identifying 
a rule for each assignment entity-rule 
association.

Rule Primary 
Column 

Group Primary 
Column

Name of the column in the primary table 
that stores the primary or single-owner rule.

Rule Primary 
Denorm Column 

Group Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary rule is 
assigned by the denorm program.

Rule Primary 
Manual Column 

Group Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary rule is 
manually assigned.

Rule Primary System 
Column 

Group Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary rule is 
system assigned.

Rule Table Group Table Name of the rule intersection table.

Rule Team Copy 
Columns 

Group Primary 
Column List

Comma-separated list of column names in 
the rule intersection table that should be 
copied when the primary rule changes. 
Assignment Manager copies values from 
these columns from the old primary rule to 
the new primary rule.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Rule Team Denorm 
Column 

Group Denorm 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
assigned by the denorm program.

Rule Team Manual 
Column 

Group Manual 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
manually assigned. 

Rule Team System 
Column 

Group System 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
system assigned.

Set Primary 
Employee

For teams only. When this parameter is set 
to TRUE, Assignment Manager is enabled for 
setting a primary employee. You select the 
primary employee for an assignment rule in 
the Assignment Rules view.

The primary employee is the highest-scoring 
employee in the highest-scoring assignment 
rule for the object being assigned.

Set Primary Org For teams only. When this parameter is set 
to TRUE, Assignment Manager is enabled for 
setting a primary organization. You select 
the primary organization for an assignment 
rule in the Assignment Rules view.

The primary organization is the highest-
scoring organization in the highest-scoring 
assignment rule for the object being 
assigned.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Set Primary Position For teams only. When this parameter is set 
to TRUE, Assignment Manager is enabled for 
setting a primary position. You select the 
primary position for an assignment rule in 
the Assignment Rules view.

The primary position is the highest-scoring 
position in the highest scoring assignment 
rule for the object being assigned.

NOTE: If the property for the assignment 
object is Set Primary Position = False, then 
the existing primary is not modified by 
Assignment Manager; the primary remains 
the same. If the property for the assignment 
object is Set Primary Position = True, then 
the existing primary might be modified by 
Assignment Manager. This behavior is 
irrespective of the value in the Keep Man 
Asgn Primary Position property.

Set Primary Rule Set Primary Group When this parameter is set to TRUE, 
Assignment Manager is enabled for setting a 
primary rule. You select the primary rule for 
an assignment rule in the Assignment Rules 
view.

The primary assignment rule is the highest-
scoring rule for the object being assigned.

Skill Item Table Name of the skill item table.

For more information about skill item tables, 
see “Using Skill Tables” on page 143.

Skill Table Name of the skill table.

For more information about skill tables, see 
“Using Skill Tables” on page 143.

Table 38. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Run-Time Parameter Default Values
This section includes tables that list the run-time parameters and their default 
values for the following predefined assignment objects. For a procedure that 
explains how to view these objects and values, see “To view values for an 
assignment object” on page 289.

■ Account (see Table 39 on page 290)

■ Activity (see Table 40 on page 295)

■ Campaign (see Table 41 on page 300)

■ Campaign Contact (see Table 42 on page 305)

■ Contact (see Table 43 on page 310)

■ Contact Denormalization (see Table 44 on page 315)

■ Employee (see Table 45 on page 320)

■ Opportunity (see Table 46 on page 325)

■ Order (Sales Credit Assignment) (see Table 47 on page 330)

■ Organization (see Table 48 on page 335)

■ Position (see Table 49 on page 340)

■ Product Defect (see Table 50 on page 345)

■ Product Denormalization (see Table 51 on page 350)

■ Project (see Table 52 on page 355)

■ Project Team (see Table 53 on page 360)

■ Service Request (see Table 54 on page 365)
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To view values for an assignment object

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can 
enable it by selecting View > Options > Object Explorer in the Development 
Tools Options dialog box.

3 In the Workflow Policy Objects window, select the assignment object.

NOTE: Objects are listed alphabetically by parent name of the assignment object.

4 In the Object Explorer, select Assignment Object.

The values for the assignment object appear in the Assignment Objects list 
applet as well as the Properties window.
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Account Object Parameters
Table 39 shows the run-time parameters and their default values for the Account 
assignment object. For descriptions and usage comments of some of these run-time 
parameters, see Table 38 on page 276. 

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 39. Account Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization 

Default Position Siebel Administrator

Employee Column
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Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 39. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORG_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 39. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Org Primary System Column

Org System Column

Org Table 
(Organization Table)

S_ORG_BU

Org Team Score Column

Parent Name Account

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_ACCNT_POSTN

Position Team Score Column

Primary Table S_ORG_EXT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Table 39. Account Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 293



Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position TRUE

Skill Item Table S_ORG_SKILL_IT

Skill Table S_ORG_SKILL

Table 39. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Activity Object Parameters
Table 40 on page 295 shows the run-time parameters and their default values for the 
Activity assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

The Lock Assignment parameter for Activity objects is, by default, set to TRUE. This 
setting does not allow Assignment Manager to assign these objects. The Field 
Service Activity object is the one exception and is, by default, available for 
assignment (Lock Assignment field value is set to FALSE). Other activities must 
have the Lock Assignment parameter set to FALSE or null for assignment to occur. 
This behavior is due to a setting in the Post Default Value property for the Action 
business component’s Assignment Excluded field (Business Component > Field > 
Assignment Excluded). The value in the property is: 

Expr: "IIf ([Class] = LookupValue(""FS_ACTIVITY_CLASS"", ""Field 
Engineer Activity"") OR  [Class] = LookupValue
(""FS_ACTIVITY_CLASS"", ""Repair Activity"") OR [Class] = 
LookupValue(""FS_ACTIVITY_CLASS"", ""Preventive Maintenance""), 
""N"", ""Y"")"

For information about how to set the default value for activity assignment objects, 
see “Setting the Lock Assignment Default Value for Activity Assignment Objects” on 
page 264.

Table 40. Activity Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode
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Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column APPT_DURATION_MIN

Calendar Early Start Time Column

Calendar Start Time Column APPT_START_DT

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column EMP_ID

Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column OWNER_PER_ID

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

ASGN_SYS_FLG

Employee Table S_ACT_EMP

Employee Team Score Column

Table 40. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORG_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive TRUE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Table 40. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Activity

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Table 40. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_EVT_ACT

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table S_ACT_SKILL_IT

Skill Table S_ACT_SKILL

Table 40. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Campaign Object Parameters
Table 41 shows the run-time parameters and their default values for the Campaign 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 41. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 41. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_SRC_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 41. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Campaign

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_SRC_POSTN

Position Team Score Column

Primary Table S_SRC

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org FALSE

Table 41. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position TRUE

Skill Item Table S_CAMP_SKILL_IT

Skill Table S_CAMP_SKILL

Table 41. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Campaign Contact Object Parameters
Table 42 shows the run-time parameters and their default values for the Contact 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The parent name for the Campaign Contact assignment object is Campaign 
Contact Owner (not Campaign Contact). 

The run-time parameters are presented in the order they appear in the Siebel Tools 
Properties window. If the corresponding parameter name that appears in the Siebel 
Tools Assignment Objects list applet differs from the name shown in the Properties 
window, it is shown parenthetically. Parameters in the table that do not include a 
default value have a default value of null.

Table 42. Campaign Contact 

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode Organization-oriented

Assignment Scoring Mode Person-based

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Organization
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Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Table 42. Campaign Contact 

Run-Time Parameter Default Value
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Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Table 42. Campaign Contact 

Run-Time Parameter Default Value
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Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Campaign Contact Owner

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table

Position Team Score Column

Primary Table S_CAMP_CON

Set Primary Employee FALSE

Table 42. Campaign Contact 

Run-Time Parameter Default Value
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Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table

Skill Table

Table 42. Campaign Contact 

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Contact Object Parameters
Table 43 shows the run-time parameters and their default values for the Contact 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 43. Contact Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization

Default Position Siebel Administrator

Employee Column
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Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 43. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_CON_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 43. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Contact

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_POSTN_CON

Position Team Score Column

Primary Table S_CONTACT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Table 43. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 313



Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position TRUE

Skill Item Table S_CON_SKILL_IT

Skill Table S_CON_SKILL

Table 43. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Contact Denormalization Object Parameters
Table 44 shows the run-time parameters and their default values for the Contact 
Denormalization assignment object. For descriptions and usage comments on some 
of these run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 44. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 44. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee 
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 44. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Contact Denormalization

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_POSTN_CON

Position Team Score Column

Primary Table S_CONTACT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 44. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table

Skill Table

Table 44. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Object Parameters
Table 45 shows the run-time parameters and their default values for the Employee 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 45. Employee Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position SADMIN

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Table 45. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Table 45. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Employee

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_USER

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Table 45. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Skill Item Table S_EMP_SKILL_IT

Skill Table S_EMP_SKILL

Table 45. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Opportunity Object Parameters
Table 46 shows the run-time parameters and their default values for the 
Opportunity assignment object. For descriptions and usage comments on some of 
these run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 46. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization

Default Position Siebel Administrator

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy 
Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 46. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_OPTY_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org TRUE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column PR_BU_DNRM_FLG

Org Primary Manual Column PR_BU_MANL_FLG

Table 46. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 327



Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column PR_BU_SYS_FLG

Org System Column

Org Table 
(Organization Table)

S_OPTY_BU

Org Team Score Column

Parent Name Opportunity

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_OPTY_POSTN

Position Team Score Column

Primary Table S_OPTY

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Table 46. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position TRUE

Skill Item Table S_OPTY_SKILL_IT

Skill Table S_OPTY_SKILL

Table 46. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Order (Sales Credit Assignment) Object Parameters
Table 47 shows the run-time parameters and their default values for the Order 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276. For more information about sales credit 
assignment, see Siebel Incentive Compensation Administration Guide.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 47. Order Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

ASGN_GRP_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 47. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORDER_ASGNGRP

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

FALSE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 47. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Order

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_ORD_CRDT_ASGN

Position Team Score Column

Primary Table S_ORDER

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 47. Order Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 333



Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table

Skill Table

Table 47. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Organization Object Parameters
Table 48 shows the run-time parameters and their default values for the 
Organization assignment object. For descriptions and usage comments on some of 
these run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 48. Organization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 48. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 48. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Organization

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_BU

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 48. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table S_BU_SKILL_IT

Skill Table S_BU_SKILL

Table 48. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Position Object Parameters
Table 49 shows the run-time parameters and their default values for the Position 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 49. Position Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position SADMIN

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List (Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Table 49. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Table 49. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Position

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_POSTN

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org FALSE

Set Primary Position TRUE

Table 49. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Skill Item Table S_POS_SKILL_IT

Skill Table S_POS_SKILL

Table 49. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Product Defect Object Parameters
Table 50 shows the run-time parameters and their default values for the Product 
Defect assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 50. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column OWNER_EMP_ID

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 50. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 50. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Product Defect

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_PROD_DEFECT

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 50. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table

Skill Table

Table 50. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Product Denormalization Object Parameters
Table 51 shows the run-time parameters and their default values for the Product 
Denormalization assignment object. For descriptions and usage comments on some 
of these run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 51. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 51. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 351



Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 51. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

S_PROD_INT_BU

Org Team Score Column

Parent Name Product Denormalization

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_PROD_INT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 51. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table

Skill Table

Table 51. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Project Object Parameters
Table 52 shows the run-time parameters and their default values for the Project 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 52. Project Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position

Employee Column EMP_ID
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

ASGN_MANL_FLG

Employee Table S_PROJ_PTL_RSRC

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 52. Project Object Run-Time Parameters

Run-Time Parameter Default Value
356 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B
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Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 52. Project Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Project

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_PROJ

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 52. Project Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table S_PROJ_SKILL_IT

Skill Table S_PROJ_SKILL

Table 52. Project Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 359



Assignment Object Parameters

Run-Time Parameter Default Values
Project Team Object Parameters
Table 53 shows the run-time parameters and their default values for the Project 
Team assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 53. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position

Employee Column EMP_ID
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

ASGN_SYS_FLG

Employee Table S_PROJ_PTL_RSRC

Employee Team Score Column SKILL_SCORE

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 53. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 53. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Project Team

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_PROJ_RSRC

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 53. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table S_PROJRSRC_SKLI

Skill Table S_PROJRSRC_SKL

Table 53. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
364 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Assignment Object Parameters

Run-Time Parameter Default Values
Service Request Object Parameters
Table 54 shows the run-time parameters and their default values for the Service 
Request assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 38 on page 276.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 54. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Person-based

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization

Default Position Siebel Administrator

Employee Column
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column OWNER_EMP_ID

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 54. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org TRUE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 54. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
Version 7.5. Rev. B Siebel Assignment Manager Administration Guide 367



Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column

Parent Name Service Request

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column

Primary Table S_SRV_REQ

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org TRUE

Table 54. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Position FALSE

Skill Item Table S_SR_SKILL_IT

Skill Table S_SR_SKILL

Table 54. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Manager Error Messages B
This appendix explains the error codes and associated text that Assignment 
Manager may generate during processing.
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Understanding Assignment Manager Error Messages
Understanding Assignment Manager Error Messages
Table 55 lists the error codes, the message text, and a description of each error that 
Assignment Manager may generate during processing. For each error, Assignment 
Manager writes this information to the Assignment Manager log file (if you 
specified that one be used).

To view Assignment Manager error codes

1 Start Siebel Tools.

2 From the application-level menu, choose Screens > System Administration > 
Strings.

3 In the Message Key field in the Messages applet, query for ERR_ASG*.

Error messages for all languages appear.

TIP: If you want error messages only for a particular language to appear, specify 
that language (such as ENU for English) as part of your query.

Table 55 provides the Assignment Manager error codes.

Table 55. Assignment Manager Error Codes

Error Code Error Text1 Resolution2

ERR_ASG_ALREADY_ASSIGNED Assigned this object %1 (more 
recently than requested %2).

This is just information.

ERR_ASG_ASSIGN_REPLY Selected %3 rules, 
%5 organizations, and %4 
people for %1 (%2).

This is just information.

ERR_ASG_BASSIGN_REPLY Assigned %1 rows for %2. This is just information.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1.

The configuration of the assignment 
object is not correct. Use Siebel Tools 
to check the configuration of the 
assignment object.

ERR_ASG_BDENORM_REPLY Denormalized %1 rows for %2. This is just information.
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ERR_ASG_CANNOT_ASSIGN_
LOCKED_ROW 

Cannot assign this item because 
it is in a locked state. (Object 
Name = %1, Object Row Id = 
%2.)

If you want to assign this object, 
please uncheck the Lock Assignment 
field for the object being assigned. 
Otherwise, this is just information.

ERR_ASG_DENORM_REPLY Denormalized %1 rows for %2. This is just information.

ERR_ASG_DUP_CONFLICT Unable to update row (%1) 
because updated values violate 
unique index with an existing 
row (%2).

Check the data on your team table 
on the object row_ID where it failed.

ERR_ASG_INVALID_BU_
DFLT_NAME

Default organization %1 for 
assignment object %2 is not 
found in the organizations 
table. Please check that Default 
Organization - %1 is a valid 
organization.

Use Siebel Tools to set the Default 
Organization parameter for the 
assignment object to a valid 
organization in the database.

ERR_ASG_INVALID_EMP_
DFLT_NAME 

Default employee %1 for 
assignment object %2 is not 
found in the employees table.

Use Siebel Tools to set the Default 
Employee parameter for the 
assignment object to a valid 
employee in the database.

ERR_ASG_INVALID_POSTN_
DFLT_NAME 

Default position %1 for 
assignment object %2 is not 
found in the positions table.

Use Siebel Tools to set the Default 
Position parameter for the 
assignment object to a valid position 
in the database.

ERR_ASG_INVALID_STORE_
COL_NUM

Assignment criteria attribute 
%1 has an invalid store column.

Check the Store Column value for 
your assignment criteria attribute 
and make sure it lies between 1 
and 4.

ERR_ASG_INVALID_WF_
LINK_COL

Assignment attribute column 
(%1) references invalid 
workflow component column 
(%2).

Check the Workflow Policy 
Component Column property of the 
assignment attribute column, and 
make sure it points to a valid and 
active workflow policy component 
column.

Table 55. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_ITEM_ATTR_HAS_
NO_ATTR

Assignment Criteria %1, 
Assignment Criteria Attribute 
%2 has no attribute defined. 
Verify in Siebel Tools that the 
Assignment Criteria %1 has an 
assignment criteria attribute 
defined and active. Recompile 
the server repository file to 
apply changes made on 
assignment criteria 
configuration if necessary.

ERR_ASG_ITEM_ATTR_HAS_
NO_ITEM

Item(%2) not found for item 
attribute (%1). Please make 
sure that the item(%2) is active.

Make sure that the Parent 
Assignment Item Type of the 
Assignment Criteria Attribute(%1), 
points to a valid and active 
assignment criteria.

ERR_ASG_ITEM_NOT_
FOUND

Assignment Criteria %1 has an 
invalid assignment attribute. 
Please check the assignment 
criteria configuration on Siebel 
Tools using the Validate tool, 
and note that it is a requirement 
to recompile the server SRF 
after adding or deleting 
assignment criteria records.

ERR_ASG_LOADING_GROUP Unable to load assignment rule 
%1 from the database. Please 
check the assignment rule 
definitions to make sure that all 
the required information is 
correct and press the Release 
button to recreate the rule cache 
data file.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1." 

Check the configuration of the 
assignment object.

Table 55. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_LOV_VALUE_NOT_
FOUND

No LOV value found for 
Type [%1], Value [%2].

Make sure expertise values for skills 
are valid, belonging to LOV type 
EXPERTISE_CD (defined through 
Application Administration screens).

ERR_ASG_MATCHASSIGN_
REPLY

Qualified and selected %3 rules, 
%5 organizations, and %4 
people for %1 (%2).

This is just information.

ERR_ASG_MATCH_REPLY Qualified %3 rules, %5 
organizations, and %4 people 
for %1 (%2).

This is just information.

ERR_ASG_NO_OBJ_COL_FOUND Assignment object %1 has no 
columns.

ERR_ASG_NOT_EMP_POSTN Employee or Position not 
specified for assignment object 
%1.

If person-based assignment, make 
sure that at least one of the four 
properties (Position Table, Position 
Primary Column, Employee Table, 
Employee Primary Column) for 
assignment object %1 has a valid 
non-null value. If organization-based 
assignment, make sure that at least 
one of the two properties (Org Table, 
Org Primary Column) for assignment 
object %1 has a valid non-null value.

ERR_ASG_NO_WF_COLS_
IN_ATTR

Assignment attribute %1 has no 
workflow columns.

ERR_ASG_NO_WF_OBJECT No workflow object available 
for assign object = %1.

Make sure that the Parent Workflow 
Object property of the Assignment 
Object % points to a valid workflow 
object.

Table 55. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_OBJECT_NOT_FOUND Assignment object %1 is not 
registered in the Siebel 
repository. Please make sure 
that %1 is a valid assignment 
object name and the value you 
input is identical to what you 
see in the application. Please 
review the Assignment Manager 
documentation for details on 
the required parameters before 
running an Assignment 
Manager task.

ERR_ASG_PERSON_OBJECT_
NUM_ATTR_MISMATCH

Number of attributes do not 
match with assignment object 
for person object %1.

ERR_ASG_PR_TBL_ROW_
NOT_FOUND 

RowId [%1] in table [%2] not 
found.

Make sure that request submitted is 
for a valid Row Id in table (%2).

ERR_ASG_UPDATE_FAILED Unable to update row %1 (%2). Check the log file for database 
related error, and correct the error.

ERR_ASG_PARSING_VALUE Unable to parse criteria value 
%1.

ERR_ASGN_KEY_NO_MATCH Assignment Key %1 does not 
match the Request Key.

Make sure that the AsgnKey 
parameter is set to the Row Id of one 
of the assignment groups mapped to 
the server.

1. The error text that appears in Table 55 is generic. However, for most errors, Assignment Manager generates 
more specific information about the exact cause of the error. Both the generic and the specific error 
messages appear in the Server Process Log; while only the specific error message appears in the Assignment 
Manager log file.

2. If the Resolution column is blank, this means either the error code is no longer applicable or the text of the 
error code is informative enough not to warrant a separate explanation for resolution.

Table 55. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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creation process overview 117

described 32
expertise codes, role of 47
inclusion methods (table) 33
mapping workflow components 148
multilingual list of values (MLOV) 

capabilities 36
multiple assignment attributes, about 

basing on columns 118
multiple object assignments 250
new configurations, activating 153
nonrequired assignment criteria 38
object definition properties 134
object definition properties, about 130
predefined criteria, about enabling 

for 36
primary address, assignments based 

on 252
properties (table) 130
queries, creating 171
required assignment criteria 37
required when available, about and 

example 38
seed assignment criteria, removing 118
single value to multiple fields 117
skills comparison methods 46
values, comparison method 41
values, creating 174
warning about adding or changing 90

assignment criteria attributes
configuring 133
creating 135
creating, example of 137
list columns, relation to 133
object properties (table) 138
object type, about 92

assignment criteria object type, about 92
assignment criteria values

See skills
creating, example 176
criteria values, creating as skills 177
expertise codes, using 177
sorting and storage 175
wildcard characters as literals 175
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wildcard characters, about 175
assignment information, tracing 212
Assignment Manager

Assignment Manager component, 
configuring 209

child accounts, parent primary address 
example 251

command line options, compatibility with 
Territory Assignment (table) 272

component configuration, overview 89, 
119

component parameters, configuring, 
importance of 210

components of, listed 19
components, starting 209
configuration concepts 91, 130
contact denormalization 63
customizing, about 18
data sources 205
event log configuration 212
parameters, configurable (table) 209
post-configuration tasks 215
preferences, setting 270
running multiple instances 246
Server Request Broker components, 

checking 208, 216
table compatibility with Territory 

Assignment 271
trace and error flags, about using 212

Assignment Manager, modes
batch assignment mode, running in 236
dynamic assignment mode 220
interactive assignment mode 216
mobile assignment mode, running 

in 235
assignment methodology, assigning 

candidates 53
assignment modes

dynamic assignment mode, 
overview 220

dynamic assignment, disabling and 
enabling 229

independent assignment 78

interactive assignment mode, running in 
overview 216

mobile mode, running in 235
organization and person-oriented 

assignment, about 80
organization-oriented assignment, if 

multitiered assignment is set 79
person-oriented assignment, if 

multitiered assignment is set 79
server requirements 214

assignment object modes
batch assignment mode, multiple record 

assignments 62
batch mode assignment, overview 236

assignment object object type, about 92
assignment object parameters

See also configuration; configuration, 
advanced

Account object run-time parameters, 
about and table 290

Activity object run-time parameters, 
about and table 295

assignment object, viewing values 
for 289

Campaign Contact object run-time 
parameters, about and table 305

Campaign object run-time parameters, 
about and table 300

Contact Denormalization object run-time 
parameters, about and table 315

Contact object run-time parameters, 
about and table 310

Employee object run-time parameters, 
about and table 320

object run-time parameters, about and 
usage comments (table) 276

Opportunity object run-time parameters, 
about and table 325

Order object run-time parameters, about 
and table 330

Organization object run-time parameters, 
about and table 335
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Position object run-time parameters, 
about and table 340

Product Defect object run-time 
parameters, about and table 345

Product Denormalization object run-time 
parameters, about and table 350

Project object run-time parameters, about 
and table 355

Project Team object run-time parameters, 
about and table 360

Service Request object run-time 
parameters, about and table 365

assignment objects
assigning multiple records 62
assignment attributes, mapping to 125
assignment rules, about developing 67
candidates, role of 20
configuration overview 96
configuring 100
default organization assignment 201
default organization, suppressing 

assignment of 262
dynamic assignment mode, role of 220
expertise codes 47
interactive assignment, configuring 104
interactive assignment, overview 103
locking 97
matching requirement for workload 

rules 183
multiple object assignments 250
multitiered assignment, 

configuration 112
new configurations, activating 153
no-criteria rule 171
original assignment objects, configuration 

warning 93
position and employee-based 

assignments, creating 97
positional visibility, about 197
predefined assignment rules, definition 

requirement 157
predefined definitions, list of 96
predefined object types, overview 19

primary address criteria 252
primary owner, candidate assigned 

as 23
primary position, maintaining 261
reassigning positions, example 257
repository migration, warning 90
role in defining assignment criteria 129
sample configuration, Account 

assignment object 102
setting preferences 270
Siebel Tools, role of 91
system-assigned positions, deleting 198
team scoring, configuration 114
team table, configuring to copy additional 

columns to 266
team-based criteria 184
warning about adding or changing 90
wildcard characters, use of 175
workflow policy object, adding to 98
workflow policy objects, relation to 96

assignment objects, availability-based 
assignment

about configuring for 107
configuration example 109
configuring for 108
visibility 111

assignment policies
actions, creating 231
activating 230
batch assignment mode deactivation 

requirements 237
contact denormalization, activating 232
deactivating 231
dynamic assignment mode and 

predefined assignment policies 229
workflow group, setting 230
workflow group, setting example 230
workflow groups, role of 229
Workflow Monitor Agent, role of 229

Assignment Results BusComp user 
property 106

assignment rule groups
assignment rules, sequencing 26
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creating 165
example of creating 167
key-based routing 29
overview 25

assignment rules
See also territories
activating 158
assigning candidates to two objects 145
assignment methodology, role in 53
assignment object configuration 

overview 96
availability-based assignment, 

example 84
availability-based rules, overview 193
combining criteria, developing rules 75
complex rule, example 251
creating 161
definition requirement 157
developing, about 67
emails, as activities 45
employees, about visibility for assigned 

object 197
employees, adding example 191
employees, adding to (procedure) 189
employees, files assigned to 

(rulecache.dat file) 191
Enterprise Integration Manager, loading 

with 237
example of creating 164
exclusive, evaluating 57
matching information, tracing 212
minimum score, requiring satisfaction 

of 39
multiple criteria, about creating rules that 

combine 75
multiple object assignments 250
multitiered assignment mode, using with 

sales assignment rules 78
multitiered assignment, about 52
no-criteria rule 171
object assignment 32
organizations, adding to 199

organizations, file assigned to 
(rulecache.dat file) 200

overview and example 23
positions, adding to 195
positions, file assigned to (rulecache.dat 

file) 198
predefined 97
primary owner, candidate assigned 

as 23
primary, determining 57
process overview 17
releasing 202
required assignment criteria 37
rule cache, recreating 202
rulecache.dat file, about updating 206
scoring formula 55
sequence, defining 170
sequences of rules, evaluating 26
sequences of rules, examples 26
tasks, listed 159
without criteria, role of 33

assignment scoring
overview 51
scoring rules 23
team member scores 51

assignment strategy
assignment rules, about developing 67
assignment skill, associating with an 

organization 68
sales organizations, assignment in 70
skills, associating with a position 68
skills, associating with an employee 69

Assignment Type business component, user 
property 105

attributes, about defining assignment 
criteria and using 129

audience for guide 10
availability-based assignment

assignment objects, configuring 109
assignment objects, visibility 111
assignment rules, overview 193
availability criteria, activating 193
overview 45
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B
batch assignment mode

about 62
assignment rules without criteria 33
command line, additional parameter 

characteristics 242
command line, running from (about and 

parameters) 241
date and timestamp fields, updating 

of 240
interaction with dynamic assignment 

mode 237
mobile users, routing assignments 

to 260
multiple instances, running 246
Object WHERE Clause, using when 

starting server task 242
overview 236
performance tuning 244
record updating, inadvertent 237
running 238
SRVRMGR utility, additional parameter 

characteristics 242
SRVRMGR utility, running from (about 

and parameters) 241
wildcards, using in SQL statements 242

BatchMode parameter, about 228
BatchSize parameter

batch assignment command-line interface 
parameter, about 241

description, about 218
performance considerations 244

business components
Assignment Rule compared to 

Assignment Group 129
interactive assignment 104

business services
Server Requests, about invoking 

Assignment Manager from within 30
Synchronous Assignment Manager 

Requests, about invoking Assignment 
Manager from within 29

C
cache size, LastUsrCacheSx parameter, 

about 228
Campaign Contact object run-time 

parameters, about and table 305
Campaign Contact Owner

See Campaign Contact object run-time 
parameters, about and table

Campaign object run-time parameters, 
about and table 300

candidates
assignment criteria, using to determine 

qualified candidates 32
assignment methodology 53
employees, about and example 20
evaluation methods, about 32
individuals, about and example 21
organizations, about and example 21
positions, about and example 20
potential assignees list 56
primary owner, about and example 23
qualifying 32
teams, about and example 21
two objects, assigning to 145
types, described 20
workloads, balancing 43

Check Calendar box, about using 193
Check version iterations parameter, 

about 210
CheckLogCacheSz parameter, about 228
child accounts

PAR_OU_ID column, about value point 
to 256

parent’s primary address, assigning based 
on 254

primary parent address 251
classes, confirming for interactive 

assignment 104
column-based assignment attributes, 

about 117
command-line interface
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interactive assignment mode, running 
from 218

Territory Assignment and Assignment 
Manager, compatibility (table) 272

Compare Object to Organization
assignment criteria values, about 46
comparison method, about 32
criteria requirements, about 37
evaluation description 55

Compare Object to Person
comparison method, about 32
criteria requirements, about 37
evaluation description 55
expertise codes, use of 47
skill matching 46

Compare to Object
assignment criteria values, about 46
comparison method, about 32
criteria requirements, about 37
criteria values, about using 174
criteria values, assignment criteria 41
expertise codes, use of 47

Compare to Organization
assignment criteria values, about 46
comparison method, about 32
criteria requirements, about 37
criteria values, about using 174
evaluation description 55

Compare to Person
assignment criteria values, about 46
comparison method, about 32
criteria requirements, about 37
criteria values, about using 174
criteria values, assignment criteria 41
evaluation description 55
expertise codes, use of 47

configuration
See also configuration, advanced
Account assignment object example 102
Assign option, using to invoke Interactive 

Assignment 103
Assignment Manager post-configuration 

tasks 215

assignment objects for multitiered 
assignment 112

availability-based assignment, extending 
Service Request’s base table for 108

availability-based assignment, 
overview 107

configurable features 91
event logs, about and types of 212
event logs, setting log level 212
interactive assignment, configuring for an 

assignment object 104
interactive assignment, overview 103
new configurations, activating 153
original assignment objects, 

changing 93
process overview 89
Siebel Dedicated Web Client, parameters 

for interactive assignment mode 
(table) 216

team scoring example 114
configuration, advanced

See also configuration
activity assignment objects, setting the 

lock assignment value 264
assignment objects, configuring to copy 

additional columns 266
assignment rules, creating to assign two 

objects 250
assignments, routing to mobile 

users 260
child account, assigning based on 

parent’s primary address 254
default organization, stopping 

assignment of 262
organization, stopping assignment for 

accounts 263
primary address, assigning objects based 

on 252
primary position, maintaining manually 

assigned 261
primary position, resigning 

accounts 257
contact denormalization
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activating 232
assignment operation mode, about 63
object run-time parameters, about and 

table 315
Contact object run-time parameters, about 

and table 310
criteria

See assignment criteria
Criteria list column, using to configure 

assignment criteria 129
criteria values

configuration warning 90
criteria value scores, calculation of 174
duplicate criteria values 175
methods used 174

CSSBCBase, about configuring for 
interactive assignment 104

customer service organization, developing 
effective assignment rules 81

D
data visibility, about controlling visibility 

between organizations 21
database triggers, about generating 61
default organization, suppressing 

assignment of 262
default parameters, modifying 100
Default Tasks parameter, about 210
DeleteSize parameter, about 228
denormalization, about using Contact 

Denormalization mode 63
Detail views, about phasing out 269
dynamic assignment mode

See also Workflow Monitor Agent
about 61
assignment objects, enabling and 

disabling for 229
database changes, refreshing 

display 233
error message 221
generating triggers, about 221
GenTrig command-line interface 

command, running using 225

interaction with batch assignment 
mode 237

key-based routing, about using with 31
mobile users, routing transactions 

to 260
overview 220
performance tuning 234
triggers, generating 222

E
eBusiness Integration Manager (EIM), 

loading assignment rules 237
email and assignment rules, activity-based 

assignment 45
Employee object run-time parameters, 

about and table 320
employee-based assignment objects, 

about 45
employees

assignment rules, added to file 
location 191

assignment rules, adding to 
(procedure) 189

assignment rules, example of adding 
to 191

availability-based assignment rules, 
overview 193

availability-based assignment, about 45
multitiered assignment, about and 

example 192
position and employee-based 

assignments, creating 97
service objects, about assigning to 20
skills, associating with 69
visibility, about for assigned object 197
workload criteria definition 

example 186
workload criteria, defining 184

error flags, about using 212
error messages

dynamic assignment mode, attempting to 
modify a record 221

error codes, viewing and table of 372
384 Siebel Assignment Manager Administration Guide Version 7.5. Rev. B



Index
IgnoreError parameter, about 228
event logs

about configuring and types of 212
log level, setting 212

EventDate parameter
batch assignment command-line interface 

parameter, about 241
interactive assignment command-line 

interface parameter, about 218
Exclude method, about 35
EXEC parameter, about 225
expertise codes

creating 178
creating, example 179
criteria values, using with 177
overview 47
predefined expertise codes, about 47
weighting factors example 181
weighting factors, about applying to 48
weighting factors, defining 179

Expertise list column, about 134

F
field service

assignment example 84
assignment rules, creating 87

G
Generate Triggers server component, 

about 61
Generate Triggers, running 222
GenReqRetry parameter, about 228
GenTrig command-line interface command, 

using 225
GroupName parameter, about 228
guide

audience for guide 10
revision history 11

H
history of revisions 11

I
IgnoreCache parameter

batch assignment command-line interface 
parameter, about 241

interactive assignment command-line 
interface parameter, about 218

IgnoreError parameter, about 228
Include All Matching method, about 35
Include All method, about 34
Include method

assignment criteria inclusion method, 
about 34

criteria values, about using 174
inclusion-exclusion assignment criteria 

table 33
independent assignment mode, and 

multitiered assignment disabled 78
individuals, assigning to objects 21
interactive assignment mode

about 60
applet classes, allowable 104
assignment objects, configuring for 103
business components, restrictions 

on 104
command-line interface, running 

from 218
configuring 104
key-based routing, about using with 31
running in overview 216
service requests, running for 

example 217
Siebel Dedicated Web Client, running 

Assignment Manager in 216
Siebel Dedicated Web Client, server 

component requirements 216

K
KeepLogDays parameter, about 228
key-based routing, about and use of 29

L
language
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code criteria example 41
error messages, specifying in query 372

LastUsrCacheSz parameter, about 228
list columns, relation to assignment criteria 

attributes 133
lock assignment

about 97
activity assignment objects, setting 264
parameter, about setting and assigning 

objects 295
log file, viewing error codes and table 

of 372
log level, setting 212
Log txn only on change parameter, 

about 210
LogTxnChgOnly parameter

batch assignment command-line interface 
parameter, about, 241

interactive assignment command-line 
interface parameter, about 218

mobile users, routing assignments 
to 260

M
MailServer parameter, about 228
MailTo parameter, about 228
matching information, tracing 212
Maximum MT Servers parameter, 

about 210
Maximum Tasks parameter, about 210
MaxSkillsAge parameter, about 219
Minimum MT Servers parameter, 

about 210
MinMTServers parameter, about 

setting 209
MLOV

See multilingual list of values (MLOV)
mobile assignment mode

about 62
mobile users, routing transactions 

to 260
running in 235

Mode parameter, about 225

multilingual list of values (MLOV)
assignment attributes. configuring 

for 124
assignment criteria 36
workload criteria, about 44

multitiered assignment
See also multitiered assignment mode
employees, adding example 192
organization assignment, about 201
position assignment, about 198

multitiered assignment mode
See also multitiered assignment
independent assignment 78
organization and person-oriented 

assignment, about 80
organization-oriented assignment, if 

multitiered assignment is set 79
overview 78
person-oriented assignment, if 

multitiered assignment is set 79
multitiered assignment objects

about 52
configuration 112

N
nonrequired assignment criteria

about using 38
SIEBEL_AM_MINRULESCORE system 

variable, setting 39

O
Object Assignment event, about 212
object run-time parameters, about and 

usage comments (table) 276
object types

configurable object types 92
field value and property relationships, 

diagram 94
hierarchy relationship diagram 93

Object WHERE Clause
creating 242
performance considerations 245
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role of 242
running multiple Assignment Manager 

instances 246
objects

See assignment objects
ObjWhereClause parameter

batch assignment command-line interface 
parameter, about 241

interactive assignment command-line 
interface parameter, about 219

SRVRMGR utility, about running from 
batch assignment mode 242

One, Best Fit, assignment rule, about 24
One, Random, assignment rule, about 24
opportunities

territories, role of 70
territory definition list, modifying 74

Opportunity base table scoring 
configuration example 114

opportunity object example 250
Opportunity object run-time parameters, 

about and table 325
Opportunity Workflow Policy Object

deactivated components 152
Order object run-time parameters, about 

and table 330
Org Primary column, using to stop 

assignment 262
organization and person-oriented 

assignment mode, and multitiered 
assignment 80

Organization object run-time parameters, 
about and table 335

organization objects, role in visibility 21
organization-oriented assignment mode, 

and multitiered assignment 79
organizations

accounts, stopping assignment for 263
assignment criteria requirements, 

about 37
assignment rule, adding organizations 

to 199

assignment rules, file storage 
location 200

comparison method, about 32
default assignment 201
default organization, suppressing 

assignment 262
denormalization of 65
employee multitiered assignment, about 

and example 192
multitiered assignment rules, using with 

sales assignment rules 78
multitiered assignment, about 201
overview 21
positions, about assigning based on 

parent organization 198
positions, assigning organizations based 

on and example 201
skills, associating with 68
workload criteria, defining for 187

P
PAR_OU_ID column, about value pointing 

to parent account 256
parameters

default parameters, modifying 100
parent’s primary address, assigning based 

on child account 254
parent-child hierarchy, relationship 

diagram 93
performance tuning

assignment rules without criteria 33
batch assignment mode 244
dynamic assignment mode 234

person-oriented assignment mode, and 
multitiered assignment 79

picklists
assignment attribute, specializing in 119
Criteria list column, about using 129

position object
examples 257
run-time parameters, about and 

table 340
positions
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assignment rules, adding to 195
assignment rules, file storage 

location 198
described 20
indirect positions 63
multitiered assignment, about 198
organization, assigning based on 201
parent organization, based on 198
position and employee-based 

assignments, creating 97
predefined objects, using 20
primary position, determining 64
skills, setting up 68
system-assigned positions, deleting 198
visibility for assigned object 197
workload criteria definition 

example 186
workload criteria, defining 184

post-configuration tasks, server 
administration requirements 215

predefined objects
overview 19
sales objects, use of 20
service objects, about assigning 

employees to 20
Price List table, organization 

denormalization 65
primary address

assigning child accounts based on 251
assignment based on 252

primary owner of assignment object, 
about 23

primary position
determining 64
different position, reassigning accounts 

to 257
manually assigned primary position, 

maintaining 261
Product Defect object run-time parameters, 

about and table 345
Product Defect Priority criteria value 176
Product Denormalization

mode, about and using 65
object run-time parameters, about and 

table 350
products, associating to organizations and 

price lists 65
Project object run-time parameters, about 

and table 355
Project Team object run-time parameters, 

about and table 360

Q
queries, assignment criteria 171

R
ReloadPolicy parameter, about 228
Remove parameter, about 225
repository

repository file, compiling 154
repository migration, warning 90

Requests parameter, about 228
revision history 11
rulecache.dat file

assignment rules, releasing 202
updating, about 206

Rules Evaluation event, about 212
run-time parameter default values

Account object run-time parameters, 
about and table 290

Activity object run-time parameters, 
about and table 295

assignment object, viewing values 
for 289

Campaign Contact object run-time 
parameters, about and table 305

Campaign object run-time parameters, 
about and table 300

Contact Denormalization run-time 
parameters, about and table 315

Contact object run-time parameters, 
about and table 310

Employee object parameters run-time 
parameters, about and table 320
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Opportunity object run-time parameters, 
about and table 325

Order object run-time parameters, about 
and table 330

Organization object run-time parameters, 
about and table 335

Position object run-time parameters, 
about and table 340

Product Defect object run-time 
parameters, about and table 345

Product Denomalization object run-time 
parameters, about and table 350

Project object run-time parameters, about 
and table 355

Project Team object run-time parameters, 
about and table 360

Service Request object run-time 
parameters, about and table 365

S
Sales Credit Assignment object parameters, 

about and table 330
sales organizations

assignment in 70
multiple criteria, about creating rules that 

combine 75
multitiered assignment rules, using with 

sales assignment rules 78
position candidates, use of 20
team candidates, about 21
territory definition list, modifying 74
territory-based assignment rules, 

creating 72
territory-based assignment rules, 

developing 75
territory-based assignment rules, 

example 72
sales team

See teams
Sample database, predefined assignment 

rules 97
Score list column, about 134
scoring

assignment scoring 51
criteria score 32
formula for assignment rules 55
overview 23
scoring rules 23
sequences of rules, evaluating 26
sequences of rules, examples 26
team member scores 51
without criteria, role of 33
workload scoring, about 43

security, about controlling an organization 
security 21

seed assignment criteria, removing 118
server administration

Assignment Manager post-configuration 
tasks 215

dynamic mode requirements 220
interactive assignment mode, server 

component requirements 216
requirements by assignment mode 214

server key maps
about and used of 29
new server key map, defining 168

Server Request Broker components
checking 208
interactive mode, checking server 

components 216
Server Requests business service, about 

invoking Assignment Manager from 
within 30

service objects, about assigning employees 
to 20

service organizations
assigning, about 81
customer service organization, 

developing effective assignment 
rules 81

employee candidates, use of 20
field service assignment rules, creating 

using availability 84
individual candidates 21
primary owner of object 23
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Service Request base table, extending for 
availability-based assignment 108

Service Request object
configuring for interactive 

assignment 103
run-time parameters, about and 

table 365
service requests

assigning, about 81
availability-based rules, example 84
customer service organization, 

developing effective assignment 
rules 81

interactive assignment mode, running 
for 217

Siebel Dedicated Web Client
Assignment Manager, running in 

interactive mode 216
service requests, running interactive 

assignment mode in 217
Siebel Server, concurrent components, 

number of 209
Siebel Web Client

service requests, running interactive 
assignment mode in 217

SIEBEL_AM_MINRULESCORE system 
variable, setting 39

skill scores, weighting 179
skill-based assignment attributes, 

about 117
skills

See also expertise codes
about 141
Assignment Manager, assigning a service 

request example 143
comparison methods 46
creating with expertise codes, 

example 177
criteria values, creating as skills 177
employee skills, associating with 69
new skill, creating 142
organization skills, associating with 68
position skills, setting up 68

predefined skills, viewing 141
role of 46
skill table, using 143
weighted expertise codes, defining 179

SmartScript, role in interactive 
assignment 103

.srf file, compiling instructions for 154
SRVRMGR utility

batch assignment mode, additional 
parameter characteristics 242

batch assignment mode, running from 
(about and parameters) 241

dynamic assignment mode, using to 
run 225

interactive assignment mode, using to 
run 218

Synchronous Assignment Manager 
Requests business service, about 
invoking Assignment Manager 29

system preferences, compatibility 
comparison 270

T
table compatibility used in Territory 

Assignment and Assignment 
Manager 271

TAMode parameter, about 225
teams

availability-based assignment rules, 
overview 193

availability-based assignment, about 45
described and example 21
team member assignment scores 51
team table, configuring assignment 

objects to copy additional columns 
to 266

territories
See also assignment rules
criteria, about creating rules that combine 

criteria 75
location and revenue-based, example 75
multitiered assignment, using with sales 

assignment rules 78
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organization and person-oriented 
assignment, about 80

realignment, impact of 70
role in opportunity and account 

distribution 70
sales assignment rules, creating based on 

territories 72
sales assignment rules, creating that 

combine criteria 75
territory definition list, modifying 74
territory-based assignment rules, 

creating 72
views being phased out 71

territory assignment criteria, example of 
creating 175

territory assignment rules
creating 202
example of creating 174

Territory List, about phasing out 269
trace flags, about using 212
TrigFile parameter, about 225
triggers

assignment attributes 120
checking and editing 221
custom triggers, about creating 222
Generate Triggers, running 222
generating, about 221

tuning
batch assignment mode, performance 

tuning in 244
dynamic assignment mode, performance 

tuning in 234

U
Use Expertise property, about setting 134
UseForUpdate parameter

batch assignment command-line interface 
parameter, about 241

interactive assignment command-line 
interface parameter, about 219

user properties
assignment criteria attributes 

(table) 138

Assignment Results BusComp, about 
showing additional properties 106

V
Values list

about and example 119
list column set, creation of 133

version comparisons
command line options used in Territory 

Assignment and Assignment Manager 
(table) 272

system preferences, between Territory 
Assignment and Assignment 
Manager 270

tables, compatibility of Territory 
Assignment and Assignment Manager 
tables 271

visibility, organizations, role of 21

W
weighting factors

defining, about and procedure 179
example 181
expertise codes, about applying to 48

wildcard characters
batch assignment mode SQL 

statements 242
criteria value, using with 175

Windows NT, setting 
SIEBEL_AM_MINRULESCORE system 
variable 39

workflow groups, setting for assignment 
policies 230

Workflow Monitor Agent
assignment policies, role in 229
role of 61
running 226
workflow groups, role of 229

workflow policy components
assignment attribute, mapping to 150
assignment criteria, mapping to 148
creating 146
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Opportunity Workflow Policy Object, 
deactivated components 152

overview 145
record updating, inadvertent 237

workflow policy objects
assignment objects, adding 98
assignment objects, relation to 96

workload criteria
about 43
defining 182
employees and positions example 186
employees and positions, defining 

for 184
multilingual list of values (MLOV) 44

organizations, defining for 187
predefined fields (table) 185
predefined rules 183
team-based criteria 184

workload evaluation description 55
workload rules

assignment object matching 
requirement 183

creating 182
creating example of 184

workload score
about 43
formula 55
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